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Preface

Preface
This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications
To find guides for Oracle Applications, go to the Oracle Help Center.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.
Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Contacting Oracle
Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides. Please take one of the following surveys:
• For web-based user guide, Web-based User Guide Survey
• For tutorial feedback, Tutorial Survey
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Your Company’s Configuration
You can configure Oracle Field Service Cloud to your specific business requirements, such as the type of work performed,
the kinds of skills available for assignment, the way in which working calendars are organized, and so on. You can configure
the settings for all these requirements on the Configuration screen.
Most configuration settings are available on the Configuration screen. However, depending on the way you have
implemented the application for your company, some of the settings might be placed in individual menu items or grouped
under different menu items. Your user type configuration determines the options displayed on the menus.
The configuration elements are grouped logically on the Configuration screen:
• General (the settings related to the general principles of the company operation):

◦
◦
◦
◦
◦
◦

About
Business Rules
Link Templates
Work Schedules
Work Zones
Work skills

• Resources, Activities, Inventories (the settings related to the resources the company employs, the activities it
performs and the inventory used in the course of their performance):

◦
◦
◦
◦
◦
◦

Properties
Capacity Categories
Time Slots
Resource Types
Activity Types
Inventory Types

• Displays (the settings related to the general appearance of the application, screen layouts, languages and
translations):

◦
◦
◦
◦
◦

Glossary
Display
Themes
Filters
Forms & Plugins

• Users, Security, Integrations (the settings related to user management and system access):

◦

Organizations

1

Oracle Field Service Cloud

Administering Oracle Field Service Cloud

◦
◦
◦
◦
◦

Chapter 1

Configure Oracle Field Service Cloud

Login Policies
User Types
Applications
Oracle Knowledge
Integration Cloud Service

• Subsystems (the settings related to Oracle Field Service Cloud modules):

◦
◦
◦
◦
◦
◦

Statistics
Outbound Integration
Collaboration
Message Scenarios
Holidays
Surveys

Items are added only to the groups listed above. Each item, when clicked, leads to the corresponding configuration screen.

Configuration Screen Access and Visibility Settings
Access to the Configuration screen can be allowed or denied per user type, which means that all users of that type will
either have the Configuration item in their menu or not. The visibilities that set the user access to this screen are hidden,
read-write, and read-only.
The items on the Configuration screen and their visibilities are configured in a dedicated context layout, Configuration.
Similar to other context layouts, the Configuration screen is configured per user type, which means that all users of the
selected type will see the same items on the screen with the same level of visibility. The Company Configuration context
layout can include only the company configuration items. Therefore, the Add action window contains only the list of items
related to company configuration. The reverse is also true—the company configuration items are not included in the action list
of any other context layout.

How Plug-Ins are Configured
This topic describes the high-level steps to configure and use a plug-in in Oracle Field Service Cloud.
1. Determine whether you want to host the plug-in in Oracle Field Service Cloud. If yes, prepare your plug-in for upload.
2. Configure the plug-in.
a. Upload the hosted plug-in.
b. Add the available properties.
3. Add the plug-in to the required screen.

Configure a Plug-In
To use a plug-in in Oracle Field Service Cloud, you must configure it first.
1. Click Configuration > Forms & Plugins .
The Forms & Plugins screen appears and displays the existing forms and plug-ins.
2. Click Add Plugin.
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The Add Plugin screen appears.
3. Complete these fields:
Field Name

Description

General Information section
Name (English)

A mandatory field defining the plug-in name in the English language. The action or plug-in
appears under this name in the actual context.

Name (other languages)

Plug-in name translations to other languages, if used.

Label

A mandatory field defining a unique action or plug-in label.

Entity

Entity (activity, inventory, required inventory, resource, service request, user) to which the
action or plug-in is to be related. For example, if you select Inventory, the action will appear
only in the contexts related to inventory. Leave the field blank for the action to be available in
all contexts of all the entities.

Visibility rules similar to

The base action from which the plug-in is to be derived, if needed. When a base action is
selected, the resulting plug-in functions per the same rules as the base action. The base
action affects only the visibility of buttons and not the functioning of the plug-in. It appears
only in the contexts in which the base action appears and is shown or hidden according to
the same visibility conditions. For example, if start_activity is selected as the base action for
a plug-in, the plug-in is only be shown in the context of a pending activity when there is no
started activity in the same route, similar to the Start action. The list of available base actions
is filtered according to the Entity that is selected.

Type

The type of plug-in you want to use. Here are the options:
Native application: This means, the plug-in opens another application on the same
device.
HTML5 application: This means, the plug-in uses an external application to extend
the functionality. An HTML5 application plug-in can be used in one of these Mobility
contexts - Activity List, Edit., View Activity, Inventory Grid or Add/Details Inventory.
This restriction applies only for plug-ins that use the Plugin API. If this option isn’t
selected, the HTML5 plugin is just a URL of an external resource that is opened in a
new window or in an iframe.

◦
◦

Fields for the HTML 5 Application Option
Use Plug-in API

Determines whether you want the plug-in to communicate with Oracle Field Service Cloud
using the Plug-in API. If you clear this check box, the URL is just opened in a new tab/
window/iframe. To interact with Oracle Field Service Cloud you must pass some data (such
as activity id, resource name) to the plug-in using the placeholders in the "POST Data" and
"URL" fields.

URL

The path to a URL (for external plug-ins). This URL executes the HTML5 application and it
executes the plug-in in the entire browser window. The URL must start with the protocol
(https). This field is hidden, if Hosted plugin is selected. The URL must point to the main file
of the plug-in, if the “Use Plug-in API” option is selected. If “Use Plug-in API” is cleared, the
URL must point to an external resource, which is opened either in a new window or inside
Oracle Field Service Cloud in an iframe (if the “Tab or iframe layout” option is selected).

POST Data

The data that you want to be sent to the external plug-in. This field is hidden, if Use plugin
API is selected.

Disable plug-in in offline

Determines whether you want to disable the plug-in when Oracle Field Service Cloud is
offline. Clear this check box for the plug-in to work in offline mode with Oracle Field Service
Mobility Cloud Service. This field is hidden, if Hosted plugin is selected.

Main menu items

Determines whether the plug-in can be set as a Main Menu item through the Main menu
context layout. This field is hidden, if Use plugin API is selected.
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Field Name

Description

Tab or iframe layout

Determines whether the plug-in uses the iframe layout. If the field is cleared, the plug-in’s
URL is opened in a new browser tab or window. This field is hidden, if Use plugin API is
selected.

Show scrollbars

Determines whether the window in which the plug-in runs has scroll bars. This setting is
applicable to the Legacy Manage application. This field is hidden, if Use plugin API is
selected.

Width in pixels/ Height in pixels

The width and height of the plug-in window in pixels. This setting is applicable to the Legacy
Manage application. This field is hidden, if Use plugin API is selected.

these fields are displayed when you select the Use Plug-in API check box.
Hosted plugin

Determines whether you want to use a hosted plug-in. The fields that are displayed when
you select this check box are displayed in the Host a Plug-in topic.

URL

The path to a URL (for external plug-ins). This URL executes the HTML5 application and it
executes the plug-in in the entire browser window. The URL must start with the protocol
(https). The URL must point to the main file of the plug-in, if the “Use Plug-in API” option is
selected. If “Use Plug-in API” is cleared, the URL must point to an external resource, which
is opened either in a new window or inside Oracle Field Service Cloud in an iframe (if the
“Tab or iframe layout” option is selected).

Disable plug-in in offline

Determines whether you want to disable the plug-in when Oracle Field Service Cloud is
offline. Clear this check box for the plug-in to work in offline mode with Mobility Cloud
Service.

Authentication

The type of authentication used by the external server hosting the plug-in source to verify
access to the plug-in. This field is hidden when Native application is selected as the plug-in
type. The following choices are available:
Basic HTTP: The Basic Access Authentication method working over HTTP or HTTPS.
The Basic HTTP authentication method requires a valid login and password. When the
entered login and password are verified by the server, the server returns the plug-in
content.
HMAC: Hash-based message authentication code verifying that the data is received
from an authorized source. HMAC authentication method requires a secret key
configured for each plug-in. This field is hidden, if Hosted plugin is selected.

◦
◦

Login/Password

The user name and password to log in to the plug-in. These fields are displayed only when
Basic HTTP is selected for Authentication.

Secret key

Displayed when HMAC authentication is selected. All parameters of the plug-in URL with
replaced placeholders will be encrypted on the basis of the SHA-256 hash of the Secret Key
value using the HMAC algorithm. The resulting string will be appended to the URL as the
HMAC parameter.

Secure parameters

The section where secure information such as user name and password used to access
external sites is entered. This section is available only when Use Plugin API is selected.
The data entered here is encrypted and stored. Use the plus icon to add a new key-value
pair. You can add a maximum of 20 key-value textbox pairs, after which the icon is hidden.
The maximum size of the parameters allowed is 5 KB. This size includes the data structure
overhead and doesn't correspond to the length of keys and values of strings. Changes
to the secure data are sent to Oracle Field Service Mobility Cloud Service during the next
synchronization. The data is sent to the plug-in when the next message is sent.

Fields for the Native Application Option
Native application name

The name of the application to be launched by the plug-in.

Browser user agents mask

The browser in which the application is to be launched. The Native application link will be
available in GUI, if the browser user agent matches the specified mask. For example, Safari,
Android, iPad, iPhone.
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Field Name

Description

URL template

The template for building the external application URL from properties. The URL
template contains parameters key and placeholders for parameters value. Properties are
interpolated with placeholders, surrounded with braces "{" and "}". For example: http://
www.example.com/android? type=LOCATION'&'action=View'&'alt={acoord_y}'&'long=|
{acoord_x}'&'address={caddress|url}'&'city={ccity|url}'&'state={cstate}'&'zip={czip}

these screen shot shows the Add plugin screen:

4. To add the details for another native application, click Add.
5. To reorder the applications, click the stack icon and move the application up or down.
6. To add the properties that are available to the plug-in through the plug-in API, click the pencil icon in the Available
properties section.
The Select properties screen appears.
7. Select the check boxes for all the properties that you want to be passed to the plug-in or updated by the plug-in.
Click OK.
The properties are saved. Unlike earlier, now you don’t have to define the visibility for the properties explicitly.
8. Click Save on the Add plugin screen.

How Plug-Ins are Hosted
If your plug-in consists only of HTML, CSS, and JavaScript files and doesn't contain server-side files, then you can upload it in
Oracle Field Service Cloud. No additional hosting is required. The plug-in framework handles the communication between the
hosted plug-in and Oracle Field Service Cloud. You can host a maximum of 10 plug-ins per instance.
The steps to host a plug-in are:
• Complete the prerequisites to upload the plug-in.
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• Upload the plug-in.
After hosting a plug-in, you can:
• Use it on a screen
• Move between instances
• Modify
• Rollback to a previous version
• Delete
Note: A hosted plug-in works only with Oracle Field Service Mobility Cloud Service.

Prerequisites to Upload a Plug-In
The plug-in must be in a specific format to be uploaded. If not, you cannot upload it, you must host it elsewhere.
The plug-in files must meet these requirements:
• You must upload a ZIP archive of the plug-in files.
• You can upload only the files of following types:
◦ .html

◦
◦
◦
◦
◦
◦
◦
◦

.css
.js
.jpg

.jpeg
.png
.gif
.svg
appcache

• You can organize files in sub-directories, but you must have the "index.html" file in the root folder.
• Each file can be a maximum of 1 MB and the total size of the compressed archive must be less than 500 KB.
• You can have a maximum of 10 files or directories in the archive.
Note: The plug-in files uploaded in Oracle Field Service Cloud are available by unique URLs on the Internet.
The URLs are generated automatically and contain a long string. There is no authentication to access these
files, so anyone who has the direct link to the file can download the file. Therefore, don't store any sensitive
information such as passwords or login names in the plug-in archive. If you don't want your code to be available
without authentication, we recommend that you don't use the hosted plug-in functionality. Be aware that the
communication between the plug-in and Oracle Field Service Cloud starts only when a user successfully logs in
to Oracle Field Service Cloud.

Working Offline
You can create the plug-in to work offline using the Application Cache functionality, which is specified in HTML5 specification
(section "5.7 Offline Web Applications").
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You can include the manifest file in the archive and associate your index.html file with it. For example, if the name of the
manifest file is "manifest.appcache" then include these code in the html file:
<html manifest="manifest.appcache">

don't add this line if your plug-in is intended to work only online. Each version of the uploaded plug-in is hosted in a separate
directory. If you use the application cache functionality, the browser considers each new version of the plug-in as a separate
offline application. Further, by default the browser doesn't clean up the application cache of the previous versions of the plugin. So, don't create too many versions of the plug-ins on the production instance.
Tip: If you experience an overflow of the application cache in the browser, clean up the offline cache of the
browser.

Upload a Plug-In
You must upload the plug-in archive to use it as a hosted plug-in.
1. Click Configuration > Forms & Plugins .
2. Locate the plug-in for which you want to upload the archive. Click the stack icon and then click Modify.
The Modify plugin screen appears.
3. In the Plugin settings section, ensure that the Hosted plugin check box is selected.
4. Click Browse and select the ZIP archive that is ready for upload.
The archive is uploaded only if these conditions are met:
◦ The archive is a ZIP archive and has the extension .zip.

◦
◦

◦
◦
◦

The size of the archive is less than 500 KB.
The archive includes only directories and files of these types:
- .html files
- .css files
- .js files
- .appcache files
- .jpg, .jpeg, .png, .gif, .svg files
- Directories
Files are less than 1 MB.
The "index.html" file is located in the root of the archive.
The archive includes a maximum of 10 entries, including empty directories.

If any of these conditions is not met, an error message is displayed and the archive is not uploaded.
5. Click Save.
The plug-in details are saved and the Version history section is populated with:
◦ The user name of the user that uploaded the files.

◦
◦

The date on which the archive is uploaded.
A link to download the archive.

To be able to use the plug-in, you must add it to a button or a link. See the Add the Plug-in to a Screen topic.

Modify, Download, or Delete an Archive
After uploading a plug-in archive, you might want to modify it, download it, or delete it.
1. To modify a hosted plug-in, you upload a newer version. To upload a newer version of the archive, click Browse on
the Modify plugin screen and upload it again.
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You can have only two versions of the plug-in at any time. Whenever you upload a newer version of a plug-in, these
happens:
◦ The current version becomes a historical one.

◦
◦
◦

The newly uploaded version becomes the current one.
The newly uploaded version is displayed in the first row of the Version history table.
The previous version is moved to the second row of the Version history table.

2. To download a plug-in, click Download in the Version history section. Save it to the desired location.
3. To rollback to a previous version, download the version that you want to rollback to. Click Browse and upload it
again.
4. To delete a plug-in, first unassign it from all the buttons it is added to. Then, click Delete on the Forms & Plugins
screen.
The plug-in is deleted with all its historical versions.
5. To move all the uploaded plug-ins between instances, export from the required instance using the Export function
on the Forms & Plugins screen. Import the exported files using the Import function in the target instance.
6. To move a single plug-in between instances, download it from the required instance. Upload it in the target instance.
You can use the Export option here as well.

Add the Plug-In to a Screen
You add a plug-in to a context layout screen, so that Field Resources can open it. You can configure the parameters for a
button to send the parameters to the plug-in, or to open a specific screen, or another plug-in.
1.
2.
3.
4.

1. Click Configuration > User Types .
Select the type of user for which you want to add the plug-in.
Click Screen configuration.
Find and click the screen to which you want to add the plug-in.

5.
6.
7.
8.
9.

The Visual Form Editor screen appears. Plug-ins are available not only on the Visual Form Editor, but on old
context layout screens such as Parts Details as well. On such screens, add an action and select a plug-in from the
list.
Drag-and-drop the Button element to the section from where you want to invoke the plug-in.
Click the button.
In the Standard action screen field, click the pencil icon.
Select Plug-ins.
In the Screens list, select the name of the plug-in that you want to open and click OK.

The label of the plug-in is displayed in the Plug-in field. By default all plug-ins have a visibility of Read-only.
10. In the Visibility section, add the conditions based on which the plug-in is visible.
11. In the Translations section, add a name for the plug-in.
This name is displayed on the screen from which the plug-in will be invoked. these screen shot shows the Visual
Form Editor screen where a plug-in is added to the Button element:
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12. To configure the parameters:
a. Click Add new in the Parameters section.
b. Enter a name for the parameter in the Name field.
For example, enter defaultScreen to define a screen as the default screen in the plug-in. The maximum length
of the name that you can enter is 248 characters.
c. Enter a value for the parameter.
For example, enter part_order to display the Part order screen as the default screen in the plug-in. The
maximum length of the value that you can enter is 4000 characters.
d. Click Save.
e. Repeat the procedure for all the parameters that you want to configure.
The total combined length of all parameter names and values must not exceed 5000 characters. These
parameters are not encrypted when sent to the plug-in.
13. Click Save on the Visual Form Editor screen.
The plug-in is added to the selected screen.

The Navigate Action
The Navigate action is a pre-configured link used to open a native navigation app on mobile devices. The Navigate link
appears only when the user is online or offline and when activities have resolved coordinates.
These links are pre-configured:
• Android devices (browser user agent mask = *Android*) open a navigation application by geo: protocol for Android
browsers.
• iOS devices (browser user agent mask = *(?:iPad|iPod|iPhone)*) open Apple Maps.
• All other devices (Browser user agent mask = *) open maps.google.com.
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Modify the Navigate Action
You can modify the Navigate action, but note that changing this configuration could impact the users in the field. We
recommend that you test the application properly before changing.
1. Click Configuration > Forms & Plugins .
2. Locate Navigate and click Modify in the stack menu.
The Modify plugin window appears.
3. Enter the Native application name, Browser user agents mask and URL.
4. Click Save.
The new Navigate action is saved.

Activity Types
An activity is any time-consuming task done by a resource (for example, installation, trouble call, lunch, team meeting, and
so on). Each activity type includes a set of features, which are yes/no flags and define the way the activity type is processed.
For example, whether activities of a specific type can be moved, created in bucket, rescheduled, and so on. Access to the
Activity Types window is controlled by the Activity Types visibility. You must set this permission for each user type that
you want to manage Activity Types. If the action is not configured for the user type or if no visibility is defined, Activity Types
are not visible to the user. If you select ReadOnly, Activity Types is placed into a view only mode. If you select Read/Write
for this setting, the user can manage Activity Types.
This table provides a detailed description of the features that may influence the processing of activity from the back office
applications through Oracle Field Service Cloud.
Feature

If enabled, the activities of the type...

Allow to create from Incoming Interface

… can be created from external systems, including Oracle Field Service Cloud ETAWorkforce

Allow move between resources

… can be moved between resources

Allow creation in bucket

... can be created in bucket through routing plans and profiles

Allow reschedule

… can be moved to another day

Support of not-ordered activities

… can be not-ordered – such that can be started by the resource before/after any other activity
within the route

Allow non-scheduled

... can be activities without a date

Support of time slots

… can use time slots (time-period within which they are to be started can be defined)

Calculate activity duration using
statistics

… are estimated using statistics that are gathered at the resource level and company level

Find Activity Types
An activity type defines the specific parameters of the activity, such as which time slot the activity takes place. You may want
to find activity types to edit or view their details.
1. Click Configuration.
2. In the Resources, Activities, and Inventories section, click Activity types.
The Activity types screen appears and displays these columns:
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Column

Description

ID

System-generated number assigned to records in the database – not used by anyone
except the Support team.

Activity Type Name

The user-friendly name the end user sees in the drop-down list of choices on the Activity
screen.

Status

Indicates if the activity type is being used.
Green check mark = Active and in use

◦
◦

Red X = Inactive and not used

Activity Type Label

A unique identifier for the activity type.

Actions

Links to the actions you can take on this activity.

3. Click View.
4. Type the activity type that you want to find in the Find field.
5. Click Apply.
The results appear in the work area with the search criteria in bold.

Activity Type Fields and Features
This topic describes the fields available on the Add Activity Type screen.
You can view the details of an activity type by clicking Modify in the Actions column of the Activity Types screen.
Note: Some features are available only during the initial configuration. This will vary based on the options
selected during the configuration. Features that are not available for editing after the initial configuration will be
greyed out.
The Add Activity Type screen displays these fields:
Field

Description

Activity type info section
Label

Unique identifier.

Name

User-friendly name that appears in the interface. Enter the name in English and in all the languages
that are active in the application.

Active

Defines if the activity is active.

Group

The activity type group this activity type belongs to, for example, Customer, Internal, Teamwork, or
Task.

Default duration

The time taken to complete the activity. This is the default value and it will be used when no
statistics are available for the activity.

Color Scheme Section - Color scheme allows defining colors for each of activity statuses and for warning with standard RGB color codes and
palettes. The colors Pending = FFDE00, Completed = 79B6EB, Warning = FFAAAA, Suspended = 99FFFF, Not done = 60CECE, Not ordered =
FFCC99, Started = 5DBE3F, and Canceled = 80FF80 are not available in the Mobility Supervisor Time View (Manage).
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Field

Description

Copy from

The color palette to be copied from an existing Activity Type. The color scheme of the selected
activity type is duplicated.

Pending through Cancelled

The color to show on the Time, List or Map views.

Available Time Slots Section
Available Time Slots

The times slots for this activity type. Time slots are setup in Configuration > Time Slots . Select
the check box to activate the time slot.

Features Section- The features are yes/no flags, which define individual characteristics of the type processing. If the check box is selected then
the feature is enabled.
Teamwork

Enable segmenting and extended
duration

When selected, the Activity type is allowed for teamwork. This option can only be selected while
creating the Activity Type. When the Teamwork activity feature is enabled, these activity type
features are disabled:
• Enable segmenting and extended duration
•

Allow move between resources

•

Allow creation in buckets

•

Allow reschedule

•

Allow non-scheduled

•

Enable 'day before' trigger

•

Enable 'reminder' and 'change' triggers

•

Support of work zones

•

Support of work skills

•

Support of inventory

•

Support of preferred resources

•

Allow mass activities

When selected, the Activity type is intended to be used for field work that must be split into
segments, which can be scheduled and assigned to technicians. You can select this option only
while creating the Activity Type. When you select this option, a new section, Enable segmenting
and extended duration, appears in the Add activity type window where you can set the duration
for segments. These fields are displayed in the Enable segmenting and extended duration
section:
• Minimum segment duration for a single day: Defines the minimum length (in minutes) of each
segment the activity is to be split.
•

Maximum segment duration for a single day: Defines the maximum total duration (in minutes)
of the activity segments for any day.

When the Enable segmenting and extended duration feature is enabled, these activity type features
are disabled:
• Teamwork
•

Allow mass activities

•

Allow repeating activities

•

Enable 'day before' trigger

•

Enable 'reminder' and 'change' triggers

•

Enable 'not started' trigger

•

Enable 'SW warning' trigger
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Field

Description

Allow move between resources

When selected, the activity type can be moved from one resource to another. This option cannot be
enabled if Teamwork is selected.

Allow creation in buckets

When selected the Activity type can be created in a bucket.
• This option cannot be enabled when Teamwork is selected.
•

This option can only be enabled if Allow move between resources is selected.

Allow reschedule

When selected allows the reschedule of an activity to another date.

Support of not-ordered activities

When selected the activity type can be a not-ordered activity.
Not-ordered activities are the ones for which the order of execution is not defined. Such activities
don't have an estimated time of arrival. The resource, dispatcher or routing may define the order (for
example, command change order in mobile interface or edit activity command in web interface).

Allow non-scheduled activities

When selected this activity type can be a non-scheduled activity. This option cannot be enabled if
Teamwork is selected.
Non-scheduled activities are the ones that don't have a specific day of completion assigned to
them.

Support of work zones

When selected, this defines if a resource work zone must be calculated. This option cannot be
enabled if Teamwork is selected. If this option is selected and a work zone cannot be calculated, a
warning is displayed when such an activity is moved; routing will not assign such activities. If using
work zones, Business rules must be configured to allow support of work zones ( Configuration >
Business Rules > GUI features > Enable work zones support ).

Support of work skills

If selected, work skills will be calculated and assigned to the activity based on any conditions met.
Subsequently, only resources with matching work skills will be considered for assignment of the
activity. If cleared, work skills are not considered and the activity can be assigned to any available
resource.
• This option cannot be enabled if Teamwork is selected.
•

This option does not depend on the Allow move between resources feature (as work skills
are used not only to move activities but to calculate capacity).

If using work skills, Business rules must be configured to allow support of work skills (
Configuration > Business Rules > GUI features > Enable work skills support ).
Support of time slots

When selected defines if time slots are required for activities of this type. This refers to preconfigured time slots within which the activity can be performed.

Support of inventory

When selected, this defines if inventory can be used for activities of this type (e.g. lunch breaks and
meetings should not have inventory). This option cannot be enabled if Teamwork is selected.

Support of links

When selected, allows for the linking of predecessor/successor activity relationships.

Support of preferred resources

When selected, allows for resource preferences (Preferred Resource tab) to be defined for activities
of this type. This option cannot be enabled if Teamwork is selected.

Allow mass activities

When selected defines if activities of this type can be Mass activities.
• This option cannot be enabled if Teamwork is selected.

Allow repeating activities

•

This option cannot be enabled if Allow move between resources is selected.

•

This option cannot be enabled if Support of not-scheduled activities is selected.

When selected defines if activities of this type can be recurrent.
• This option cannot be enabled if Allow move between resources is selected.
•

This option cannot be enabled if Support of not-scheduled activities is selected.
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Field

Description

Calculate travel

When selected, defines if the travel time to an activity must be calculated. If an activity has
Calculate travel enabled and has neither travel key (i.e., zip code) nor coordinates, a company
default value will be used as a value of travel to and from the activity.
• If the feature is enabled the algorithm implemented for activities is used for all activities of the
type.
•

If the feature is not enabled (not selected) the travel time to activities of the type will always be
calculated as zero (0) (as if location of activities of the type is the same as location of previous
activity) and travel to the next stop also starts from this previous location.

Calculate activity duration using
statistics

When selected, specifies that the activities are estimated using the statistics that are gathered at the
resource level and company level.

Allow to search

When selected, specifies that the Oracle Field Service Cloud Search Engine indexes activities of this
type.

Allow to create from Incoming interface

When selected, specifies that activities of this type can be created from Inbound Interface. Activities
may originate from either Oracle Field Service Cloud or external systems.

Enable ‘day before’ trigger

When selected defines if day before trigger is invoked for activities of this type. This option cannot
be enabled if either Teamwork or Enable segmenting and extended duration is selected. This
option can only be selected while creating the Activity Type.

Enable ‘reminder’ and ‘change’ triggers

When selected defines if 'reminder' and ‘change’ triggers are invoked for activities of this type. This
option cannot be enabled if either Teamwork or Enable segmenting and extended duration is
selected. This option can only be selected while creating the Activity Type.

Enable ‘not started’ trigger

When selected defines if 'not started' trigger is invoked for activities of this type. This option cannot
be enabled if either Teamwork or Enable segmenting and extended duration is selected. This
option can only be selected while creating the Activity Type.

Enable ‘SW warning’ trigger

When selected defines if 'SW warning' trigger (Service Window warning) is invoked for activities
of this type. This option cannot be enabled if either Teamwork or Enable segmenting and
extended duration is selected. This option can only be selected while creating the Activity Type.

Calculate delivery window

Defines if a delivery window can be calculated for activities of this type.

SLA and Service window use customer
time zone (required for routing)

When selected, supports SLA/Service Window adjustment changes. This feature must be used if
the Support of time slots feature is enabled.

Support of required inventory

When selected, this defines if required inventory is supported for activities of this type.

Disable resource tracking for this activity
type

When selected, the resource's geolocation will not be tracked, if the activity is status ‘Started’. The
message, ‘Your location is not tracked for this activity.’ appears on the Landing page. Location
tracking resumes after the activity status changes (that is, the status changes to ‘Completed/End’,
‘Suspend’, or ‘Not Done’) and, the route is still active. This functionality is supported in the Oracle
Field Service Cloud Core Application (browser) and installed applications (Android and iOS) and
requires Oracle Field Service Smart Location Cloud Service, Oracle Field Service Professional Cloud
Service or Oracle Field Service Enterprise Cloud Service. This message is not displayed if you have
not selected Enable GPS Telemetry under the Configuration > User Types > Permissions
section.

Related Topics
• How Activity Duration Is Calculated
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Activate, Deactivate, or Delete Activity Types
If you don't want to use an activity type any more, you can either deactivate it, or delete it. Similarly, if you have an existing
deactivated activity type, you can activate it and start using it.
1. Select the check box next to an activity type.
Options appear at the top of the screen.
2. Click the appropriate button, based on the action you want to perform.
Note: Deactivate does not delete the activity type; it just makes it inactive.

How Activity Duration Is Calculated
Activity duration can be either defined manually or calculated using statistics that are obtained from learned durations.
Note: You can specify durations for specific activities and technicians through APIs. For more information, see
the REST API for Oracle Field Service Cloud guide.
The manually-defined and statistical methods work as follows:
• Manually-defined: If the Calculate activity duration using statistics check box is not selected in the Add activity
type or Modify activity type screen, the duration specified at the time of creating the activity is used. If the duration
is not specified in the activity, the default duration for that activity type is used.
• Statistical: If the Calculate activity duration using statistics check box is selected in the Add activity type or
Modify activity type screen, the duration of the activity is calculated based on statistical methods. If the history is
not enough to calculate using statistics, the duration entered manually (if entered) at the time of creating the activity
is used. If neither history nor a manually entered value is present, then the default duration for that activity type is
used. The default duration is specified at the time of creating the activity type.
Calculation of activity duration using statistics
Activity duration estimations are calculated by the application based on the historical data of completed activities. The
application analyses new data, compares it against previous estimations, and corrects the previous estimations, based on the
new data, to obtain updated estimations for future usage. For this, the application uses two main statistics: company profile
and personal profile. The application learns how each technician performs tasks and updates these statistics daily.
• Company profile: The activity duration is calculated at the company level based on the Activity duration stats
fields configured in the Statistics screen. All activities belonging to the same field value are grouped together for
calculating the duration. The key is typically something that identifies similar activities as a single entity including
fields such as Activity Type. When a technician performs tasks and reports the time against them, the company
level estimate is derived for each task type based on the stats field values. The application gives more importance to
more recent data for computation, rather than historic data. This increases the estimation accuracy and allows the
application to respond to changes in trends in a timely manner. The default duration specified in the Add activity
type screen is used as the starting point for estimating the duration. The application:
◦ Refers to the previous experiences of similar tasks.

◦

Calculates the estimate based on the summary of experiences.
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Learns from new experiences.
Updates and remembers the updated experiences for future use.

Every day the estimate is modified by a small amount, based on the durations reported on the previous day for
similar activities. The correction applied is controlled to ensure that there isn’t too much deviation from the previous
estimation and the estimated durations don't keep fluctuating on a daily basis; but is significant enough to respond
to any trend change within a few days.
The formula to calculate the new estimate is:
New estimate = Previous estimate +/- Correction

where correction is based on previous estimates and the differences between the estimated and reported durations.
• Personal profile: Along with the company level estimate, the estimated time for the activity for the technician is
computed in the form of a ratio. This ratio is calculated based on the company level estimate for the activity. The
final estimate at the technician level is the product of the personal profile ratio and the company level estimate.
Each technician may have different ratios for different types of activities, based on their performance. Similar to the
correction applied to the Company level estimates, the Personal profile ratio is also updated by a small controlled
amount every day, based on the durations reported by the particular technician on the previous day for similar
activities. When a technician performs an activity for the first time, the default ratio is used.
Some more important points about activity durations:
• If the personal profile is not available for an activity key value, the default ratio for the technician is used.
• The default ratio has an initial value that is specified in the Initial Ratio for Activity Duration field. This value will be
updated each time the technician performs a relatively new activity.
• You can specify which type of resources use personal profile. If this setting is not selected, such resource types will
not use the personal profile and will use only the company wide estimations.
• You can specify whether a resource affects the company level estimates. If it does, you can also specify the number
of days to be skipped. The duration reported by only those resources that satisfy these two conditions is used to
modify the company level estimates.
• You can set upper and lower limits for activity durations. The values will always remain within the set limits.
The fields that affect activity duration are:
Field

Screen

Minimum and maximum relevant
duration time in minutes

Statistics

Lower/Upper limit for personal ratio for
duration calculation
Default duration

Add activity type and Modify activity type

Calculate activity duration using
statistics
Personalize the estimation of activity
duration

Add resource type

Use durations reported to enhance
company-wide estimations
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Screen

don't consider reported data of the first
x working days
Initial ratio for Activity Duration

Resource Info

Working days left for reported data to
start impacting duration estimations

Configuration examples
Example 1: Application uses the duration that is provided at the time of creating the activity
• Activity Type screen:

◦
◦

Default duration = 30
Calculate activity duration using statistics = not selected

If the activity created has a duration of 50 minutes, that value (50) is used, if no value is provided at the time of creating the
activity, 30 minutes is used.
Example 2: New resource in the application has no historic data. The administrator wants to provide 20% more time than the
estimated duration at the company level.
• Resource Type screen: Personalize the estimation of activity duration = selected
• Resource Info screen: Initial Ratio for Activity Duration = 120%
• Activity Type screen: Calculate activity duration using statistics = selected
• Assume company-wide estimation for the activity to be 45 minutes
Since the resource does not have previous records for this kind of activity the initial (default) ratio is used for calculations. The
estimated duration for the resource is: 45 * 120% = 54 minutes
Example 3: Application uses technician’s learned duration with limits. Resource has performed activities of this type in the
past and, hence, has a personal activity key ratio.
• Statistics screen:

◦
◦

Lower limit for personal ratio to calculate duration = 50%
Upper limit for personal ratio to calculate duration = 200%

• Resource Type screen: Personalize the estimation of activity duration = selected
• Activity Type screen: Calculate activity duration using statistics = selected
• Assume personal profile to be 90% and company-wide estimation for the activity to be 50 minutes.
Since the personal activity key ratio falls within the set limits, it is used for estimations. The estimated duration for the resource
is 50 * 90% = 45 minutes.
Example 4: Application uses company duration without using personal profile
• Statistics screen:

◦

Minimum relevant duration time in minutes = 3
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Maximum relevant duration time in minutes = 1440

• Resource Type screen: Personalize the estimation of activity duration = not selected
• Activity Type screen: Calculate activity duration using statistics = selected
• Assume company-wide estimation for the activity to be 45 minutes
Since the personal profile is not configured and the company-wide estimation is within the set limits, the estimated duration
for the resource is same as the company wide estimation = 45 minutes.

Pre-Calculated Travel Statistics
Travel statistics are based on the actual durations reported by field resources. As such, new customers and existing
customers expanding into new operating areas will not have actual durations in the application. With this release, the
application will use pending activities to derive estimated durations. Using this method improves travel durations at the time of
optimizing routes and moving activities.
Oracle Field Service Cloud performs this process once a day:
• Get the list of activities and their locations.
• Estimate the probability of travel in future between each pair of ’Activity travel stats fields' (Travel Keys). The travel
probability is calculated for all Travel Key pairs within the same travel area.
• Calculate travel durations. The travel durations are calculated only between keys that share a common travel area.
• Sort Travel Key pairs in descending order.
Note: Travel Keys that have existing learned travel are excluded from the estimation process.
• Estimate a maximum of 3,000 pairs based on the sorted list.
After performing the process, the application has additional travel duration data. The next time Routing runs or a user moves
an activity, the system uses the pre-calculated travel values. Calculating probability and sorting Travel Key combinations:
• Only activities that have the address resolution to the level of 'Address' are considered for calculations.
• Activities that have valid coordinates with an accuracy value of either 8, 9, or 0 are considered. Travel coordinates
with an accuracy value of ‘0’ are provided by customers.
• Travel Keys that have at least 4 pending activities or 12 regular activities (or their combination) are considered for
estimation.
• All activities belonging to the same Travel Key are considered to be in similar locations.
• In the first cycle, the average travel duration within each Travel Key is calculated. This is done by selecting the
corner most activities (based on x and y co-ordinates) within the Travel Key and the average distance between the
locations. The Travel Keys are sorted in descending order of the number of activities, while sending the coordinates
for calculation.
• In subsequent cycles, the average travel time between different Travel Keys is calculated. Here, the sorting of Travel
Key pairs is based on the number of activities present in both the Travel Keys involved.
Example of sorting Travel Keys: Consider these Travel Keys with the corresponding number of activities and travel areas:
Travel Key

Travel Area

Number of Activities

TK1

TA1

100
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Travel Key

Travel Area

Number of Activities

TK2

TA1

150

TK3

TA1

200

TK4

TA2

50

In this scenario, the Travel Keys are sorted as follows before being sent to the Location Service:
• TK3-TK3 (within the same Travel Key)
• TK2-TK2 (within the same Travel Key)
• TK1-TK1 (within the same Travel Key)
• TK4-TK4 (within the same Travel Key)
• TK2-TK3 (between Travel Keys that share the same Travel Area)
• TK1-TK3 (between Travel Keys that share the same Travel Area)
• TK1-TK2 (between Travel Keys that share the same Travel Area)

Configure Business Rules
Business Rules help you configure the application to suit your requirements.
The Business Rules visibility profile permission controls the access to the Business Rules page. You must set this
permission for each user type that manages Business Rules. If the action is not configured for a user type, or if no visibility
is defined, the users don’t see the Business Rules page. If you select ReadOnly, Business Rules is placed into a view-only
mode. If you select Read/Write for this setting, the user can manage Business Rules in Oracle Field Service Cloud.
1. Click Configuration.
2. In the General section, click Business Rules.
The Business Rules screen appears.
3. Complete these fields:
Field

Description

General
Work Skills Support
Work Zones support

If a feature is disabled (unselected) the settings defined for it are retained in the application,
but no restrictions are applied.
Work skills and work zones are critical settings greatly affecting performance, particularly,
activity assignment to resources. When they are enabled, they impose these constraints on
the process of activities assignment and reassignment:
Routing takes into account work skills and work zones and assigns activities only to
resources matching the work skill and work zone requirements of the activities.
All newly-created activities have work skills and work zones calculated for them and,
therefore, will be correctly assigned afterwards
Self-assignment, Quota management, manual activities move or assignment are
subjected to work skills and work zones check

◦
◦
◦

All these factors contribute to higher application performance and help improve the use
of the workforce. Disabling work skills support and/or work zones support may result in
Routing results below optimum and, therefore, must be used with care.
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Field

Description

Service Window Support

If selected, by default the Service Window placeholder is selected when an activity or
teamwork is created (must be defined).

Points Support

Select the box if you use points. When points are used, each shift and corresponding work
schedule is assigned a certain number of points, which are a relative expression of the
required work to be performed within such work schedule. Similarly, each activity may be
also assigned a certain number of points. As the resource completes activities in their route,
their points are added and compared to the total number required for the work schedule.
Points may be used by Routing in activities assignment.

Overnight Work

The number of hours for overnight work since midnight. Used only if you have overnight
work activities. Select the time zone used to define the work-day closure from the dropdown menu. If the value is greater than 0, it is possible to create activities for the previous
day’s route and perform other route modifications based on the time zone setting value.
Working time ____ hours since midnight <…..>
This setting affects the logic of data saving by the Daily Extract functionality. If the company
does not support overnight shifts, the extraction period covers time since the previous
extraction till the end of the previous day. If the company supports overnight shifts, the Daily
Extract data for the previous day are available for extraction after the overnight expiration,
i.e., at 00:00 AM + overnight. If the data is extracted before that time, the resulting files
will contain data of 2 days before. It is recommended to schedule Daily Extraction several
minutes after the overnight expiration to guarantee that only the relevant data is extracted.

Full-time Equivalent

Used in the Planning section of Mobility Calendars. The value is a company wide setting.
The value converts the calendar to a Full-time Equivalent resource. For example: If the
resource works from 08:00-16:00 (8 hours) and the Full-time Equivalent value = 8 this
resource will be shown as 1 Full-time Equivalent.

Expose mass and repeating activities
for these number of days

The number of days in advance in which the template activities are created in technicians’
routes automatically.
The default value is '0', which means that such activities are not instantiated automatically,
but are created only when a route is created. When you modify the value and save it, Oracle
Field Service Cloud scans all the technician routes and instantiates the templates for the
dates that match the configured period. If you increase the value, then the application
includes more dates into consideration for automatic instantiations. If you decrease the
value, then the application does not remove the existing instantiated activities, instead
processes fewer dates from then on. When you add a new resource or change the
templates and schedules, the application changes the activities accordingly.

Note: Instantiating activities may require significant time, especially if you increase
the value and there are many technicians in the application. It also generates a
significant amount of transactions such as events (routeCreated, activityCreated)
and outbound messages for the "Activity is created" launch conditions.
Activity Priority

Activity priority is used by Routing to assign urgent activities, immediate activities, and to
prioritize activities for self-assignment on the map in Mobility. You can use any custom
property of activity with type string, enumeration, or integer, but not fields. The configuration
consists of these parameters:
Property to define priority: Defines the activity property that will be used to identify
urgent, immediate, and self assignment activities.
Urgent activities have these values of the property: Defines the specific values
of the property, which make the activity urgent or immediate. Several values of the
same property can be used as criteria. In this case the values must be separated by
commas in the field. The order of property values defines the priority level. The value
listed first will have the highest priority, with other values following in the descending
order. For example, if you have a privileged customer, you may specify it as a specific
value (such as "PC") in an activity property, so it qualifies the activity as urgent. For
enumeration properties, you must specify the enumeration values.

◦
◦
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Description

◦

Normal activities have these values of the property: Defines the specific values
of the property, which make the activity normal. For example, in-house activity
selected as "IN" in an activity property may qualify the activity as normal.
When activities are routed using the immediate routing run option or the urgent routing
option, the priority specified in the field that you select here are considered. For example, a
company must always perform repairs as soon as possible to reduce service disruptions.
In this case, the company may have a custom property which indicates that the activity
is "Repair" to consider an activity as urgent. The preferred ETA for Urgent activities is the
earliest possible time. SLA start time does not have any impact on Urgent activities, which
means, SLA violation is expected behavior. Further, even if you select Immediate routing,
SLA start time does not have an impact on the Urgent activities ETA.
Enable the Visit functionality

Define Bundling Keys for a Visit

Visit Bundling Keys

Define Bundling Keys for a Visit

Maps and Geocoding
Available Countries

Geocoding is the process of finding associated geographic coordinates (latitude and
longitude) from other geographic data, such as street addresses, or zip codes (postal
codes). Geocoding data is required for Routing and is critical for Map/driving directions.
Proper geocoding information is necessary for every country that this instance of the
application is operating within. The Available Countries field allows adding additional
countries for geocoding purposes.
Select the + symbol to select an additional country form the drop-down menu. Select the
pencil icon to edit the country name for localization purposes.

Default Country for Geocoding

Determines from which country the Available Country list above is used as the default
country for geocoding.

Zip Code Format

Defines the format of ZIP (postal) code and state code values, when applicable. Both fields
are used in the activity coordinates resolution from its geographic address. The ZIP value is
validated by the Inbound API, therefore, its format is important. When the ZIP value sent by
the Inbound API does not correspond to the format set in the Business Rule, the API returns
an error. However, when the Free Post code option is selected, the ZIP value is not validated
and will always be accepted.

State Format

The State format field includes Free format and US. Select US for addresses in the USA
having a strict 2-letter state code format. For all other countries with different civil entity
systems, select Free.

GPS

Identify technician by – Determines how a unique technician is identified within the context
of GPS plotting.
these items are applicable with Oracle Field Service Cloud Smart Location Cloud Service:
Resource is considered idle if moved less than __ meters within _- minutes

◦
◦

Map Parameters

Resource is considered to be at the activity location if the distance is less
than __ meters -

Defines the items related to the Map screen:
Distance Measurement Units: Specifies whether distance is measured in miles or
kilometers.
Ignore coordinates with accuracy less than: Sets the minimum sufficient
accuracy level for geocoding. The minimum sufficient accuracy level is the
coordinate’s accuracy which is considered acceptable for usage. The coordinates
below the specified level will not be used as insufficiently accurate.
Baidu Maps and Geocoding parameters: Indicates the server key and browser
key for Baidu maps, which are used to authenticate the user or organization using the
service.

◦
◦
◦
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Note: Driving directions for Oracle map and geocoding are only shown in these
languages: (English (default), French, German, Italian, and Spanish). The default
maps and geocoding provider is Oracle. Google or Baidu can be used, if it is part of
your subscription. To use Google or Baidu maps, contact Oracle Sales. Further, you
can have only one provider (Oracle, Google, or Baidu) configured in the application.
Information about the geocoding provider is displayed on the Configuration >
About screen, Enabled Services section.

Map Layers

Lets you add two types of map layers: Work Zone layer (work zone shapes) and custom
map layers (for example, places of interest such as gas stations or gas pipelines) on top of
the map. You can add a Work Zone layer or a new map layer, modify or delete an existing
layer, and change the permissions for an existing layer. When you click Add new, the Add
Map Layer screen appears. You can either upload shape files through the interface or
through an API, or you can provide the path to MapViewer from where the custom layer is
obtained. You also see these sections:
Status: Indicates the status of the layer. If the shape file is uploaded successfully
and is ready for use, the status displays a green check mark. If the shape file is not
uploaded properly or has any errors, the status displays a red cross mark.
Map layers: Provides the name of the map layer and the date on which it was last
updated. If the map layer is not available, this column provides the reason such as:
Shape loading failed.
Permissions: User types to which the layer is assigned. If there are multiple user types,
they are displayed as, ‘<user type> and <number> more’. For example, ‘Technician
and 3 more’. This column is empty for the Work Zone layer.

◦
◦
◦

Note: The Permissions option is not available for a Work Zone layer.
Properties of Work Zone layers:
Each Work Zone can have only one map layer, and if it does not exist, the message,
No configured layers appears.
You can create only one Work Zone layer. After a Work Zone layer is created, the
Create Work Zone layer option is grayed out on the Add map layer screen and the
message "Only one layer for work zone shapes can be created" is displayed.
When you delete a Work Zone layer through the metadata API, only the layer
is deleted. The shape files are not deleted from the database. However, when
you delete a Work Zone layer from the Manage interface, by selecting the Delete
associated shapes option, the layer and its associated shapes are deleted.

◦
◦
◦

Nearby Radius and Nearby SLA

Defines the criteria of the nearby activities search in the Nearby screen of the Mobility
application. It does not affect the Scheduling layer on the Map screen. The Scheduling layer
shows all activities in the visible part of the map.
The Nearby Radius value sets the radius of the circular area in which nearby activities is to
be searched. The Nearby SLA parameter sets the SLA expiration period which activities
must have to match the search criteria. The default values are 50 kilometers as the radius
and 60 days as the SLA. The minimum values are 1 km and 1 day, respectively. The
maximum values are 1000 km and 1000 days, respectively. As the result, the functionality
searches a circular area with the center in the resource location and the radius equal to the
Nearby Radius value, selecting the activities with SLA expiring within the period defined as
Nearby SLA. Any activities not conforming to these criteria will not be included in the search
results.

Company Boundaries

The latitude and longitude coordinates of the company’s geographical work area. Activities
can be performed only within these boundaries that are a set of squares. To identify a
square, its top left and bottom right corners are defined. If no boundaries are defined the
company can perform work anywhere. Additional boundaries can be added by clicking the +
symbol.

Quota Management

these items are applicable with Oracle Field Service Cloud Capacity Cloud Service:

22

Oracle Field Service Cloud

Chapter 1

Administering Oracle Field Service Cloud
Field

Configure Oracle Field Service Cloud
Description

◦

Measurement units for Quota and Available Capacity
Defines the general settings affecting Quota Management functionality. Particularly,
the user can choose the units of measurement to display Quota and Used values by
setting the Quota and available capacity are defined in parameter. The available values
are hours, man-days and minutes. Internally, all values are calculated in minutes
anyway, and are converted to the selected unit when the corresponding value is
displayed in the Quota View.
When man-days is selected as the unit of measurement, the Number of hours per
man day is field appears where the correlation between man-days and hours can be
defined. Ultimately, this parameter is used to convert man-hours into minutes.

◦

When the Quota is defined as percentage of the capacity available by calendar,
sometimes it requires adjustment. To adjust the value, the system estimates the
capacity available by calendar, processes the already booked activities (to calculate
the Other activities value), and, finally, recalculates the Quota in minutes using the
defined percentage value.
Recalculation period
You can set a predefined time interval for Quota and Capacity recalculation using the
every [ ] minutesfield.
Valid values: 1 to 1,440 minutes
Default value: 10 minutes
Also, you can recalculate quota and capacity for a predefined future period (defined
as days or calendar weeks). For example, if you enter 10 minutes and set 3 calendar
weeks for Quota and Capacity recalculation, then the recalculation occurs after every
10 minutes for 3 calendar weeks.
The Calendar Week (duringdrop-down list) option is processed based on the value
selected from the First Day of the Weekdrop-down list in the Display screen.
When you use the Calendar Week option, all remaining days of the current week
(unless the start day is the week start day selected using the First Day of the Week
drop-down list) plus all days of these weeks are considered.
However, if the recalculation period is set to 7 days, the recalculation is performed for
7 days only. The maximum value for the Calendar Week option is set to 99 days or 15
calendar weeks.
You can select the recalculation start day (current day, tomorrow, or day after
tomorrow) from theThe Corresponding quota values are automatically adjusted
starting from drop-down list.
The Quota and Capacity is recalculated for the Available Capacity, Booking
Status, and Quota screens.

Note: When an activity is booked during the predefined recalculation period, then
irrespective of the routing schedule and the specified recalculation period, the values
in the Available Capacity, Booking Status, and Quota screens are recalculated
immediately.
Capacity Intervals

See Define Time Intervals section in the Oracle Field Service Cloud Capacity Cloud Service
Guide.

Search Fields

Define Search Fields for Core Manage and Define Search Fields for the Mobility
Application
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Note: Search uses the first 40 characters of the search string. Inventory search
does not support enumeration type fields.

Related Topics
• Add a Map Layer

How Geocoding Works
Oracle Field Service Cloud attempts to geocode a location using the address data that is provided when the activity is
created.
The application uses these fields when attempting to geocode the location:
• Address (caddress)
• City (ccity)
• State (cstate)
• Zip/Postal Code (czip)
• Country (country_code)
Data provided in these fields are submitted to the geocoding service without any modification or manipulation. When the
geocoding service resolves a location, it returns a response with an accuracy level. In understandable terms it is accurate up
to the address, accurate up to the street, and accurate up to the city. The location is resolved based on the selection made in
the Ignore coordinates with accuracy less than setting on the Business Rules screen. For example:
• If the value for Ignore coordinates with accuracy less than is Address, and the geocoding service returns
Accurate up to the Intersection, the location is not resolved, because the lowest acceptable level based on the
configuration is Address.
• If the value for Ignore coordinates with accuracy less than is Intersection and the geocoding service returns
Accurate up to the Address, the location is resolved, as it exceeds the lowest acceptable level based on the
configuration of Intersection.
Ignore coordinates with accuracy less than includes these options in descending order:
• Address: Indicates an accuracy level of the exact premise. Usually requires an exact match of the address (including
house number, street name, street type/suffix/prefix), city, state, zip, and country.
• Intersection: Indicates an accuracy level of a major intersection, usually of two major roads.
• Street: Indicates an accuracy level of a street.
• Route: Indicates a named route (such as US 101). This may not apply to all countries.
• Zip: Indicates an accuracy level of the zip/postal code. May also require a city name and country match.
• City: Indicates an accuracy level of the city. May also require the country name to be matched.
• County: Indicates an accuracy level at the county level. This type may indicate a minor civil administrative level. Not
all countries have this type of administrative levels.
• State: Indicates an accuracy level at the state level. Within the United States, these administrative levels are states.
Not all countries have this type of administrative levels.
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• Country: Indicates an accuracy level of the country. If you update an existing activity (with resolved coordinates) with
a new country_code, the coordinates for the activity are reset to zero (acoord_x=0, acoord_y=0).
The better the data quality, the more likely the location is resolved. For example - if you submit “10 Henr St Chartley, MA
02712”, the accuracy level will most likely result in something less then an accuracy level of Address, because Henry is
misspelled. Other items to watch out for are extra characters or spaces in the fields, missing or wrong address prefix or suffix,
abbreviations that don't match postal guidelines, a new address that is not in any geocoding service, wrong data (wrong zip/
post code or street name), and partial data. Any of these items can cause challenges with resolving an address.

Best practices
• We strongly recommend that you send us the geo-coordinates when you create activities. This ensures that the
coordinates are available for use in the application. Send the values using Coordinate X (acoord_x) and Coordinate
Y (acoord_y). These values are also required for some features available in the Oracle Field Service Cloud Enterprise
SKU when Google Maps is used (for example, real-time travel adjustments).
• For the activities associated with the Activity Types that have the Calculate travel option selected, we encourage
you add and populate address fields. This helps the application use the information to make the best possible
decision.
• We recommend setting the Ignore coordinates with accuracy less than to Zip. Any other settings may result in
fewer locations being resolved or too many locations resolved with a low level of accuracy.
• don't include additional address elements in the Address (caddress) field. The element includes but is not limited a
business name, unit, flat, suite, floor number, and so on.
• Avoid uncommon abbreviations, or abbreviations that are part of a defined standard used by the postal authority. It
is possible that “Ave”, “Ave.” and “Avenue” can lead to different accuracy resolutions.
• You may have to experiment to find the best way to send address data to Oracle Field Service Cloud.

Add a Map Layer
Map layers are layers that are added on top of a map. The layers may include those places of interest that are specific to
your business. You can add layers through an external source, or internally through APIs. Use APIs to upload shape files for
each layer that you want to create and configure the shape files in the Manage screen. You can also add a layer for your work
zone, which is visible to all users.
If you are adding a map layer internally, you must upload the shape file through the metadata API.
Note: Work Zone layers are not displayed on the Map view in Oracle Field Service Mobility Cloud Service.
1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Maps and Geocoding section, click Add new.
The Add Map Layer dialog appears.
4. Select whether you want to create a Work Zone layer or a map layer.
You can add only one Work Zone layer; after you add it, the Create work zone layer option is grayed out.
5. Enter the name of the layer in the preferred language.
The languages displayed here are the languages that you have selected for Company language in the Display
screen. This option is not available for the Create work zone layer option. The application adds the name ‘Work
Zone Layer’ automatically and translates into the required languages.
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6. Add a label for the custom layer in the Label field.
If you have added a custom layer through the metadata API, the name is suggested as you type it. If you have not
added any layer through API and you don't add an external source, you cannot save the layer. This option is not
available for the Create work zone layer option. The application adds the name ‘wz_layer’ automatically and
translates into the required languages.
7. Select the status of the layer in the Status drop-down menu.
A layer with the Active status is available in Oracle Field Service Mobility Cloud Service, and a layer with the Inactive
status is not available. This option is not available for the Create work zone layer option.
8. Select the location from which you want to use the shape for the layer:

◦
◦

Upload shapefile later via API: Select this option to upload a shape file through API.

Upload shape now: Select this option to upload a shape file now. these fields are displayed:
- URL to shape file: Enter the URL to the location where the shape file is available. Use only a secure
protocol, that is, a HTTPS URL.
- Username and Password: Enter the username and password to access the shape file location.
- SRID: Enter the shape identifier that was generated in the application in which the shape was created.
Use
external data source: Select this option to use an external data source to display custom layers. This
◦
functionality requires Oracle MapViewer where the layers are created and stored. these fields are displayed:
- MapViewer URL: Path to MapViewer from where the layer data is obtained.
- Data source: The source of the map layer data used by MapViewer.
- Theme: Layer name in MapViewer.
All the fields are mandatory. If a field is left empty, the window is rejected with the error message: {field_name}
is empty.
◦ Use already uploaded shape: Select this option to use a shape that is already uploaded. The list of available
shapes is displayed and these details are displayed:
- Layer label: The label of the layer.
- Last updated: The date on which the shape file was last updated.
- Source URL: The URL in which the shape file is uploaded.
9. Click OK.
By default, users of all user types have access to the new custom layer. If the status is Active, the application verifies
if:
◦ Data for this layer is present in the database.

◦
◦

Data is consistent and not corrupted.

◦
◦

Activity List map: Accessed from Mobility > Activity List > Map

There are no errors when displaying the layer on map.

If these conditions are satisfied, the layer is saved and displayed on these Oracle Field Service Mobility Cloud
Service map screens:
◦ Team map: Accessed from Mobility > Map
Activity Details map: Accessed from Mobility > Activity Details > Map

Review these information before uploading shape files:
Requirements for the shape file:
• The shape file must be in a zip archive.
• The shape file must be in the root of the zip archive, not inside any folder of the zip archive.
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• If more than one shape file is present in the root of the zip archive, the first shape file of the default zip archive
reading sequence is processed and saved. The rest of the shape files are ignored.
• Column names in the shape file must contain only alphanumeric characters and underscore ('_').
• Column names must begin with an alphabet.
Shape file restrictions:
• When uploading a shape file using HTTPS, these restrictions apply: WebLogic's default certificate validator does not
accept certificates with wildcards (including Google Drive certificate).
• SRID value should be a valid SRID.
• A maximum of 2 GB is available for extracted shape file data that is uploaded and hosted in Oracle Field Service
Cloud.
• If a shape file contains a column with the name "SHAPE_AREA" (case insensitive), it is renamed as “SHAPE_AREA_".
• If a column name is same as an Oracle Database reserved word, then an underscore ("_") is prefixed to the column
name. The full list of Oracle Database reserved words is available at: Oracle Database Reserved Words.
Recommendations:
• It is recommended that you use shape files with compressed data size less then 50MB. The shape file data is
extracted and stored in the browser memory (when showing to end user), so the size of the file may heavily influence
the browser performance, including the inability to show the map layer.
• It is not recommended to use polylines for work zones.

Display a Work Zone Layer on a Map
You can display a Work Zone layer on the map, only if you have added it to the Business Rules page. Before you display a
layer on the map, you must select the shape identifier on the Edit Map Layer screen. The shape identifier helps you identify
the shape when you are working on a different screen. For example, the shape identifier can be the internal serial number.
1. To select the shape identifier:
a. Click Configuration > Business Rules .
b. Go to the Map layers section.
c. Click Modify against the layer for which you want to add the shape identifier.
d. In the Edit Map Layer screen, select a value in the Shape Identifier drop-down list.
2. To display the Work Zone layer on the map:
a. Click Configuration > Work Zones .
b. Select or create the work zone for which you want add the shape identifier.
c. Add the value of the shape identifier in the Work Zone Shapes field.
d. Click Update or Add.
The work zone shape corresponding to the selected shape identifier is displayed on the map.

Update Shape Properties
After you upload a shape, you can modify its properties such as visibility on the Map hint.
1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Map layers section, click the stack icon next to layer that you want to modify and click Modify.
The Edit map layer dialog opens and displays the information in the Layer info and Shapes sections. The
information in the Shapes section depends on the way in which you have uploaded the shape.
4. Select a title for the shape in the Shape title column drop-down menu.
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This title is displayed for the shape on the Map view in Oracle Field Service Mobility Cloud Service.
5. Fill up these fields in the Shape hint columns section:
Field

Description

Custom name

Enter a meaningful name for the layer.

Visible on hint

Select whether you want to display the name in the hint on the Map view in Oracle Field
Service Mobility Cloud Service.

6. Click Save.
The changes are saved.

Assign Permissions to a Map Layer
When you upload a shape, by default it is available for all user types. You can change the permissions as to which users can
see which shape.
1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Map layers section, click the stack icon next to layer that you want to modify and click Permissions.
The Select user types dialog appears. By default, all the user types are selected.
4. To remove access to the selected layer, click the minus icon next to the user type.
5. To provide access to a layer, click the plus icon. Select the check boxes next to the user types to whom you want to
provide access.
6. Click Save.
The changes are saved. The updated permissions come into effect the next time the user of the corresponding user
type logs in.

Delete a Map Layer
You can delete just a map layer, or a layer and its associated shape files. You can delete the layer using the metadata API, or
through the Business Rules screen.
1. Click Configuration > Business Rules .
2. Go to the Map layers section.
3. Click the menu on the right against the layer that you want to delete and click Delete.
The Delete map layer dialog appears.
4. To delete just the layer, click Delete.
If you go to the Add map layer screen and select the Use already uploaded shapefile option, the shape file that
was related to the deleted layer is displayed in the list.
5. To delete the layer and its associated shape files, select Delete associated shapes and then click Delete.
If you go to the Add map layer screen, the Use already uploaded shape file option is not available. This is
because, the shape file that was associated with deleted layer was removed from the Geospatial Database.
6. Click Save on the Business Rules screen.
Note: Deleting a layer and its associated shape file is possible only through the Core Manage interface.
The metadata API DELETE method removes only the layers from the database.
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Define Bundling Keys for a Visit
Oracle Field Service Cloud sends configured notifications for each activity separately. If several activities (appointments) are
scheduled on the same day for a customer and you want to send one notification of each kind (for example, day before,
reminder, or change notifications) to the customer, then select the Enable Visit Functionality check box to activate the Visit
functionality.
Use the Visit Bundling Key field to define the criterion for a visit. The criterion can include an activity property field, where
you can set the length of the property values and determine whether the property values are case sensitive. The application
compares the values defined in the activity fields against the specified criterion. Activities are grouped together as a visit,
only if the values of all visit bundling keys match the specified criterion. To ensure that external system messages are sent
properly, you must add a launch condition using visit triggers while configuring message scenarios.
When routing is run using Immediate Assignment and if the Bundling setting is used (only available in Immediate Assignment
routing), then the Immediate Routing plan uses the Visit Bundling key for route optimization. For example, when you use
the activity address as a bundling key and run routing for urgent activities, then routing finds activities that are on the same
address as the urgent activity to create visits. For more details, refer to the Immediate Activity Assignment section in the
Oracle Field Service Cloud Using Routing Cloud Service Guide. After you define the visit bundling keys, click Save to
recalculate the existing activities according to the new visit settings. To define bundling keys for a visit:
1. Click Configuration.
2. Click Business Rules in the General section.
The Business Rules screen appears.
3.
4.
5.
6.
7.
8.

Select the Enable the Visit functionality check box.
Click the Modify icon.
Click the Plus icon.
Select the required keys.
Click Add.
Use these filters to specify additional criterion for grouping activities:

Length: Enter an integer value between 0 to 99. For example, if you enter 5, then the first 5 values of the
activity property are considered.
◦ Function parameter: Select a parameter to determine whether the activity property values are case
sensitive, case insensitive, first word case sensitive, first word case insensitive.
9. Click Save.

◦

Note: If there are already visits in the system, and if the visit bundling keys are changed, then after
recalculation, the visits no longer matching the keys are split into individual activities.

Example of How to Define Bundling Keys for a Visit
Assume that an installation activity is scheduled for a customer on 21st June, 2016 and is the only notification you send to the
customer. The installation activity involves the activities, installing the hardware and installing the software but you want the
customer to receive only one notification.
Assume that installing the hardware is assigned to technician William and installing the software is assigned to technician
Philip. Both activities are scheduled on the same day at 4 to 5 pm and 5 to 6 pm respectively. Assume these details for the
customer:
• Account number: 123456
• Address: 77 Discovery Drive, Bozeman, Montana 59718
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Since both the activities are performed on the same day for the same customer and at the same location, and the goal is
to notify the customer only once, it is necessary to bundle the activities together and schedule a visit. Let us select Account
Number and Address properties as the bundling keys from the Configuration, Business Rules page and click Save. Since
the values defined in the activity fields (that is, Account number and Address) match the selected criteria (that is, Account
Number and Address properties selected as the bundling keys); the activities, installing the hardware and installing the
software, are grouped together as a visit. To verify whether the activities are grouped as a visit:
1.
2.
3.
4.

Select Dispatch, Activities.
Select the technician William from the resource tree.
Select the Installing the hardware activity from the dashboard and view the activity details.
Select the Links tab.
A Visit number is displayed with the Pending status.

5. Repeat steps 1 through 4 for the Installing the software activity.

Define Search Fields for Core Manage
Oracle Field Service Core Manage Cloud Service uses the activity property fields defined in the Search section of the
Business Rules screen to search for activities.
You can also edit the activity property fields in the Search section of the Business Rules screen to define additional search
fields to search for activities. For example, assume that the activities are searched using the Name and Account Number
activity fields. Now, you want to search the activities using the Address activity field. You can specify an additional search field
as follows:
1. Click Configuration.
2. Click Business Rules in the General section.
The Business Rules screen displays.
3. Click the Edit icon for Activity Search fields in the Search section.
The Activity Search Fields screen displays.
4.
5.
6.
7.

Click the Plus icon.
Select the Address field.
Click Add.
Click OK.
The Address field displays in the Activity Search Fields section.

8. Click Save.
9. Click the Core Manage Search icon and click the gear icon.
The Search preferences dialog displays the selected search categories.
10. Select the by Address check box.
11. Click the Back to Search button and enter an address, for example, 7700 Technology Way, in the Search field.
When a search is performed, the search fields are selected in the order defined in the Search preferences dialog.
You can perform these tasks in the Search Preferences dialog of the Core Manage Search option:
◦ Click the reorder icon to drag and drop the required activity search fields in the list to rearrange the order.

◦
◦

Select or clear the required activity search fields to add or remove the activity search fields.
Select an option from the Date drop-down list to refine the activity search results.

Note: Search uses the first 40 characters of the search string.
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The activities matching the specified address display.

Define Search Fields for the Mobility Application
Mobility uses the inventory property fields defined in the Search section of the Configuration, Business Rules screen to search
for inventories in Mobility.
You can also edit the inventory property fields in the Search section of the Business Rules screen and define additional search
fields to search for inventories. For example, assume that the inventories in the application are searched using Model and
Item Number inventory fields. Now, you want to search the inventories using the Serial Number field. You can specify an
additional search field as follows:
1. Click Configuration.
2. Click Business Rules in the General section.
The Business Rules screen displays.
3. Click the Edit icon for Inventory Search fields in the Inventory Search Fields section.
The Inventory Search Fields screen displays.
4.
5.
6.
7.

Click the Plus icon.
Select the Serial Number field.
Click Add.
Click OK.
The Serial Number field displays in the Inventory Search Fields section.

8.
9.
10.
11.

Click Save.
Log in to the Mobility application.
Click the Search icon.
Enter the Serial Number (for example, 8779808797) in the Search field and click Search.
The inventory matching the specified serial number displays.
Note: Search uses the first 40 characters of the search string. Inventory search does not support
enumeration type fields.

Capacity Time Intervals
The time interval set consists of time intervals delimited with a comma (","). Time intervals within the time interval set cannot
have time period in common (with the only exception of a "point in time" time interval.

Capacity Categories
A Capacity Category is a predefined set of work skills and/or work skill groups and time slots visible to a user who is booking
the activities for the customers.
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Based on the number of minutes available (Capacity = Initial Quota allocation minus used minutes), the user decides if enough
time is available within a time slot to realistically promise a specific service window to the customer. This information is sent to
the CSR via Capacity API. Capacity Categories are visible only if you are using the Oracle Field Service Cloud Capacity Cloud
Service module.
Note: The Used Minutes value is calculated based on the exact time (in minutes) from start to end of a working
day.
You must enable the Capacity Categories visibility profile permission for each user to access the Capacity Categories
window:
• Read-Only: Select this option to display capacity categories in a view only mode.
• Read/Write: Select this option to let the user manage Capacity Categories in Oracle Field Service Cloud.
If the permissions are not configured for a user type, the activity types will not be visible to the users. Oracle Field Service
Cloud maps the work skills to assign incoming activities to the resources. In general, many companies define quota for a work
skill group rather than for an individual work skill. For example, separate skills are required for installation, un-installing and
maintenance of modems, but from a scheduling perspective, quota is defined for all the modem-related works group.
A capacity category can also consist of a single work skill and the minimum required level of the skill level. For example, a
category can be created for all the customer-oriented work and a separate group for VIP customers or for highly difficult
tasks. The two categories would contain the same work skills but the minimal qualification level in the VIP group is higher.
Because of the categories and the multi-skill functionality, the same activity can match several rows in the Quota table and
can be added to the Used capacity several times. The duration of this activity will be taken into account for all the capacity
categories it matches.

Create a Capacity Category
Create a capacity category to configure work skills, work skill groups, and time slots.
1. Click Configuration > Capacity Categories .
The Capacity categories screen appears.
2. Click Add New.
The Add Capacity category window appears.
3. Enter the appropriate information in the following fields:
The following table describes the fields available on the Add Capacity category screen.
Option

Description

Name

Enter the name of the capacity category. The name is displayed in the list and in the quota
matrix. If the application is configured for multiple languages, input boxes will appear for
each language.

Label

Specify a label. It is used in the context of APIs and it must conform to a standard naming
convention.

Active

Select the Active check box to mark this capacity category as active. Only active capacity
categories are used in the quota matrix.

4. Click Save.
Once you create the capacity category, you must add work skills, work skill groups and time slots to the category.
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Edit a Capacity Category
Edit an existing capacity category to change the status, name, label, work skills, or time slots.
1. Click Configuration > Capacity Categories .
The Capacity categories screen appears.
2. Select the check box next to the capacity category that you want to change.
3. Click the pencil icon in the Name column.
The Edit Capacity Categories window appears.
4. Change the Name, Label, or Active field. Similarly, click the pencil icon in the Work Skills or Time slots columns and
change the required values.
5. Click Save.

Delete a Capacity Category
Delete a capacity category when you no longer need it.
1. Click Configuration > Capacity Categories .
The Capacity categories screen appears.
2. Select the check boxes next to the capacity categories that you want to delete.
3. Click Delete.
4. Click OK.
The selected capacity categories are deleted.

Add or Edit Work Skills Within a Capacity Category
A Capacity Category can contain one or more work skills and each work skill must meet a minimum required level.
1. Click Configuration.
2. In the General section, click Capacity Categories.
The Capacity Categories screen appears.
3. Click the pencil icon in the Work Skills column for the Capacity Category that you want to add or edit.
The Edit Work Skill window appears.
4. Select a work skill and add the minimum level of the skill required in the corresponding text box.
The default value is 1. When the minimum level of a work skill is defined, an activity matches a Capacity Category,
only if a required skill level for the activity skill is equal to or more than the level of the Capacity Category.
Note: If a capacity category contains a group of work skills, the activity matches the category, if it requires
at least one of work skills from the group.
Recalculate activities after any edits or updates have been made to apply changes to pending and future activities in the
system.
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Add or Edit Time Slots Within a Capacity Category
A time slot indicates that the work mentioned in the Capacity Category must be performed in the defined time of the day.
Capacity Categories can contain one or more time slot associations.
1. Click Configuration.
2. In the General section, click Capacity Categories.
The Capacity Categories screen appears.
3. Click the pencil icon in the Time Slots column for the Capacity Category you want to add or edit.
The Edit Time Slots window appears.
4. Select a time slot.
5. Click Save.

Create a Group or Help Desk
You can communicate with other users in your organization and organize help desk activities using Oracle Field Service
Cloud Collaboration. You can use the chat window to access data from the application, instead of using the Core Application
interface. For example, you can share details about a resource, an activity, or an inventory item, or you can move activities
and inventory. Oracle Field Service Cloud Collaboration is visible only if it is configured. This procedure describes how to
create a group or help desk.
The Collaboration screen shows settings that affect the way the user interface appears to the end user. While you may
retain the default settings for most of these settings, you can change a few settings during implementation based on your
business needs. Access to the Collaboration screen is controlled by the Collaboration visibility profile permission. You
must set this permission for each user type that manages Collaboration. If you don’t configure the permission or define the
visibility for a user type, users of this user type cannot access Collaboration. If you select ReadOnly, Collaboration is placed
into a view only mode. If you select Read/Write for this setting, users can manage Collaboration. To create a group or help
desk:
1. Click Configuration.
2. In the Subsystems And Integrations section, click Collaboration.
The Collaboration screen appears.
3. Click the + icon.
The New group screen appears.
4. Fill up these fields:
Field

Description

Name

Name of the group or help desk you are creating.

Type

Type of group you are creating—options are group and help desk.

Active

Specifies whether the group or help desk is active.

Description

A description for the group or help desk.
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5. If applicable, click the pencil icon in the Groups to collaborate with section to select the groups that the newly
created group can collaborate with.
The Select Groups window appears.
6. Select the required groups and click OK.
7. If applicable, click the pencil icon in the Assisting Helpdesks section to select the help desks the newly created
group can be assisted by.
8. Select the help desks and click OK.
9. Click Save.

Edit or Delete a Group or Help Desk
You can communicate with other users in your organization and organize help desk activities using Oracle Field Service Cloud
Collaboration. You can use the chat window of Oracle Field Service Cloud Collaboration to access data from the application,
instead of using the Core Application interface. For example, you can share details about a resource, activity, or inventory
item, or you can move activities and inventory. This procedure describes how to edit an existing group or help desk.
1. Click Configuration.
2. In the Subsystems And Integrations section, click Collaboration.
The Collaboration screen appears.
3. Select an existing group or help desk.
4. To delete, click Delete.
5. If applicable, click the pencil icon in the Groups to collaborate with section to select the groups that the newly
created group can collaborate with.
The Select Groups window appears.
6. Select the required groups and click OK.
7. If applicable, click the pencil icon in the Assisting Helpdesks section to select the help desks the newly created
group can be assisted by.
8. Select the help desks and click OK.
9. Click Save.

Configure the Display Screen
You configure the Display screen to change the way the user interface appears to the end user. While you may retain the
default settings for most of these settings, you can change a few settings during implementation based on your business
needs.
The Display visibility profile permission controls the access to the Display page. You must set this permission for each user
type that manages the Display settings. If you don’t configure the permission or the visibility, the Display screen is not visible
to the user. If you select ReadOnly, Display is placed into a view only mode. If you select Read/Write for this setting, the user
can manage Display. To configure the display settings:
1. Click Configuration.
2. In the Displays section, click Display.
The Display screen appears.
3. Complete these fields:
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Description

General
First day of the week

The week that the working week begins.

Time input

The way time is entered in the application-whether it is chosen from a drop-down with fixed
increments or is entered manually.

Allow application to be launched
inside iframe

Lets you launch Core Manage Cloud Service in an iFrame.

Remember User Name on Login
Screen

The control to display the Remember my username check box on the Login screen.
Selecting the Remember my username check box saves the user name and populates it
automatically, when a user uses the same device and browser to log in to the application.
This feature is available only for users who have the Internal and LDAP login policies, and not
for users who have the SAML or OpenID Connect policies. If a user’s authentication fails, the
user name is not populated when the user logs in the next time.

Enable password reset on Login
screen

Displays the Can’t sign in link on the Login screen, which helps users reset their
passwords. Resetting the password is a global feature and is available only for users
assigned to an Internal Login Policy. This is not available for users assigned to LDAP, SAML,
and OpenID Login Policies. Selecting this check box displays the Email for password
reset field.

Email for password reset

The source from which you want to get the email address of the user, who wants to reset
their password. This field includes custom properties that can be chosen as the source of
the email address to which the recovery email is sent. The custom properties are displayed
only if these conditions are satisfied:
Entity = User

◦
◦
◦

Type = String
GUI = Text or Email

Company time zones
Time zones

The globally available times zones. Use the Edit icon to add the required timezones.

Company language
Languages

The globally available languages. Use the Edit icon to add the required languages.

Login screen language

The language used on the login screen when accessing the application.

Mobile settings
Number of activities per page

The number of activities or resources to appear on one page on the mobile device. Default
value is 5.

Number of inventory per page

The number of equipment records to appear on one page on the mobile device. Default
value is 10.

Number of days to view on the
Calendar screen

The number of days to appear on the mobile device at a time. Default value is 14.

Idle time minimum

The threshold under which idle time is not displayed on the Time View for Mobility.

Quota settings
Major Capacity Usage

On the Quota grid, quota and minutes used display in brown once used = X% (major) of
initial quota. Enter the percent of quota that indicates major capacity usage.
Expected duration comprises [……] % of quota.
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Field

Description

Critical Capacity Usage

On the Quota grid, quota and minutes used display in bright red once used = X% (critical) of
initial quota. Enter percent of quota that indicates critical capacity usage.
Expected duration comprises [……] % of quota.

Enable Plan column that shows data
set in Forecasting

Whether a plan created in forecasting is available in the quota management screen.

Alert settings
Activity has not been started x
minutes before the end of Service
Window

The activity turns red and a Resource Tree warning appears based on the value set in this
field. Enter the number of minutes preferred.

Activity has not been completed
x minutes before the end of SLA
Window

The activity turns red and a Resource Tree warning appears based on the value set in this
field. Enter the number of minutes preferred.

Route has not been started x
minutes after the start time of
resource work day

A warning appears on the resource’s record within the Resource Tree. Enter the number of
minutes.

Activity has not been started x
minutes after ETA

A warning appears on the resource’s record within the Resource Tree. Enter the number of
minutes.

Activity list settings
Travel time representation

The color for travel time, if a visual of travel time is desired on the Time and List views.

Resource tree visualization
Show assistants

Shows assistants on the Resource Tree.

Show teams

Shows teams on the Resource Tree.

Show activity/teamwork counters

Shows the count of activities or teamwork on the Resource Tree.

Map
Fade resources

Whether a resource becomes transparent after geolocation data update.

Fade resource time

The number of minutes after geolocation data update after which a resource’s time
becomes transparent.

Hide resource time

The number of minutes after geolocation data update after which a resource’s time is
hidden.

Activity history
Monitored activity fields

The list of activity fields to be monitored. If one of these fields (or properties) is changed, a
record is inserted into a corresponding history table. Use the Edit icon to add the required
activity fields.

Monitored inventory fields

The list of inventory fields to be monitored. If one of these fields (or properties) is changed, a
record is inserted into a corresponding history table. Use the Edit icon to add the required
inventory fields.

History user type

The user type to be used to build the identifiers of objects (activities, inventory, and service
requests) that are to be logged into the history.

4. Click Save.
The settings are saved.
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Set Your Language
Oracle Field Service Cloud supports 23 languages to be set up as your preferred language. Manage the language setting
specific to your company requirements.
Note: A few terms (such as words used in report headers) may not get translated to the language selected as
the company's preferred language.
1. Click Configuration > Display
The Display page opens.
2. Under Company Language, select the appropriate languages from the available list and move them to the
selected list.
3. Select the Login Screen Language from the drop-down list.
4. Click Save.
The selected language is set.
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Note: these languages are supported:
◦ English

◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦

Chinese (Simplified)
Chinese (Taiwan/Mandarin)
Czech
Danish
Dutch
Finnish
French (European)
German
Greek
Hindi
Hungarian
Italian
Japanese
Korean
Norwegian
Polish
Portuguese (Brazil)
Romanian
Russian
Spanish
Swedish
Turkish

Create a Filter
Filters have two primary uses—first, filters narrow down lists of activities or resources within the workspace area, based on
defined fields and values. These filters are used within the Time, List, and Map views, providing an ad hoc reporting capability.
Second, filters within routing plans predefine the information that determines how routing distributes activities across available
resources. These filters are commonly set up to differentiate the cost, or value of assigning certain jobs to certain resources,
as well as determining the priority of certain types of activities.
The Filters visibility profile permission controls the access to the Filters window. You must set this permission for each user
type that manages Filters. If you don’t configure this permission or don’t define the visibility for a user type, users of this user
type cannot view the filters that you create. If you select ReadOnly, Filters is placed into a view only mode. If you select Read/
Write for this setting, the user can manage Filters. To create a filter:
1. Click Configuration.
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2. In the Displays section, click Filters.
The filters listing appears.
3. Click Add New.
The Add filter window appears.
4. Complete these fields:
Field

Description

Filter

The filter name that the users see. Enter the name in English and in all the languages that are
active in the application.

Applicable for

The entity type (activity or resource) that the filter pertains to. The entity determines the table
fields that can be selected when applying the filter conditions.

List/Time/Map/Daily

The views within which the filter is available.

Routing

Whether the filter is used within routing plans.

Restriction of Visible Activities

Whether you want to restrict filter activities from appearing if resource routes have not been
activated or a working day has not yet begun. This configuration is related to the User Type.
Once the filter is configured, apply the filter as a visibility restriction filter for user type.

User Types

The user types that the filter is available for. This field is displayed if you select the List/
Time/Map/Daily check box. Use the arrow buttons to move the user types between the
Available and Selected columns.

5. Click Add.
The filter is saved.
You must add conditions for the filter. If no conditions are added, the filter does not work.

Add a Filter Condition
Filter conditions help you further narrow down the activity you want to search for. For example, you can have a condition to
select activities based on work zones.
1. Click Configuration, Filters.
The Filters screen is displayed.
2. Locate the filter you want to add a condition to.
3. Click Conditions in the Actions column.
4. Click Add New at the top of the screen.
The Add filter condition dialog appears.
5. Complete these fields:
Field name

Action

Field

Choose one or more activity or resource-based criteria on which to base the filter.

Dynamic

Select the box if you want the user to type a value for the field that the condition is for.

Conditions

Select one or more options to represent how the field selected above relates to the Value
entry.

Value

These are the options that can be associated with the Field chosen for this condition. If
multiple values are applicable for this condition to be met, then add them to the Selected
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Action
column. From the list of available values, click to select and then click the >> button. The
selected item moves to the Selected column. these rules apply to enumeration fields:
Any field and property used in the application can serve as a filter condition.

◦
◦
◦

You must populate the value for the field and property other than enumerated fields
manually.
The condition value supports CSV format, such as 1, 2, 3, 4,, "1,1,1", "2,s", and
"(""test"")".

6. Click Add.
7. Navigate to the Work Area and verify that the filter is listed in the View drop-down menu.
8. Test the filter to ensure that it meets your requirements.

Delete a Filter Condition
When a filter condition is no longer needed, you can remove it from the application.
1.
2.
3.
4.
5.

Click Configuration. Click Filters from the Displays section.
Find the filter that has the condition you want to delete from and click the Conditions link.
Select the check boxes next to the condition that you want to delete.
Click Delete above the list of conditions.
Click OK.

Delete a Filter
When you don't need a filter anymore, you can remove it from the application.
1.
2.
3.
4.

Click Configuration. Click Filters from the Displays section.
Select the check boxes next to the filters that you want to delete.
Click Delete.
Click OK.

Glossary Entries
Use the Glossary to configure the default names of UI elements to your business needs. For example, instead of the default
term for the Activity Status, Completed, you can use the glossary to configure the term to display as Done.
You can configure the description of a user-interface element, only if the element corresponds to a glossary item in the Oracle
Field Service Cloud glossary.
The changes made to glossary references are global, that is, the change is consistent for all users. However, the same
glossary entry might belong to different categories or sub categories. For example, the glossary entry, Not Done belongs
to the categories, Activity Status, Activity History Operation, Notification Trigger Name, and Action Link. If you modify the
glossary entry, Not Done that belongs to the category, Activity Status, then the change does not affect other categories.
Note: The glossary entries for the Screen Configuration (Manage, Collaboration, Mobility, and Plugin) categories
are configured for the selected user types.
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The Glossary Visibility Profile permission that controls the access to the Glossary window for a User Type is set using the
Company Configuration context in the Screen Configuration, Manage section. Only User Types that have Read/Write
access can modify the glossary.
these columns display on the Glossary page:
• Category: Displays the category and the sub category, if available, in the format, <Category:Subcategory>. For
example, Activity: First Manual Operation.
• Label/ID: The label/ID of the glossary entry displays. If label is not available, the ID displays. You cannot change
labels in the glossary.
• Columns for each language: The selected languages are displayed. See Add an Active Language.
You can click on the text highlighted in red on any of the Language column to view the number of missing glossary entries.
When you update one of the missing glossary entries, the red highlight on the text box disappears and the count in the
Language column is updated. If no entries are missing, the warning text on the column header disappears.
Click the Search icon in the search field to list the glossary entries. You can select a specific category from the drop-down list
next to the search box and enter a term in the Search field to search for the required glossary entries.
By default, the original text for all glossary entries is displayed. When you modify the original text of a glossary entry and click
Save, the modified text is overwritten. However, the original text is still visible, when you hover the mouse over the modified
text.

Modify a Glossary Entry
Oracle Field Service Cloud glossary items have a unique identifier referred to as placeholder IDs. The Placeholder ID that
displays next to an UI element lets you identify the correct glossary item that you want to edit in the Glossary page. For
example, you can use Show instead of View.
You can also modify the description of an UI element using an in-context editor, so that you need not access the Glossary
page. This example explains how to modify the description of a UI element, View, using placeholders and in-context editor.
To modify a glossary entry:
1. Select your user name (for example, Admin) at the top right corner.
2. To modify the description of each UI element using placeholders:
a. Select My Display.
b. Select the Show Placeholder ID check box.
c. Click OK and refresh the page.

d.
e.
f.
g.
h.

Each UI element that corresponds to an Oracle Field Service Cloud glossary item in the application displays an
ID next to them.
Select Dispatch,Activities.
Make a note of the placeholder ID (for example, 8047) for the UI element, View.
Click Configuration.
Click Displays, Glossary.
Enter the Placeholder ID in the search field and click the Search icon.

The glossary entry displays.
i. Select English as the language and enter the term, Show in the field.
j. Click Save.
The glossary entry is modified and you can view the original text, View when you hover the mouse over the
modified term, Show.
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3. To modify the description of each UI element using the in-context editor:
a. Repeat steps 1 to 2.c from the above procedure.
b. Select your user name (for example, Admin) and select Glossary Editor is Off.
The in-context glossary editor is turned on.
c. Select Dispatch, Activities.
d. Select View.
e.
f.
g.
h.

An on-screen glossary editor displays.
Enter the term, View in the English field.
Click Save.
Deselect Glossary Editor is Off and the Show Placeholder ID check box from the My Display screen.
Refresh the page.
The modified description displays.

Export and Import Glossary Items
You can export the glossary entries to a .csv file to achieve these goals:
• Translate a list of glossary entries to one of the selected languages that is set using the Languages button.
• Modify a list of glossary entries.
Note: It is recommended that you use a text editor to update the glossary terms. don't use Microsoft
Excel, as it converts the .csv file from a comma-delimited file with quote qualifiers to a comma-delimited file
without quote qualifiers.
You can simultaneously update a list of glossary entries and import the updated list into the application. This example
explains how to export a list of glossary entries related to the Activity Hint Category, and import the modified entries into the
application. To export glossary entries:
1. Click Configuration.
2. Click Displays, Glossary.
3. Select Activity Hint as the Category from the drop-down list.
The entries related to Activity Hint display.
4. Click Export.

5.
6.
7.
8.
9.
10.

The Export dialog displays and by default, the languages that display on the Glossary page are selected. You can
also export the entries to any of the deselected languages. To add a language, see Add an Active Language.
Select the Filtered option to only export the entries related to the Category, Activity Hint. Or, select the All option to
export all the glossary entries.
Click Export.
Save the file in the .csv format, for example, test.csv.
Open test.csv, modify the required entries in the English (en-US) and Spanish (es-ES) columns, and save the file.
Click Import on the Glossary page, select test.csv, and click Import.
Click Save.
The modified entries display in the English and Spanish columns.
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Add an Active Language
You can select the active languages, that is, the languages that you want to display on the Glossary page without accessing
the Company Language setting. Based on your selections, the Language columns (drop-down lists that let you toggle
among the selected languages) are updated.
Note: You can only view two columns on the Glossary page.
To add an active language:
1. Select Languages from the Glossary page.
2. Click the Plus icon.
3. Select the language, for example, Spanish and click Add.
The selected language displays in the Languages list.
4. Click OK.
The selected language, Spanish displays as an option in both the Language columns.

Edit Property Descriptions
You can edit the description for properties for each user type and for each screen separately using these categories:
• Screen Configuration - Application screens
• Screen Configuration - Legacy Manage
• Screen Configuration - Collaboration and Identifiers
Each category has a sub category that is associated with the respective screen within Screen configuration. For example, the
sub category, Activity fields for export that belongs to the category, Screen Configuration – Manage is associated with the
Activity fields for Export screen that belongs to the Screen Configuration – Manage within the Configuration, User Types
page.
Note: If you share a screen configuration across multiple user types, then the properties of that screen
configuration are also shared, and, therefore, any change to the description of a property of that screen
configuration, affects all user types.
For example, if you share the screen configuration that belongs to the user type, Administrator using the Copy or share
screen configuration, Use Screen configuration of option across user types, Technician and Field Engineer, even the
properties of the screen configuration that belongs to the user type, Administrator are also shared.
Assume that the Activity fields for Export screen that belongs to the user type, Administrator has a property named Work
Order and the screen is shared across the Technician and Field Engineer user types.
When you edit the glossary entry for the Work Order property, the changes are also applied for the Technician and Field
Engineer user types.
By default, the Glossary page displays all properties for each screen within Screen configuration.
If there are custom names for any of the user types, then the original and custom names for the property are displayed in a
comma-separated format for each language.
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This example shows how to add a custom name, Job Code to the user type, Technician for the Work Order property in
the Activity fields for export screen that belongs to the category, Screen Configuration – Manage. To edit a property
description:
1. Click Displays, Glossary.
2. Select Screen Configuration – Manage from the drop-down list and click the Search icon.
The properties related to Screen Configuration – Manage display.
3. Click the Edit icon in the language column that is displayed for the Work Order property for the Screen Configuration
- Manage: Activity fields for export category.
The property label, appt_number and the original name, Work Order display.
4. Click the Plus icon and select the user type, Technician.
Note: The Edit Custom Names for User Types screen and the Plus icon displays when there are
custom names for user types. If there are no custom names for user types, then the Add screen displays
when you click the Edit icon.
5. Click Add.
6. Enter the custom name, Job Code in the field.
7. Click OK.
The custom name, Job code displays along with the original name, Work Order in a comma-separated format for each
language.

Holidays
There may be certain holidays when it would not be appropriate to send messages to customers. Use the Holidays section
within Notifications to set up the dates where certain outgoing messages will be blocked.
Access to the Holidays window is controlled by the Notifications visibility profile permission. You must set this permission
for each user type that you want to manage holidays. If the action is not configured for the user type or if no visibility is
defined, Holidays will not be visible to the user. If you select ReadOnly, Holidays is placed into a view only mode. If you select
Read/Write for this setting, the user can manage Holidays

Add a Holiday
There may be certain holidays on which it would not be appropriate to send messages to customers. Use the Holidays
section of the Company Settings to set up the dates where certain outgoing messages will be blocked.
1. Click Configuration.
2. In the Subsystems section, click Notifications.
3. Click Holidays.
The Holidays screen appears.
4. Click Add new.
The Add holiday window opens.
5.
6.
7.
8.

Enter the name of the holiday in the Add holiday box.
Select the status from the Status drop-down menu.
Select the date on which the holiday falls.
Click Add.
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The holiday appears in the list.

Delete, Activate, or Deactivate a Holiday
There may be certain holidays on which it would not be appropriate to send messages to customers. Use the Holidays
section of the Company Settings to set up the dates where certain outgoing messages will be blocked.
1. Click Configuration.
2. In the Subsystems and Integrations section, click Notifications.
3. Click Holidays.
The Holidays screen appears.
4. Select the check box next to holiday that you want to delete or deactivate.
5. Click Delete, Activate, or Deactivate.
6. Click OK.
The updated holiday list is displayed. Deactivated holidays are not included for selection.

Inventory Types
Inventory Type helps you distinguish between serialized and non-serialized inventory.
Access to the Inventory Type window is controlled by the Inventory Types visibility profile permission. You must set this
permission for each user type that you want to manage Inventory Types. If the action is not configured for the user type or if
no visibility is defined, Inventory Types will not be visible to the user. If you select ReadOnly, Inventory Types is placed into a
view only mode. If you select Read/Write for this setting, the user can manage Inventory Types.

Add an Inventory Type
You can create serialized inventory and non-serialized inventory types.
1. Click Configuration.
2. In the Resources, Activities and Inventories section, click Inventory Types.
3. Click Add new.
The Add inventory type dialog appears.
4. Complete these fields:
Field

Description

Label

Enter a unique identifier for this inventory type.

Active

Select this check box to make the inventory type available in drop-down menus.

Non Serialized

Select this check box if the inventory type is non-serialized.

Supports required inventory

Select this check box to make the inventory type required for selected activities.

Model Property

If desired, select additional characteristics for this inventory type from the drop-down list.

Name

Enter a name for this inventory type in each appropriate language field.
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Field

Description

Unit of measurement

If this inventory type is non-serialized, enter a unit of measure. Use a language and a unit of
measure appropriate for the country in which this inventory type will be used.

5. Click Save.

Activate or Deactivate an Inventory Type
Inventory Type helps you distinguish between serialized and non-serialized inventory. You can deactivate an Inventory Type
when you don’t use it any more.
1.
2.
3.
4.
5.

Click Configuration.
Select Inventory Types from the Resources, Activities and Inventories section of the menu.
Select the check box next to inventory type(s) that you want to activate or deactivate.
Click Activate or Deactivate.
Click OK.

Link Templates
Link Templates are link profiles containing link type, time between activities constraints, scheduling constraints, and
assignment constraints. Links between the activities are created with the help of Link Templates.
Linked activities ensure scheduling and detailed planning for complicated, multi-step tasks, which may potentially involve
different resource types, different times, and time constraints. Configuring all these link constraints in a multi-step task allows
our routing engine to assign and schedule activities while meeting all of the requirements.
The Link Templates screen includes the list of link types that exist in the system. You can edit existing links and add new
ones. Note that existing activity link types cannot be removed from the system but can only be deactivated.
Access to the Link Templates window is controlled by the Link Templates visibility profile permission. You must set this
permission for each user type that you want to manage Link Templates. If the action is not configured for the user type or if
no visibility is defined, Link Templates will not be visible to the user. If you select ReadOnly, Link Templates is placed into a
view only mode. If you select Read/Write for this setting, the user can manage Link Templates.

Add a Link Template
Link Templates are link profiles that describe how activities are linked. The templates contain the type of link, constraints for
the time between activities, scheduling constraints, and assignment constraints. Links between the activities are created with
the help of Link Templates.
1. Click Configuration.
2. In the General section, click Link Templates.
3. Click Add Link Template.
The New Link Template dialog is displayed.
4. Select the appropriate icon that represents the way in which you want to link activities.
The fields below the icons change based on your selection.
5. Complete these fields:
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Field

Description

Minimum interval

Minimum time interval between activities. Select one of the options:
Adjustable: The time interval is adjustable with the specified default value.

◦
◦

Maximum interval

Non-adjustable: The time interval is non-adjustable with the specified predefined
value.

Maximum time interval between activities. Select one of the options:
Adjustable: The time interval is adjustable with the specified default value.

◦
◦
◦

Non-adjustable: The time interval is non-adjustable with the specified predefined
value.
Unlimited: The time interval is unlimited, with no restrictions.

Assignment constraints

Whether there are any constraints in assigning the activities to resources. Click Different
resources if the linked activities can be performed by different resources. Click Same
resource if the linked activities must be performed by the same resource.

Scheduling constraints

Whether there are any constraints in scheduling the activities. Click Different days if the
linked activities can be performed on different days. Click Same day if the linked activities
must be performed on the same day.

Link for the 1st activity

Specifies translations for the first activity. English is set as a default language, unless other
languages are specified. You must also specify the label for this link which will be used by
external systems.

Link for the 2nd activity

Specifies translations for the second activity. English is set as a default language, unless
other languages are specified. You must also specify the label for this link which will be used
by external systems.

Label

A unique identifier for this Link template.

Status

Whether this activity link type is available for selection as an option in the Add link pop-up
window.

Login Policies
Login Policies determine the authentication method and options for users to access the application.
There are five types of authentication methods:
• Internal - The internal authentication method (BasicHTTP) is a good solution for small companies with relatively few
user credentials, which can be stored directly in the application database.
• LDAP – The LDAP (Lightweight Directory Access Protocol) authentication method is similar to the internal method,
the only difference being that the users' credentials are stored outside Oracle Field Service Cloud in an external
LDAP server. This method can be used by companies which prefer to store their user data in an external server
to increase security. When LDAP authentication is used, the user enters their credentials into Oracle Field Service
Cloud which then passes them to the LDAP server for verification. To enable LDAP authentication, a software that
supports LDAP v3 must be installed and configured on the customer's back-end server. Examples of such software
are: Active Directory, OpenLDAP.
• SAML – The SAML (Security Assertion Mark-Up Language) authentication method is an SSO method involving
authentication data exchange between the user, the service provider (SP) and the identity provider (IdP). The user
wishing to access the services of the service provider has to pass the authentication by the identity provider which
asserts the user's identity to the service provider. The user's data is stored with the identity provider and is verified
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by the user's credentials. If the user authentication is successful, the service provider verifies the user's login policy
and grants access to the application. One user can be associated with only one login policy and, therefore, its data
can be stored with only one identity provider. The application supports SAML 2.0 protocol, therefore, you can use
any SAML 2.0 identity provider. The identity provider details must be used in configuring the SAML Login Policy.
IDCS for Web SSO: You can use Oracle Identity Cloud Service (IDCS) as an identity provider for web SSO. This
option helps customers store user credentials in a different store instead of Oracle Field Service Cloud. This option is
part of the SAML authentication option, and you can upload the metadata as an XML file.
• OpenID Connect - With the OpenID Connect authentication method the user uses their account created with an
OpenID Connect Identity Provider to login to any website supporting OpenID Connect authentication. The user
registers their OpenID Connect URL with the OpenID Provider which becomes the user's identifier. OpenID Connect
can be a method of choice for companies preferring cloud data storage and using the same credentials to access
multiple websites.
Generally, the authentication method used depends on the company's business principles and requirements. In most cases,
a company uses one authentication method, although, use of several authentication methods within the same company is
technically possible.

Add a Login Policy
Login policies determine the authentication method and options for users to access Oracle Field Service Cloud. The
application includes a default login policy, however, you can add multiple policies with multiple authentication methods.
Before you implement OpenID Connect: Create or register Oracle Field Service Cloud as an application in your identity
provider. Get the Configuration URL, Logout URL, Client ID, and Client secret from the identity provider. Further, define an
attribute that will be used for the username.
1. Click Company name > Configuration
The Add Policy dialog appears.
2. In the Users and Security section, click Login Policies.
3. Click Add new.
The Add Policy dialog appears.
4. Complete these fields:
Note: From the 19C release onwards, the Disable Weak Password option is removed for delivery
channels and all Outbound API integrations shall use the SHA256 algorithm for secured authentication.
The delivery channels of the clients which used Weak Password Hashing (MD5) algorithm for Outbound
API integrations, shall use the SHA256 algorithm for secured authentication.

Field

Description

Label

A unique identifier label. For SAML login policy, enter only alphabets, numbers, and
undersrores ( _ ).

Policy name

A name assigned to this policy. Enter the name in English and in all the languages that are
active in the application.

Authenticate using

The type of authentication method used for this login policy.

these fields are displayed for Internal authentication method:
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Field

Description

Max login attempts

The number of invalid login attempts after which the user is blocked. When this field is set
to 0 (zero), the feature is disabled. However, disabling this feature is not recommended for
security reasons.

Login block timer

The number of minutes during which the user remains blocked after reaching the maximum
number of invalid login attempts.

Force password change after

Number of days after which the user must change their password to access the application.
When this field is set to 0 (zero), the feature is disabled.
Note: If the customer's LDAP server allows setting the period of forced password
change, it is recommended that the period set in the application is shorter than
the one set on the LDAP server. This way, the password changes initiated by the
application occur earlier than those initiated by the LDAP server which ensures
correct and reliable performance.

User activity relogin time

The duration of the idle time after which the user is prompted to re-enter the password upon
an attempt of any action in the application.

Relogin timeout

The period after which the user is prompted to re-enter the password regardless of whether
the user was active or not.

Max sessions

The maximum number of simultaneous sessions allowed to the user.

Min password length

The minimum number of characters in the password.

Password must contain letters

Whether the password must contain alphabets.

Password must contain digits

Whether the password must contain numbers.

Password must contain special
symbols

Whether the password must contain special characters and symbols.

Password must not contain personal
details

Whether the password must not contain personal details such as the user’s first name or
last name.

Password must differ from old
password

Whether the password must be different from a previous password.

Allow access only for certain IP
addresses

Whether you want to restrict access to specific IP addresses. By default, a login policy is
created without any restrictions to the IP addresses from which the user may log in. Select
the check box to enable the restriction. When this check box selected, the Allowed IP
address list field appears, where you can enter the IP addresses that can access the
application.

these fields are displayed for the LDAP authentication method, along with the fields listed earlier:
LDAP server URL

The actual host name or IP address of the LDAP server.

LDAP DN pattern

If the LDAP server is MS Active Directory check box is selected, this field contains the
part of the UPN (User Principal Name) common among the users. In this case the LDAP
DN pattern must always contain the UPN pattern. UPN (User Principal Name) is a string
of characters used to represent a resource available in Active Directory. It should be used
when communicating with MS Active Directory servers. An example of this field value is
%s@test.corp, where %s is a special placeholder to be substituted with the user's login.
If the LDAP server is MS Active Directory check box is not selected, this field contains
the common path to the LDAP tree for the users, their DN pattern. DN (Distinguished
Name) is a string of characters used to represent a resource available in the LDAP directory.
An example of this field value is cn=%s,dc=example,dc=com, where %s is a special
placeholder to be substituted with the user's login in the application.

LDAP server is MS Active Directory

Whether the LDAP server is a MS Active Directory.

these fields are displayed for the SAML authentication method:
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Field

Description

Specify SAML IdP

The way in which you want to select the SAML identity provider. The options are:
Upload metadata XML

◦
◦
◦
◦

IdP Metadata XML

Specify metadata URL
Oracle IDCS
Manual populate

This field is displayed if you select Upload metadata XML in the Specify SAML IdP
field. Click Upload to upload the XML file that contains the metadata details for the identity
provider. If the uploaded file is incomplete, or does not contain the details in the proper
format, the message, Cannot download metadata from the specified XML: XML parser error
is displayed. Contact your Identity Service Provider to get this metadata XML. Ensure that
the XML includes or conforms to these information:
Metadata XML must be in accordance with SAML 2.0 specifications.

◦
◦
◦

The file contains "SAML Issuer" (parameter "entityID" of the node "EntityDescriptor").
The file provides identity provider certificate (nodes "md:EntityDescriptor/
md:IDPSSODescriptor/KeyDescriptor/KeyInfo/X509Data/X509Certificate/").

IdP Metadata URL

This field is displayed if you select Specify metadata URL in the Specify SAML IdP
field. Type the URL from which you want to take the SAML metadata details for the identity
provider. If the URL is unresolved, the message, Cannot download metadata from the
specified URL: no route to host is displayed.

IDCS Metadata XML

This field is displayed if you select Oracle IDCS in the Specify SAML IdP field. Click
Upload to upload the XML file that contains the metadata details for Oracle IDCS. Contact
your implementation consultant for more details on Oracle IDCS.

OFSC Metadata XML

The link to download the OFSC metadata XML. You must pair your identity provider with
Oracle Field Service Cloud. Use the downloaded XML file to register Oracle Field Service
Cloud with your identity provider.

Max sessions

The maximum number of simultaneous sessions allowed to the user.

SAML issuer

Used to identify asserts from Identity provider (IdP). It can be any string provided by IdP, not
only URL. It is used for IdP and Service provider (SP) initiated connections.

SAML identity provider certificate

IdP public key used to sign requests.

SAML identity provider login URL

IdP URL to redirect to for login. It is needed only for SP initiated logins.

SAML identity provider logout URL

IdP URL to redirect to for logout. It is needed only for SP initiated logins.

SAML attribute containing username

The SAML assertion attribute name where IdP must store the user name (login name for
Oracle Field Service Cloud). Example:
[saml:Attribute Name="uid"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrnameformat:
basic"]
[saml:AttributeValue xsi:type="xs:string"]dispatcher[/
saml:AttributeValue]
[/saml:Attribute]
If it is empty then Oracle Field Service Cloud gets the user name from the Name Identifier
element of Subject statement. Example:
[saml:Subject]
[saml:NameID
SPNameQualifier="https://sp.com/sp/module.php/ saml/sp/
metadata.php/ default-sp"
Format="urn:oasis:names:tc:SAML:2.0:nameidformat:
persistent"]dispatcher[/saml:NameID]
[/saml:Subject]
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Field

Description

Signature hashing algorithm

The security-hashing algorithm that is used to authenticate users through a SAML login
policy. The option you select determines the security algorithm that is applied to OFSC
Metadata, which is used to pair your identity provider with Oracle Field Service Cloud. We
recommend that you use "SHA-256".

these fields are displayed for the OpenID authentication method:
Max sessions

The maximum number of simultaneous sessions allowed to the user.

OpenId identity provider login URL

The Identity Provider URL to start authentication.

OpenId logout URL

URL to which the user is redirected after logout. It may be the URL for logout from the
Identity Provider.

OpenId attribute containing
username

The name of the OpenId attribute where the Identity Provider should store the user's name
(login name for Oracle Field Service Cloud). Example:
http://axschema.org/contact/email (This attribute returns the user's email). The attribute
must have a unique value for each user.

these fields are displayed for the Open ID Connect authentication method:
Max sessions

The maximum number of simultaneous sessions allowed to the user.

Configuration login URL

The Identity Provider URL to start authentication.

Logout URL

URL to which the user is redirected after logout. It may be the URL for logout from the
Identity Provider.

Attribute containing username

The name of the OpenId attribute where the Identity Provider must store the user's name
(login name for Oracle Field Service Cloud). Example: email.

Client ID

The value of the field containing data from registered OpenID provider (for example, Client
ID).

Client secret

The value of the field containing data from registered OpenID provider (for example, Client
Secret).

5. In your OpenID application, configure a link back URL to https://login.etadirect.com/openid-connect-linkback.
Your Identity Provider uses this link to redirect users to Oracle Field Service Cloud upon successful login.
Related Topics
• Sample Metadata XML File for SAML Identity Provider

Sample Metadata XML File for SAML Identity Provider
Sample metadata XML file for SAML identity provider:
<?xml version="1.0"?>
<md:EntityDescriptor xmlns:md="urn:oasis:names:tc:SAML:2.0:metadata" xmlns:ds="http://www.w3.org/2000/09/
xmldsig#" entityID="https://idp-saml.ua3.int/simplesaml/saml2/idp/metadata.php">
<md:IDPSSODescriptor protocolSupportEnumeration="urn:oasis:names:tc:SAML:2.0:protocol">
<md:KeyDescriptor use="signing">
<ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
<ds:X509Data>
<ds:X509Certificate>MIID7TCCAtWgAwIBAgIJANn3qP9lF7M3MA0GCSqGSIb3DQEBCwUAMIGMMQswCQYDVQQGEwJVQTEXMBUGA1UE
CAwOS2hhcmtpdiBSZWdpb24xEDAOBgNVBAcMB0toYXJrb3YxDzANBgNVBAoMBk9yYWNsZTEYMBYGA1UEAwwPc3RzeWJvdi12bTEudWEzMScw
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JQYJKoZIhvcNAQkBFhhzZXJnaWkudHN5Ym92QG9yYWNsZS5jb20wHhcNMTUxMjI1MTIyMjU5WhcNMjUxMjI0MTIyMjU5WjCBjDELMAkGA1UE
BhMCVUExFzAVBgNVBAgMDktoYXJraXYgUmVnaW9uMRAwDgYDVQQHDAdLaGFya292MQ8wDQYDVQQKDAZPcmFjbGUxGDAWBgNVBAMMD3N0c3lib
3Ytdm0xLnVhMzEnMCUGCSqGSIb3DQEJARYYc2VyZ2lpLnRzeWJvdkBvcmFjbGUuY29tMIIBIjANBgkqhkiG9w0BAQEFAAOCAQ8AMIIBCgKCA
QEAw4OFwuUNjn6xxb/OuAnmQA6mCWPY2hKMoOz0cAajUHjNZZMwGnuEeUyPtEcULfz2MYo1yKQLxVj3pY0HTIQAzpY8o+xCqJFQmdMiakb
PFHlh4z/qqiS5jHng6JCeUpCIxeiTG9JXVwF1ErBEZbwZYjVxa6S+0grVkS3YxuH4uTyqxskuGnHK/
AviTHLBrLfSrbFKYuQUrXyy6X22wpzo
bQ3Z+4bhEE8SXQtVbQdy7K0MKWYopNhX05SMTv7yMfUGp8EkGNyJ5Km8AuQt6ZCbVao6cHL2hSujQiN6aMjKbdzHeA1QEicppnnoG/
Zefyi/
okWdlLAaLjcpYrjUSWQJZQIDAQABo1AwTjAdBgNVHQ4EFgQUIKa0zeXmAJsCuNhJjhU0o7KiQgYwHwYDVR0jBBgwFoAUIKa0zeXmAJsCuNhJj
hU0o7KiQgYwDAYDVR0TBAUwAwEB/zANBgkqhkiG9w0BAQsFAAOCAQEAJawU5WRXqkW4emm+djpJAxZ0076qPgEsaaog6ng4MLAlU7RmfIY/
l0VhXQegvhIBfG4OfduuzGaqd9y4IsQZFJ0yuotl96iEVcqg7hJ1LEY6UT6u6dZyGj1a9I6IlwJm/9CXFZHuVqGJkMfQZ4gaunE4c5gjbQA5/
+PEJwPorKn48w8bojymV8hriqzrmaP8eQNuZUJsJdnKENOE5/asGyj+R2YfP6bmlOX3q0ozLcyJbXeZ6IvDFdRiDH5wO4JqW/ujvdvC553y
CO3xxsorB4xCupuHu/c7vkzNpaKjYdmGRkqhEqBcCqYSxdwIFc1xhOwYPWKJzgn7pGQsT7yNJg==</ds:X509Certificate>
</ds:X509Data>
</ds:KeyInfo>
</md:KeyDescriptor>
<md:KeyDescriptor use="encryption">
<ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
<ds:X509Data>
<ds:X509Certificate>MIID7TCCAtWgAwIBAgIJANn3qP9lF7M3MA0GCSqGSIb3DQEBCwUAMIGMMQswCQYDVQQGEwJVQTEXMBUGA1
UECAwOS2hhcmtpdiBSZWdpb24xEDAOBgNVBAcMB0toYXJrb3YxDzANBgNVBAoMBk9yYWNsZTEYMBYGA1UEAwwPc3RzeWJvdi12bTEud
WEzMScwJQYJKoZIhvcNAQkBFhhzZXJnaWkudHN5Ym92QG9yYWNsZS5jb20wHhcNMTUxMjI1MTIyMjU5WhcNMjUxMjI0MTIyMjU5WjCB
jDELMAkGA1UEBhMCVUExFzAVBgNVBAgMDktoYXJraXYgUmVnaW9uMRAwDgYDVQQHDAdLaGFya292MQ8wDQYDVQQKDAZPcmFjbGUxGDA
WBgNVBAMMD3N0c3lib3Ytdm0xLnVhMzEnMCUGCSqGSIb3DQEJARYYc2VyZ2lpLnRzeWJvdkBvcmFjbGUuY29tMIIBIjANBgkqhkiG9w0B
AQEFAAOCAQ8AMIIBCgKCAQEAw4OFwuUNjn6xxb/OuAnmQA6mCWPY2hKMoOz0cAajUHjNZZMwGnuEeUyPtEcULfz2MYo1yKQLxVj3pY0HT
IQAzpY8o+xCqJFQmdMiakbPFHlh4z/qqiS5jHng6JCeUpCIxeiTG9JXVwF1ErBEZbwZYjVxa6S+0grVkS3YxuH4uTyqxskuGnHK/
AviTHLBrLfSrbFKYuQUrXyy6X22wpzobQ3Z+4bhEE8SXQtVbQdy7K0MKWYopNhX05SMTv7yMfUGp8EkGNyJ5Km8AuQt6ZCbVao6cHL2h
SujQiN6aMjKbdzHeA1QEicppnnoG/Zefyi/okWdlLAaLjcpYrjUSWQJZQIDAQABo1AwTjAdBgNVHQ4EFgQUIKa0zeXmAJsCuNhJjhU0o
7KiQgYwHwYDVR0jBBgwFoAUIKa0zeXmAJsCuNhJjhU0o7KiQgYwDAYDVR0TBAUwAwEB/zANBgkqhkiG9w0BAQsFAAOCAQEAJawU5WRXq
kW4emm+djpJAxZ0076qPgEsaaog6ng4MLAlU7RmfIY/l0VhXQegvhIBfG4OfduuzGaqd9y4IsQZFJ0yuotl96iEVcqg7hJ1LEY6UT6u6d
ZyGj1a9I6IlwJm/9CXFZHuVqGJkMfQZ4gaunE4c5gjbQA5/+PEJwPorKn48w8bojymV8hriqzrmaP8eQNuZUJsJdnKENOE5/
asGyj+R2YfP6bmlOX3q0ozLcyJbXeZ6IvDFdRiDH5wO4JqW/ujvdvC553yCO3xxsorB4xCupuHu/c7vkzNpaKjYdmGRkqhEqBcCqYSxd
wIFc1xhOwYPWKJzgn7pGQsT7yNJg==</ds:X509Certificate>
</ds:X509Data>
</ds:KeyInfo>
</md:KeyDescriptor>
<md:SingleLogoutService Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect" Location="https://idpsaml.ua3.int/simplesaml/saml2/idp/SingleLogoutService.php"/>
<md:NameIDFormat>urn:oasis:names:tc:SAML:2.0:nameid-format:transient</md:NameIDFormat>
<md:SingleSignOnService Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect" Location="https://idpsaml.ua3.int/simplesaml/saml2/idp/SSOService.php"/>
</md:IDPSSODescriptor>
<md:ContactPerson contactType="technical">
<md:SurName>Administrator</md:SurName>
<md:EmailAddress>name@emailprovider.com</md:EmailAddress>
</md:ContactPerson>
</md:EntityDescriptor>

Organizations
An organization is an entity comprising multiple people, tools, and vehicles that collectively operate as a unit toward a
common goal. In other words, an organization is either a main company, a subdivision (Line of Business of an organization),
or a third-party company that has a contract with the main company. An organization can have buckets, organization units,
field resources, tools or vehicle associations.
An Organization can have buckets, organization units (Org Units), field resources, tools or vehicle associations. You must
create an organization before adding any type of resource. There is one default organization and you can create additional
organizations (in-house and contractor) to meet your operational needs. For example, if XYZ Inc., is the main organization,
XYZ East Coast and XYZ West Coast could be subdivisions. The resources that are directly employed with the organization
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are known as in-house resources. The resources that are employed by a third-party company that subcontracts work
are known as contractors. It is recommended that you create an organization for each contractor company. If the main
organization cannot directly assign activities to contractor resources for legal reasons, it can assign activities to a bucket
that contains contractors. Further, a field resource, tool or vehicle will automatically inherit the parent’s Organization, while a
bucket or organization unit can be changed to any defined Organization in the system.

Create, Edit, or Delete Organizations
An Organization is a main company, a subdivision (Line of Business of an Organization), or a third-party company that has
a contract with the main company. An Organization can have buckets, Organization units, field resources, tools, or vehicle
associations. You can create, edit, or delete Organizations.
1. Click Configuration > Organization .
The Organizations screen appears.
2. Click Add New.
The Add Organization dialog appears.
3. Enter the name of the Organization in the Name field. Enter the names in the corresponding language fields for
languages other than English.
4. Enter a label for the Organization in the Label field.
This label will be used as the Organization identifier in APIs.
5. Select the type of Organization from the Type drop-down list.
The Organization type can be in-house or contractor.
6. Click OK.
The Organization is added to the list of Organizations.
7. To edit an Organization, click the Organization on the Organizations screen.
The Edit Organization screen appears. Edit as required and click Submit.
8. To delete an Organization, click Remove on the Organizations screen.
You can remove only those Organizations that don't have field resources, tools, or vehicles assigned to them.

Message Scenarios
A Message Scenario consists of one or more scenario steps, which determine the message content, recipients, delivery
channels, and business rules. While each Message Scenario has at least one start step, you can configure multiple inner
steps to execute different actions based on the results of the preceding steps. The intent is to ensure that the right people or
systems receive the expected notifications, while considering all potential circumstances.
When you want to use Message Scenarios for time-based notifications (for example, notifications to customers) the
recommendation is to use Reminders, Alerts, or Visit selections in the Launch Conditions. For other Launch Conditions (for
example, Route, Activity, Inventory, and Service Requests) the recommendation is to use the Core API/Events REST API for
integration with Oracle Field Service Cloud.
Note: Because the messages go to your customers, you must test them carefully and thoroughly to ensure that
the launch conditions, scenarios, steps, and channels are set up correctly. For more information about Launch
conditions warnings and notes, Scenario Steps elements, Channel errors, Supported variables within the body of
the message, refer to Oracle Field Service Cloud Message Scenario Configuration Guide.
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Create a Message Scenario
A message scenario is a set of rules that specify how to process a message to an external application, or to customers when
a launch condition occurs. A launch condition is triggered by a predefined event, for example, when a reminder notification
must be sent to a customer 60 minutes prior to a resource’s estimated arrival time.
1. Click Configuration.
2. Click Message Scenarios in the Subsystems And Integrations section.
The Message Scenarios screen displays.
3. Click the Plus icon in the left pane.
The Add Message Scenario screen displays.
4. Enter Route Not Activated in the Name field.
5. Select a date from the Active From field.
6. Click OK.
The Route Not Activated message scenario displays on the left pane.

Define the Settings for a Scenario Step
The Settings tab enables you to define the general settings for a message step which includes these settings:
• Step Info section: Define the type of the message step, intended recipient, and the delivery method.
• Notification Time section: Define when to send the message (for example, day of event or for how many days) and
the time interval when the messages are sent.

Field

Description

Step Info section
Name

Enter the name of the step that displays in the Scenario steps section.

Type

Select the type of step, Start or Inner. Start steps are the first steps that occur when a scenario is
initiated. An inner step is run after a preceding step is completed.

Delivery Channel

Select the message agent for delivering the message. Options: Email, Set Property, user-defined
channel, Collaboration.
Note: If you select collaboration as the delivery channel, see Use Collaboration as a
Delivery Channel

Recipient

The options available varies based on the selected delivery channel (Email, Set Property, userdefined channel, or Collaboration).
Select the intended recipient (Customer, Resource, Dispatcher, or use static address) of the
message.
By default, the recipient address is fetched from the activity or resource fields for the options,
Customer, Resource, or Dispatcher.
However, if you select Use static address, then you must enter a static recipient address in the
format, notify@etadirect.com.

55

Oracle Field Service Cloud

Chapter 1

Administering Oracle Field Service Cloud
Field

Configure Oracle Field Service Cloud
Description

Note: these drop-down lists display based on the selections made in the Recipient and
Delivery Channel drop-down lists.
Customer Notification Time

Select the time for notifying customers. For example, ETA, Service window, or Delivery window.

Reply Address

Enter the e-mail address (for example, notify@etadirect.com) for sending notifications when you
select Email as the Delivery channel and Customer, Dispatcher, or Resource as the Recipient.

Time Zone and Language

Select the time zone and language for the email content when you select Email as the Delivery
channel and use static address as the Recipient.

Static address

Enter the email address or distribution group to which you want to send emails when you select
Email as the Delivery channel and use static address as the Recipient.

Email address source

Refers to the resource property that contains e-mail information when Dispatcher or Resource is
selected as a recipient or refers to the user-defined property that contains e-mail information when
Customer is selected as a recipient.

Notification time section
Sending time

Select one of following options:
• Day of event
•

Time of event

•

Day of route

For example, if you select Day of event, select +, and enter 2 in the Days field, then the messages
are sent after two days from the Day of event.
from

Select the starting time for the messages.
For example, if you select 8 AM from the drop-down list, then the messages are sent from 8 AM.
Available when either Day of event or Day of route is selected in the Sending time field.

Sending will time out in

Specify the interval in hours and minutes. The messages are sent during the specified interval.

Number of Attempts On ‘failed’ status

Indicates the maximum number of resend attempts. For example, if you enter 3 in the Interval field
and 10 in the Minutes field, then the message is resent for 3 times after every 10 minutes.

Number of Attempts On ‘sent’ status

Available only for External Systems.
Indicates the maximum number of attempts to resend the notification status received.
For example, if you enter 3 in the Interval field and 10 in the Minutes field, then the notification status
is resent for 3 times after every 10 minutes.

Sending delay

Specify the time in minutes if you want some time to elapse after an event.
For example, for Post Appointment Survey messages, you want to ensure that the resource leaves
the premises before the customer receives the survey.

Block messages for specific days

Select the days for which you don't want to send messages.

Block messages for holidays

Select the option, if you don't want to send messages during holidays. You must set up holidays
using Configuration, Holidays.

Blocked messages sending

Indicates the number of days before the holiday. For example, if you select 2, then the messages
are stopped before two days.
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For our example, enter these details:
1. Click Add New in the Scenario steps section.
The Add scenario step screen displays.
2.
3.
4.
5.
6.
7.
8.
9.

Enter Start test in the Name field.
Select Start from the Type drop-down list.
Select Email from the Delivery Channel drop-down list.
Select day of event and + from the Sending time drop-down list.
Enter 2 in the days field.
Enter 5 in the hours field and 30 in the minutes field in the Sending will time out in field.
Select Service Window from the Customer notification time drop-down list.
Click Add.
The Start test message step displays in the Scenario steps section. The Scenario steps section also displays
other details such as sending time, the number of messages that are being sent today, and a graph of the progress.
The graph and the queue details are hidden if the screen size is not enough to display the details.

Related Topics
• Send Notification Messages

Define the Message Content
The Patterns tab defines the content of the message that you want to send to your customers or systems. You can use
variables within the body of the message to substitute the property value within the content of the message.
Based on the delivery channel, the template for the message differs as follows:
• If the selected Delivery Channel is Email or External System, then the template for the message is defined using
the Subject and Body fields.
• If the selected Delivery Channel is Set Property, then the template for the message is defined using the property
field and property value.
For example, assume that Cancellation Reason property is associated with the entity, Activity. When a customer cancels an
activity, you need to set the Cancellation Reason property field for the activity to the value, 14. Using the Set Property delivery
channel, you can use the Cancellation Reason property in the Subject field and define the required value in the Body field. So
when the step is run, the application changes the value in the Cancellation Reason property to 14.
Also, you can determine when you want to generate the content of the message using the Generate content on message
creation or Generate content on message sending options. For example, assume that you want to send a Post
Appointment Survey message to your customer and the Sending delay field in the Settings tab is set to 40 minutes.
Assume that the content of the Post Appointment Survey message has three activity property fields.
Although the message is created when the message step is run, the property values may change after 40 minutes. Hence,
select the Generate content on message sending option so that you receive the latest changes. For example, if you
want to display the customer address in the content of the message, enter the label name of the property field using { }. For
example, {caddress}.
1.
2.
3.
4.

Select the Start test message step from the Scenario steps section.
Select the Patterns tab.
Enter test start in the Subject field.
Enter start test activity started at {caddress} in the Body field.
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5. Select Generate content on message sending option and click Update.

Define Conditions
The Next Steps tab identifies the relation between different steps of a scenario and defines the conditions for the execution
of subsequent steps.
For example, assume that the start step (that is, the start test activity) fails due to some reason and you want to inform a
resource in the Helpdesk department that the activity has failed. To handle the above condition, you must create an inner
step and define the message that you want to send to the Helpdesk department.
Note: By default, the Next Step drop-down list in the Start test, Next Steps tab is empty. Since the inner step
handles a specific condition when the Start Step fails, it is required to create an inner step and link the Start step
with the Inner step.
To create an inner step, follow the steps in the Define the settings for a scenario step using the Settings tab section, but
modify these settings:
• Enter test inner in the Name field, select Inner, Resource, and Email from the Type, Recipient, and Delivery
Channel drop-down lists.
• Enter the email address of the Helpdesk department in the Reply address field.
• Select the Patterns tab and enter the message that you want to send in the Subject and Body fields.
For our example, let us configure the Start step so that when the Start step fails, the inner step (that is, test inner) runs and
sends the failure message to the Helpdesk department.
1.
2.
3.
4.
5.
6.

Select the Start test message step from the Scenario steps section.
Select the Next Steps tab.
Select Failed from the Status drop-down list.
Select the check box and enter the required description.
Select test inner from the Next Step drop-down list.
Click Add.
The configured condition displays in the list.

7. Click Update.
The test inner step is updated with the latest settings.

Block Message Steps
The Conditions tab enables you to define conditions to block the messages in a step. The application checks for any
blocking conditions, and if the conditions are met, then the messages in the step are not processed.
Assume a scenario where you want to block the messages that are sent to the customer if the customer cancels an activity.
To handle the above scenario, define a condition to verify whether the value in the Activity Status field is Cancelled as follows:
1. Select the Start test message step from the Scenario steps section.
2. Select the Conditions tab.
3. Select Activity Status from the Field drop-down list.
4. Select In from the Condition drop-down list.
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Enter Cancelled in the Value field.
Select Failed from the Result drop-down list.
Enter activity is cancelled in the Description field.
Select Check on message sending option.
Click Add.
The configured condition displays in the list. If an activity is cancelled, then the customer receives a notification that is
configured in the Conditions tab, that is, “failed, activity is cancelled.”

Add Launch Conditions
Launch conditions are trigger events that invoke message scenarios and scenario steps to deliver configured messages to
client systems.
Assume that you want to invoke the message scenario that you have created, that is, Route Not Activated when a resource’s
route is not activated. Therefore, you need to add a launch condition to invoke the scenario as follows:
1. Click Configuration > Message Scenarios .
2. Click Add New in the Launch Conditions section.
3. Select Route is not Activated from the The scenario will be launched when drop-down list.
4. Enter the number of minutes in the minutes after shift starts according to calendar field.
5. Click OK.
The launch condition displays in the Launch Conditions section of the Message Scenarios screen. For each
launch condition of the scenario, the Launch Conditions section also displays the number of messages that are in
the queue. If the number of messages is greater than 999, then the numbers are displayed as follows:
◦ Range 1000-999999 - "k". For example, 1000 messages are displayed as "1k"; 10000 messages are
displayed as "10k".
◦ Range 1000000 and greater - "m". For example, 1000000 messages are displayed as "1m"; 123000000
messages are displayed as "123m"
Note: When the user selects a message scenario in the routing plan as a Fallback option, a read-only
launch condition, Routing fallback is automatically populated in the message scenario. When the user
removes the message scenarios from all associated routing plans, the launch condition is removed from
the message scenario. The launch condition has a count of routing plans to which it is associated. You can
click the count of routing plans in the launch condition UI to view the routing plans.

Send Notification Messages
Channels define a mechanism to communicate notification triggers to external systems. The Email agent is used for sending
messages when the Email delivery channel is selected.
However, if you want to send messages to an external system (for example, client system), then you must define the details
of the client system (such as Host, Port number, URL, Connection method, and so on) using the Delivery Channels screen.
For example, let us create a delivery channel, external sys 1 as follows:
1. Click Channels.
The Delivery Channels screen displays.
2. Click the Plus icon on the left pane.
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3. Enter external sys 1 in the Name field.
4. Select the required option from the Status drop-down list.
Note: If notification scenarios contain at least one message step that uses an internal delivery channel (email or voice) then that channel is accessible in the list of channels. A user with appropriate permissions
can select Active or Inactive to resume or stop the message delivery for any external or internal channel.
For example, you can block a channel using the Inactive option in Test instances to disallow test messages
to reach real customers. Messages that are not delivered due to inactivated delivery channel get the status
'obsolete' with the description, EXTERNAL_NOTIFICATION_ARE_DISABLED. Note that the 'set property'
messages don't have a delivery channel and cannot be handled this way.
5. Enter agent.com in the Host field and 8080 in the Port number field.
Note: Enter one of these values (20, 21, 22, 25, 80, 290, 389, 443, 587, 873, 2401, 3668, 4011, 4142,
5308, 5666, 5900, 5901, 6666, 6460, 7800, 8080 8443, 14861 and 20106) in the Port field.
6. Enter the URL Path of the server (optional).
7. Enter the name and password of the user for authorization purpose.
8. Select the Allow basic access authentication check box if you want to implement HTTP basic authentication
while integrating with external systems.
When you select the check box, the outbound methods (such as send_message, drop_message,
get_message_status methods) send the standard HTTP header "Authorization" with base64-encoded user
credentials (standard basic access authentication). Also, the <user> SOAP structure is sent in the body of the
request. The client application can either use the standard HTTP header "Authorization" or the <user> SOAP
structure to send user credentials in the request.
Note: When the check box is not selected, the standard HTTP header is not used in the request and the
client application can use the <user> SOAP structure for authentication. For more information, see the
Integrating with Outbound API Guide.
9. Select a connection from the Connection drop-down list to denote the encryption protocol type.
Note: By default, Not Encrypted option is selected. If you select default encryption or any other
encryption type, then complete the necessary fields in the Advanced Settings section.
10. Click Add.
The channel displays in the Delivery Channel drop-down list in the Add scenario step and Modify scenario step
screens. The delivery channel, external sys 1 also displays on the left pane on the Delivery Channels screen. The
channel details are displayed in:
◦ Green if there are no warnings and the channel is active

◦
◦

Gray if there are no warnings and channel is inactive

Red if there are warnings, or count of message scenarios is greater than 0 and the channel is inactive

Active and Inactive are also displayed on active and inactive channels respectively.

Use Collaboration as a Delivery Channel
You can use collaboration as a delivery channel to send alerts of different types of events or situations in Oracle Field Service
Cloud to collaboration users (for example, technicians, help desk operators, and resources). Also, you can broadcast
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notifications or alerts to collaboration user groups or help desk groups on occurrence of an event or when a predefined
condition is met in Oracle Field Service Cloud.
• Subscribe to Collaboration to view the Collaboration option as a delivery channel in the message scenario. View the
About screen in your instance to verify whether the service is enabled.
• Create collaboration users, user groups, or help desk groups.
Note: For more information on configuration settings, see the Configuring Collaboration section in the
Oracle Field Service Collaboration Cloud Service Guide.
For example, assume that you want to notify the resource using collaboration as a delivery channel when a activity is created
in Oracle Field Service Cloud. Assume that the message scenario, new appt is associated with the Activity is Created
launch condition and has a scenario step, Collab Alert.
1.
2.
3.
4.
5.

Log in to Oracle Field Service Cloud as a Administrator.
Click Configuration, Message Scenarios.
Select the Collab Alert scenario step.
Select Collaboration from the Delivery Channel drop-down list in the Settings tab.
Select one of these options from the Recipient drop-down list:
◦ Resource: Delivers message to the resource associated with the launch condition. By default, Oracle Field
Service Cloud considers the language and time zone of the user associated with the resource.
Note: If the collaboration permission is not configured for the resource, then the message scenario
displays a False Method status in the Messages tab of the Activity Details screen for the scenario
step.

◦

use static address: Enables you to send the message to specific users, user groups, and helpdesks. Click
Add New and search for the required users, user groups, and helpdesks. Select the required users, user
groups, and helpdesks to add them to the Recipients section.
Note: You must enter three letters in the Search field to search for the required users, user groups,
and helpdesks.

6. Enter the message content in the Subject and Body fields of the Patterns tab.
Note: The default language of the company is configured from the My Display, Language drop-down
list and is selected as the language for the message content. To add more languages, see Configure the
Display Screen.For example, if English is configured as the default language and if the Subject and Body
fields in the Patterns tab is populated is English, then regardless of the user’s language, the message
is sent to the recipient in English. However, you can use the Pattern tab to specify another language for
the message content. You can specify any one of the languages selected from the My Display setting as
the language for the message content. For example, if English is configured as the default language and
the Subject and Body fields in the Patterns tab is populated is Spanish, then the message is sent to the
recipient user in Spanish. If the default language is not configured then English is considered as the default
language of the recipient and the message is sent to the recipient in English.
7. Configure the required fields and click Save.
The details such as sending time and the selected delivery channel are updated for the Scenario step.
Assume that a new activity is assigned to the resource, Phillip. The message scenario is triggered and the Collab Alert
scenario step is displayed with the New status in the Messages tab of the Activity Details screen.
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When the message alert is sent to the resource, the status in the Messages tab of the Activity Details screen changes to
Sent.
Note: If the scenario step is not configured properly or if the message alert is not sent to the resource, the
status in the Messages tab of the Activity Details screen changes to Failed. However, if a message is
invalidated because of an activity-related operation in Oracle Field Service Cloud (such as delete, move, suspend
activity), the status in the Messages tab of the Activity Details screen changes to Obsolete.
To view the message alert, log in to Oracle Field Service Cloud using resource’s login credentials.
For more information, see the About Collaboration Window section in the Oracle Field Service Collaboration Cloud Service
Guide.

Add a Non-Working Reason
If a resource is not available for work during their regular work schedule or shift, then you must apply a non-working reason
(for example, illness, vacation, bereavement) to explain their absence. Once set, this reason appears on the calendar within
the Daily view.
1. To view the Non-Working Reasons screen:
a. Click Configuration.
b. In the General section, click Work Schedules.
The Work Schedules screen appears.
c. Click Non-Working Reasons.
2. To add a new non-working reason, click Add non-working reason.
3. To edit an existing non-working reason, click Modify on the far right of the grid.
In either case, you will be prompted to enter a name and a label (unique identifier) for the non-working reason.

Properties
Each entity (for example, activity, resource, inventory, and users) contains a set of associated attributes. For example,
resource records may contain attributes such as name and contact information as well as physical attributes such as gender
or a photograph. These attributes within Oracle Field Service Cloud are combinations of fields or custom properties.
Properties with the Type “Field” are the native system properties that are available for the specified entities. For example,
Name (property label, cname) is associated with an Activity, and Serial Number (property label, invsn) is associated with
Inventory. Field type of properties can be mapped with similar client properties.
Note: Multiple fields or properties with the same name can exist. For example, Name can refer to a customer’s
name (property label, cname) or a resource’s name (property label, pname). In this example, each Name property
is assigned to a different entity and has a different property label.
Custom properties are attributes of entities that are unique to each client. You can create them through the user interface,
import them, or create through an API. Once added, these properties are available for use in screen configurations, filters,
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and numerous configuration areas (for example, search fields, duration field, and so on). You can create these types of
properties:
• String: These are custom properties that require alphanumeric entries. These can include free text boxes, URLs,
phone numbers, or email addresses.
• Integer: These are custom properties that require numeric entries. This option can also be used for check boxes.
• Enumeration: These are custom properties that require selections from fixed lists. Option buttons and combo (dropdown lists) boxes are common examples of this property type.
• File: These are custom properties that require some type of file upload. These could include MIME types such
as .gif, .jpg, .pdf, .mpeg, .zip, html, .wav, or .doc. Examples of File properties could be customer signatures or even
technician photos.

Create a String Property
The string property includes free text boxes, URLs, phone numbers, and email addresses. Assume that resources must enter
remarks for an activity after the activity is closed. The Activity Details form must contain a text box, so the resource can enter
the remarks. The text box that you add here, is a string property.
1.
2.
3.
4.
5.

Click Configuration.
Click Properties in the Resources, Activities, Inventories section.
Click Add New.
Select String from theProperty Type drop-down list.
Complete these fields:

◦
◦
◦
◦
◦
◦
◦

◦

Property name(mandatory): Enter a name that you want to display to the end user in English and in all the
languages that are active in the application.
Property label(mandatory): Enter a Unique database identifier for the Oracle Field Service Cloud API.
Property hint(optional): Enter a hint that you want to display when a user hovers over the field name. For
example, Enter comments if any. Enter the text in English and in all the languages that are active in the
application.
Regular expression: Enter an expression to validate the values or format the values in a certain way.
Entity(mandatory): Select Activity since the property is associated with the Activity Details form.
Lines Count(mandatory): Enter the number of lines that you want the property to display in the Activity Details
form. For example, enter 3 to display a maximum of three lines.
GUI (optional): Select one of these options to define how the property displays to users:
- Text Element: Displays as a free text field. For our example, select this option.
- URL: Displays as a clickable URL.
- Phone: Displays as a clickable phone number.
- Email: Displays as a clickable email address.
- Geolocation Element: Displays a button to show the location on a map.
Regular expression (optional): Enter an expression to validate input or to force the data to display in a
certain way.
For example, if you want to display $23,540, then use these regular expression: /^/$?([1-9]{1}[0-9]{0,2}(/,[0-9]
{3})*(/.[0-9]{0,2})?|[1-9]{1}[0-9]{0,}(/.[0-9]{0,2})?|0(/.[0-9]{0,2})?|(/.[0-9]{1,2})?)$/
Other examples:
- Ethernet ARP address: /^([0-9a-fA-F]{2}:){5}[0-9a-fA-F]{2}$/
- Phone number: (555)5555555: /[/(/)\d/-]{10}/
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- 16-bit integer: (0-65535): /(^\d{0,4}$)|(^6553[0-5]$)|(^655[0-2][0-9]$)|(^65[0-4]\d{2}$)|(^6[0-4]\d{3}$)|
(^[0-5]\d{4}$)/
- 1 digit: (0-9): /^\d{1}$/
- 2 digits: (01-99): /^\d{2}$/
- Integer: (0-99): /^\d{1,2}$/
- Integer: (0-999): /^\d{1,3}$/
- Any 6 symbols(you can change 6 to any number): /^.{6}$/u
- Currency (USD with 2 decimal places): /^/$?([1-9]{1}[0-9]{0,2}(/,[0-9]{3})*(/.[0-9]{0,2})?|[1-9]{1}[0-9]{0,}(/.
[0-9]{0,2})?|0(/.[0-9]{0,2})?|(/.[0-9]{1,2})?)$/
- Date formatted as DD-MM-YYYY: /^((0[1-9])|([1-2][0-9])|30|31)-((0[1-9])|1[0-2])-2[0-9]{3}$/
Clone property on Reopen/Prework (optional): Enables you to duplicate the property while reopening the
activity or applying prework for a new activity.
Formatting (optional): If selected, displays these options:
- Regular expression
- XSL transformation (converts an XML file into a table format viewable in HTML that is read-only).
Note: Formatted properties are not available for presentation on the Inventory Grid context
layout screen.
Assume that you want to display these data from a client system within Oracle Field Service Cloud:
Group

Price

One Time Charges and Credits

$ 100.00

Programming Change

$ 5.00

Programming Change

$ 5.00

Programming Change

$ 5.00

Programming Change

$ 5.00

UNKNOWN

$ 0.00

Monthly Charges

$ 129.98

America’s Top 250

$ 69.99

HD/SD (2TV) Receiver

$ 14.00

HD/SD (2TV) Receiver

$ 14.00

DVR Service

$ 6.00

Protection Plan

$ 6.00

Israeli: The Israeli Network

$ 19.99

Monthly Credits
Cr: Agent $ 10x24 Mo
Monthly Charges and Credits

$ -10.00
$ -10.00
$ 119.98
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Use these regular expression for the above data: /(/s+)?(.+/w)/s+(/$)/s+(.*)/n?/im = [item group="$1"] [name]$2[/
name][price]$4[/price][currency]$3[/currency][/item]
these XML file converts the data given earlier into a table format:
[xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"]
[xsl:template match="/"]
[style]
.property_table
{
font-size:12px;
font-family: Arial;
border-collapse: collapse;
}
.property_table .property_name
{
padding-left:15px;
}
.property_table td
{
border: 1px solid grey;
padding: 4px;
}
.property_table .property_price
{
text-aligh:right;
}
.property_group
{
background-color:#ccc;
font-weight: bold;
}
.property_group .property_name
{
padding-left:5px;
font-weight: bold;
}
[/style]
[table class="property_table"]
[xsl:for-each select="root/item"]
[xsl:choose]
[xsl:when test="@group=' '"]
[tr class="property_group"]
[td class="property_name"] [xsl:value-of
[td class="property_price"]
[span] [xsl:value-of select="currency"/]
[xsl:value-of select="price"/]
[/td]
[/tr]
[/xsl:when]
[xsl:otherwise]
[tr]
[td class="property_name"] [xsl:value-of
[td class="property_price"]
[span] [xsl:value-of select="currency"/]
[xsl:value-of select="price"/]
[/td]
[/tr]
[/xsl:otherwise]
[/xsl:choose]
[/xsl:for-each]
[/table]
[/xsl:template]

select="name"/] [/td]
[/span]

select="name"/] [/td]
[/span]
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[/xsl:stylesheet]

Using XSL transformation, the above XML file is displayed in HTML as shown in this figure:

6. Click Add.
A system generated ID is assigned to the property. You can perform these actions:
◦ Click Export to export the properties to an XML file.

◦

Click Import, Browse, and select the XML file that you want to import.

Add a String Property to the Screen Configuration
After you create a property, you can assign it to a specific user type and determine where the property type displays on the
screen.
You can define these visibility settings for the property type:
• Read only, read/write, or mandatory options.
• Conditions under which the property type displays.
Note: Not all conditions are available for every screen context.
Let’s assign the string property, CSR Notes property to a User Type, Administrator, and add it to the Activity Details form.
Also, let us set the property type to Read-Only when the activity status is Completed and change the property type to Read
Write when the activity status is Pending. To add a string property:
1. Click Configuration, User Types in the Users and Security section.
The existing users display in the left pane.
2. Select Administrator from the left pane.
3. Select the Screen Configuration tab.
4. Expand Manage and click Add activity/Activity details.
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5. Select a property from the Layout Structure pane and click Add property.
6. Select the property, CSR Notes and click OK.
The property, CSR Notes displays in the Layout Structure pane.
7.
8.
9.
10.
11.
12.
13.
14.

Click Add New Visibility and select Read-Only.
Click Add New Condition.
Select Activity Status and in (equal) from the drop-down lists.
Click the Plus icon, select Completed, and clickSave.
Click Add New Visibility and selectRead-Write.
Click Add New Condition.
Select Activity Status and in (equal) from the drop-down lists.
Click the Plus icon, select Pending, and click Save.

You can view both the conditions in the Conditions column.

Create an Enumeration Property
Option buttons and drop-down lists are examples of the enumeration property. This means, you can have a set of valid
values and you can select only one value from the set. For example, you have four types of customers, Standard, Gold, Silver,
and Bronze and you want to indicate the customer type on each activity record.
This example creates an enumeration property, Customer level with four values, Standard, Gold, Silver, and Bronze, and
displays the property as a drop-down list in the user interface.
1. Click Properties in the Resources, Activities, Inventories section.
2. Click Add New.
3. Select Enumeration from the Property Type drop-down list.
4. Enter Customer level in the Property Name field. Enter the name in English and in all the languages that are active
in the application.
5. Enter Cust_level in the Property label field.
6. Select Activity from the Entity drop-down list.
7. Select Combobox from the GUI drop-down list.
8. Specify the value, Standard in the Enumeration Values field and click Add.
Note: The values display in alpha-numeric order. The system automatically applies an index value to each
specified value, and the index value is case sensitive. The APIs reference the index value. For example, if
you want to use a readable value for the value, customer not home, you can use the code CNH instead of
the default index value, 1 and map the code to the client system. You cannot edit the index value, after it is
added.
9. Repeat step 6 for each value, that is, Gold, Silver, and Bronze.
The specified values display in the Values field.
10.
11.
12.
13.

Select a value from the Values field.
Clear the Active check box.
Click Edit to make a value inactive and does not display in the user interface.
Click Add.

67

Oracle Field Service Cloud

Chapter 1

Administering Oracle Field Service Cloud

Configure Oracle Field Service Cloud

Create a File Property
The File property type supports transferring of files such as documents, photos, or signatures. This means, you can upload
MIME types such as .gif, .jpg, .pdf, .mpeg, .zip, html, .wav, or .doc files for activities.
1.
2.
3.
4.

Click Configuration > Properties .
Click Add New.
Select File from the Property Type drop-down list.
Enter a name for the property in the Property Name field. Enter the name in English and in all the languages that are
active in the application.

This is the name that is displayed on the context layout screen and any screen to which the property is added.
5. Enter a label for the property in the Property label field.
6. Enter a hint that you want to display when a user hovers over the field name in the Property hint field. Enter the hint
in English and in all the languages that are active in the application.
7. Select the entity to which the property belongs, in the Entity field.
8. Select one of these options for the GUI field:
Option

Description

File element

Select this option to upload a file. When uploaded, the file displays as a text link in the user
interface. these fields are displayed for this option:
File size limit: Select the maximum file size you want to allow for File elements in
Oracle Field Service Mobility Cloud Service. This field is displayed only for the File
element option. The default and the maximum size allowed is 5 MB.
Allowed MIME types delimiter: Select whether you want to display separate allowed
MIME types with commas, or you want to display each allowed MIME type on a new
line.
Allowed MIME Types: Click the required types of files you want to allow for upload.

◦
◦
◦

Signature element

Select this option to capture the resource’s signature.

Image element

Select this option to enable the user’s device to capture and upload the user’s photo, and to
display the image as a thumbnail. these fields are displayed for this option:
Allow draw on image: Select this check box to let the user draw on the captured
image using a stylus.
Get geolocation: Select this option to save the location information on a map with the
captured image.
Maximum picture width (in pixels): Enter the maximum width the captured image can
have. The recommended width is 1000 pixels.
Maximum picture height (in pixels): Enter the maximum height the captured image can
have. The recommended height is 1000 pixels. Maximum resolution limits should be
exceed 5000x5000 pixels. The Minimal value is 10 pixels.

◦
◦
◦
◦

9. Select whether you want to copy the property data when an activity is reopened or has a pre-work activity in the
Clone property data on Reopen or Prework field.
10. Click Add.
The new property type is added. Add this property to the context layout of the screen for the user profile for which
you want to display.
Related Topics
• Supported MIME Types
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Supported MIME Types
The full list of supported MIME-types and the matching file extensions is provided here.

MIME Type

Supported File Extensions

animation/narrative

'nml'

application/mspowerpoint

'pot', 'pps', 'ppt', 'ppz'

application/msword

'doc', 'dot'

application/oda

'oda'

application/onenote

'one', 'onetoc2', 'onetmp', 'onepkg'

application/pdf

'pdf'

application/rtf

'rtf'

application/vnd.ms-excel

'xls', 'xlt', 'xla'

application/vnd.msexcel.addin.macroEnabled.12

'xlam'

application/vnd.msexcel.sheet.binary.macroEnabled.12

'xlsb'

application/vnd.msexcel.sheet.macroEnabled.12

'xlsm'

application/vnd.msexcel.template.macroEnabled.12

'xltm'

application/vnd.ms-officetheme

'thmx'

application/vnd.mspowerpoint.addin.macroEnabled.12

'ppam'

application/vnd.ms'pptm'
powerpoint.presentation.macroEnabled.12
application/vnd.mspowerpoint.slide.macroEnabled.12

'sldm'

application/vnd.mspowerpoint.slideshow.macroEnabled.12

'ppsm'

application/vnd.mspowerpoint.template.macroEnabled.12

'potm'

application/vnd.msword.document.macroEnabled.12

'docm'

application/vnd.msword.template.macroEnabled.12

'dotm'

application/vnd.openxmlformats'pptx'
officedocument.presentationml.presentation
application/vnd.openxmlformatsofficedocument.presentationml.slide '

'sldx'
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MIME Type

Supported File Extensions

application/vnd.openxmlformatsofficedocument.presentationml.slideshow

'ppsx'

application/vnd.openxmlformatsofficedocument.presentationml.template

'potx'

application/vnd.openxmlformatsofficedocument.spreadsheetml.sheet

'xlsx'

application/vnd.openxmlformatsofficedocument.spreadsheetml.template

'xltx'

application/vnd.openxmlformats'docx'
officedocument.wordprocessingml.document
application/vnd.openxmlformats'dotx’
officedocument.wordprocessingml.template
application/x-excel

'xls'

application/x-gtar

'gtar'

application/x-gzip

'gz'

application/x-pointplus

'css'

application/x-shockwave-flash

'swf'

application/x-sprite

'spr', 'sprite'

application/x-tar

'tar', 'tgz'

application/zip

'zip'

audio/mpeg

'mp2', 'mp3', 'mpga'

audio/x-wav

'wav'

chemical/x-pdb

'pdb'

image/gif

'gif'

image/jpeg

'jpe', 'jpeg', 'jpg'

image/png

'png'

image/tiff

'tif', 'tiff'

image/x-ico

'ico'

text/html

'htm', 'html'

text/plain

'txt'

text/richtext

'rtx'

text/tab-separated-values

'tsv'

text/x-speech

'talk'

text/x-vcard

'vcf'

video/mp4

'mp4'

video/mpeg

'mpe', 'mpeg', 'mpg'

video/quicktime

'mov', 'qt'
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MIME Type

Supported File Extensions

video/x-msvideo

'avi'

Create an Integer Property
Check boxes and text fields are examples of the integer property. Use the integer property to enter numerical values such as
port number, or to select your decision such as whether an additional inventory has been approved by the dispatcher [Yes/
No].
This example creates an integer property, Customer confirmed, and displays the property as a check box in the user
interface.
1. Navigate to the Configuration screen.
2. Click Properties in the Resources, Activities, Inventories section.
3. Click Add New.
4. Select Integer from the Property Type drop-down list.
5. Enter Customer confirmed in the Property Name field. Enter the name in English and in all the languages that are
active in the application.
6. Enter Cust_decision in the Property label field.
7. Select Activity from the Entity drop-down list.
8. Select Checkbox element for GUI.
9. Enter an expression in the Regular expression field to validate input or to force the data to display in a certain way.
10. Select whether you want to duplicate the property while reopening the activity or applying pre-work for a new
activity.
11. Click Add.
The newly added property appears on the Properties screen.

Resource Types
A resource type helps you identify these differences:
• Account for cost differences between full time employees and contractors.
• Identify the resources that you want to track using geolocation.
• Manage quota and capacity for resources.
• Distinguish between team holder and team member.
• Share a resource’s inventory and work skills in a team.
You can create different resource types to differentiate the hierarchy of the Resource Tree. While creating a resource type,
each resource type is assigned to a role. The roles (Field Resource, Vehicle, Tool, Bucket, and Organization Unit) enable you
to differentiate the hierarchy of the Resource Tree. Each role is represented with the icons, Blue, Yellow, or Grey.
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By default, the Load Threshold section displays (unless the Organization Unit role is selected) on the Add Resource Type
screen and has the following options to determine how the icons display on the resource tree based on the resource’s load
(full, normal, or empty load):
• Number of Activities: Defined amount of activities, over which a resource is considered to have full load and below
which is considered an empty load.
• Hours: Defined amount of hours including travel, over which a resource is considered to have full load and below
which is considered an empty load.
• Time Percent: Defined % of a resource’s work schedule for the day that includes activities and travels among them
that is considered to be full, normal or empty. Travel time to and from work for the day is not included in these
calculations.
Note: Specify the number of activities, hours, percentages in the Full Load or Empty fields. The display of icons
on the resource tree depends on the specified values. For example, if 10 activities represent Full load, then the
Blue icon displays.

Add a Resource Type for the Field Resource Role
A Field Resource is a resource that performs work, has work skills and work zones associated, and has a related user (actual
person performing work or group of people). A Field Resource requires a user, can execute work, is shown with a Tech icon,
and does not include the Organization unit option.
Assume that you want to assign activities to a technician. You have to first create the resource type, Technician and then
select Field Resource from the Role drop-down list.
Note: Some features are available only during the initial configuration. This will vary based on the options
selected during the configuration. Features that are not available for editing after the initial configuration will be
greyed out.
To add a resource type for the Field Resource role:
1. Click Company Name > Configuration .
2. Click Resource Types in the Resources, Activities, Inventories section.
3. Click Add resource type.
4. Enter these information:
Field

Description

Name (mandatory)

Enter a name for the resource type. All supported languages are listed.

Label (mandatory)

A unique identifier for the resource type that is mapped to the Resource Management API.

Active

By default, the Active check box is selected and the resource type is activated.

Statistic Parameters section
Personalize the estimation of
activity duration check box

When selected, the resource’s personal profile is used for duration calculations. Else, uses
only company estimates. For more information, see How Activity Duration Is Calculated

Use durations reported to
enhance company-wide
estimations check box

When selected, company-wide estimations are modified based on the data reported by the
resource. If not selected, the company-wide estimations are not changed. This applies to
both activity durations and travel estimations. don't select this check box, if you don't want
the durations reported by the resource to affect company level estimations.
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Field

Description

Do not consider reported data for the
first ____ working days, for statistic
estimations

Data reported by the resource does not affect the company-wide estimations for the
initial number of days specified in this field. The date is considered from the time the user
accesses the system. Default value is 5 days. For example, if you enter 15 days, then the
data reported by the resource for activity and travel durations are ignored for the first 15
days and will not be considered while calculating the company-wide estimates. This field is
enabled only if the Use data reported to enhance company-wide estimations field is
selected.

5. Select Field Resource from the Role drop-down list.
6. Select the required features from these list:

◦
◦

Resource can participate in a team: Select the Resource can participate in a team check box to determine
whether the resource type is an assistant for teamwork activities. If deselected, then you cannot add the
resource type, technician as an assistant to a team.
Resource can be a teamholder: Select the Resource can be a teamholder check box to determine whether
the resource type is a primary team holder of an activity.
Note: An activity that requires a team is always assigned to the team holder whereas the assisting
teamwork activities are assigned to the assistants for the duration of the teamwork.

◦

Share inventory in teamwork: Determines whether the resource type shares inventory with other team
members after an activity is started. For example, if the team holder’s inventory has 5 items and the
assistant’s inventory has 3 items, then when the activity is started, there are 8 items available for use at the job
site.
Share geolocation in teamwork: Select the check box to define whether a resource (team holder or
assistant) shares the geolocation in a teamwork assignment. Although, the application uses the GPS device of
each resource to predict the location of the resource, these situations can occur:
- Application is unable to obtain coordinates since the device of a resource has stopped to work.
- Application is unable to find the location of the resource due to some reasons.

◦

In the above situations, the application uses an algorithm to predict the location of the resource using the
coordinates of other resources in the team. Therefore, you can view the location of each team resource in the
map view.
Share work skills in teamwork (team-member only): Enables the resource to share work skills with
the team holder. Sharing is defined on the work skill level according to the "Sharing of the skill in the team"
parameter configured in the Add work skill screen.
Used for Quota management: Enables you to consider the working time of each resource into the overall
workflow capacity calculation of the bucket.

◦

◦

◦

For example, assume that each resource (Technician 1, Technician 2, and Technician 3 configured as a Field
Resource) has a capacity of 480 minutes per day and the Use as Capacity Area check box is selected for
each resource. Therefore, the Max Available field in the bucket has the overall workflow capacity of 1440
minutes. Now, if a new resource type, Technician 4 is added and if the Use as Capacity Area check box is
selected, then the overall workflow capacity of the bucket changes to 1920 minutes.
Routing can assign activities: Select the check box if you want routing to assign activities to a resource.
If selected, these options enable you to specify the cost of the resource’s time that helps you to differentiate
between resources (for example, Full time resources versus Contractors):
- Working hours cost: Actual working hours of the resource during the day based on activity durations.
Select an option (Low, Normal, High, Highest). The routing algorithm factors working time cost
differences between resource types for assignments.
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- Overtime cost: Overtime refers to the minutes worked beyond the end of the resource’s working
hours for the day. Specify cost increases either as X minutes after the end of the shift or the time
beyond the X minutes threshold.
- Travel Time cost: Refers to the estimated time and the cost required for travelling between activities.
◦ Working time : Define the travel allowance for resources using these options:
- Start travel: Enables routing to consider travel time from the beginning of the resource’s working time
for the day and to the resource’s first activity. The application estimates the actual travel time to the
location of the first activity, when a resource’s Start location is defined. Note that when a route includes
activities that require travel and activities that don't need travel, the travel between activities is split
into two (or more) pieces by inserting non-travel activities in between. If there is any idle time before an
activity, it is considered as travel time for the next activity. Select one of these options:
◦ Travel time to the first activity is not included from the Working Time Start – when selected,
travel time to the first activity will not be calculated. If an activity has a Service Window of 8:00
am-10:00 am, the activity will have an ETA of 8:00 am and the resource will have to leave their
start location to arrive by 8:00 am.
◦ Travel time to the first activity is included from the Working Time Start – when selected, travel
time will be calculated to the first activity. If a resource has 30 minutes of travel and the activity
has a service window of 8:00 am-10:00 am the activity’s ETA will be 08:30 am.
◦ Resource is allotted up to <number> minutes of travel time prior to the Working Time Start –
when selected, a portion of the travel time can occur prior to the start of the shift. If the value is
set to 30 minutes and the resource need 45 minutes of travel the first 30 minutes will occur prior
to the start of the shift and the ETA activity’s ETA will be 08:15 am.
- Final travel: Enables routing to consider travel time to a known end location. Select one of these
options:
◦ Travel time from the last activity to the Resources End Location is not included from the Working
Time End – when selected, travel time to the final location will not be calculated. If a resource’s
shift ends at 6:00 pm with no overtime allowed, routing can assign activities that can end at 6:00
pm.
◦ Travel time from the last activity to the Resources End Location is included from the Working
Time End – when selected, travel time to the final location will be calculated. If a resource’s shift
ends at 6:00 pm with no overtime allowed, routing cannot assign activities that can end at 6:00
pm.
◦ Resource is allotted up to <number> minutes of travel time after the Working Time End – when
selected, a portion of the travel time will occur after the shift ends. Suppose that the resource’s
shift ends at 6:00 pm with no overtime allowed. When the value is set to 30 minutes and the
resource needs 45 minutes of travel to the end location, the latest an activity can end would be
5:45pm.
◦ Enable 'Not activated in time' alert and trigger: Represents an alert that the resource’s route is not
activated. For example, consider the resources, Technician 1 and Technician 2 configured as field resources.
If the Enable 'Not activated in time' alert and trigger check box is selected for the resource, Technician 1 and
not selected for Technician 2, then the notification messages are created only for Technician 1.
7. Click Add.
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Note: these features are available when a role, Vehicle or Tool is assigned to a resource type:
◦ Share inventory in teamwork

◦
◦
◦
◦
◦

Share geolocation in teamwork
Share work skills in teamwork (team-member only)
Working time includes travel to first activity
Working time includes travel from last activity
Enable 'Not activated in time' alert and trigger

The resource type, technician displays on the Resource Types screen. If you click Modify and change a feature setting of a
resource type, the application automatically applies the changes to the resource type.

Example of a Travel Allowance Calculation
Roger’s assigned Resource Type has these Work Time configurations:
• Travel time to the first activity is included from the Working Time Start
• Travel time from the last activity to the Resources End Location is included from the Working Time End
Jane and John’s assigned Resource Type has these Working Time configurations:
• Resource is allotted up to 30 minutes of travel time prior to the Working Time Start
• Resource is allotted up to 30 minutes of travel time after the Working Time End
Consider Roger, Jane, and John, who have their work shift from 9:00 am to 6:00 pm and these distances from work place:
• Roger lives 30 minutes from his first and last job. So, for both jobs, 30 minutes of travel is included part of his
workday.
• Jane lives 45 minutes away from the first and last job. So, for both of her jobs only 15 minutes of the travel should be
counted as part of her workday and the additional 30 minutes is beyond her workday.
• John lives 20 minutes away from his first and last job. So, no travel is part of his workday and the 20 minutes travel
for the last job is done beyond his workday.
Using this example, if a new activity is created that is estimated to finish by 5:45 pm and overtime is no allowed, routing
will not assign this activity to Roger. If it was assigned, Roger would incur overtime, because his shift ends at 6:00 pm. The
routing engine would look for a more suitable resource.

Add a Resource Type for the Bucket Role
A bucket accumulates the work that has not yet been distributed to field resources. A bucket does not require a user, cannot
execute work or activities, is shown with a Double Tech icon, includes the group option, and can have activities assigned.

Note: Some features are available only during the initial configuration. This will vary based on the options
selected during the configuration. Features that are not available for editing after the initial configuration will be
greyed out.
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Click Configuration.
Click Resource Types in the Resources, Activities, Inventories section.
Click Add resource type.
Select Bucket from the Role drop-down list.
Enter these information:

◦
◦
◦

Name (Mandatory): Enter a name for the resource type. All supported languages are listed.
Label (Mandatory): A unique identifier for the resource type that is mapped to the Resource Management API.
Active: Select the Active check box to activate the resource type.

6. Select the Use as Capacity Area check box.
This option is available only if you have purchased Capacity Cloud Service. For more details about Quota
Management in Bucket, see the Oracle Field Service Cloud Using Capacity Cloud Service Guide guide.
7. Select the Routing can assign activities check box if you want routing to assign activities to the bucket.
8. Click Add.
The resource type, Bucket displays on the Resource Types screen.

Add a Resource Type for the Organization Unit Role
An organization unit aggregates field resources, vehicles, and tools in a hierarchical structure to simplify management and
reporting. An organization unit does not require a user, cannot execute work or activities, is shown with a Double Tech icon,
includes the group option, and can have activities assigned.

Note: Some features are available only during the initial configuration. This will vary based on the options
selected during the configuration. Features that are not available for editing after the initial configuration will be
greyed out.
1.
2.
3.
4.
5.

Click Company Name > Configuration .
Click Resource Types in the Resources, Activities, Inventories section.
Click Add resource type.
Select Organization unit from the Role drop-down list.
Enter these information:

◦
◦
◦

Name (Mandatory): Enter a name for the resource type. All supported languages are listed.
Label (Mandatory): A unique identifier for the resource type that is mapped to the Resource Management API.
Active: Select the Active check box to activate the resource type.

6. Select the Use as Capacity Area check box to aggregate the capacity across buckets.
For example, assume that the maximum available capacity for Bucket 1 is 1920 minutes and the Use as Capacity
Area check box is selected. Bucket 2 has a maximum available capacity of 2400 minutes and the Use as Capacity
Area check box is not selected. Now, if you select Use as Capacity Area check box check box for Bucket 2,
then the resource type, Group aggregates the capacity across Bucket 1 and Bucket 2 and changes the maximum
available capacity of the Group to 4320 minutes.
7. Click Add.
The resource type, Organization Unit displays on the Resource Types screen.
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Add a Resource Type for Contingent Worker
Contingent (or Infrequent) Workforce is one where the workers don't work directly for the company. They are contractors that
may not have dedicated or assigned routes everyday. They will be assigned work infrequently on an ad-hoc basis.
Note: The Contingent Worker service must be enabled and available as part of your Oracle Field Service Cloud
subscription.
1.
2.
3.
4.

Click Configuration.
Click Resource Types in the Resources, Activities, Inventories section.
Click Add resource type.
Enter these information:
Field

Description

Name (mandatory)

Enter a name for the resource type. All supported languages are listed.

Label (mandatory)

A unique identifier for the resource type that is mapped to the Resource Management API.

Active

By default, the Active check box is selected and the resource type is activated.

5. Select Field Resource from the Role drop-down list.
6. Select the Resource is a contingent worker check box.
The remaining check boxes are grayed out. these rules apply to contingent worker resources:
◦ When the Resource is a contingent worker check box is selected, the Role cannot be anything other than
"Field Resource".
◦ This resource cannot participate in teamwork.

◦
◦
◦
◦
◦
◦

This resource cannot access resources other than themselves.
This resource cannot access the video chat service if provisioned.
Quota does not consider contingent workers while calculating the available capacity.
Bulk, urgent, and immediate routing don't assign activities to this resource.
The alert regarding route activation does not display for this resource.
Travel and activity duration from these resources are not included in the company-wide statistics.
Note: The Resource is a contingent worker check box is grayed out on the Edit resource type
screen. This means, after you create a contingent worker resource type, you cannot change it back to
a normal resource. Further, a contingent worker resource can only be a field resource and this resource
must have only one corresponding contingent worker user. Contingent workers are automatically removed
from the application, if they have not activated a route in 12 continuous months.
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Shifts
Add a Shift
Shifts are defined as patterns of working time. Use this feature for non-standard types of shift that don't fall within the
traditional 24-hour clock. You can create separate shifts for each working time pattern within your organization.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules screen appears.
3. Click Shifts.
The Shifts screen appears.
4. Click Add Shift.
The Add Shift window appears.
5. Fill up these fields:
Field

Description

Name

Enter a name for the shift, as it appears in the application.

Label

A unique identifier for this shift.

Type

Select an option from the drop-down menu. Common shift types include Regular for
standard periods of time, or On-call for longer time frames that a resource might be
available, after the regular shift ends.
Note: You can create only one on-call shift per day. If you create a second on-call
shift, the first one is deleted.

Active

Click the check box to activate (make available for use) this shift.

Time From

Enter the start time for this shift.

Time To

Enter the end time for this shift.

Points

Within the application, points are used as limiters. If activities are assigned point values
(based on different completion durations, complexity, value, etc.), then assignment caps can
be determined on a shift-by-shift basis. Once point thresholds are reached for a resource to
which that shift is assigned, then routing will allocate no more activities to that resource.

Add an Activity to a Shift
Add an activity to a shift, when you want to add the activity to the calendars of all of the resources that have the shift
assigned to them.
1. Click Configuration, Work Schedules, Shifts.
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The Shifts list displays.
2. Click the Activities link in the row of the shift that you want to add the activity to.
3. Click Add Activity.
The Add Activity screen displays. If this activity is an internal activity, the layout of the screen changes. If it is a
customer-facing activity, the layout stays the same.
4. Complete the applicable fields.
Field name

Action

Activity Type

Select the activity type from the Activity Type drop-down list.

Name

Enter the customer’s name. Used for customer-facing activities only.

Work Order

Enter the work order number associated with this activity.

Duration

Enter the amount of time that the activity lasts.

Position in Route-Not Ordered

The activity is not ordered, and appears in the Not Ordered column in the Time view.

Position in Route-Ordered

The activity is displayed on the resource's route. If you specify a time slot, the activity
displays in that time slot. Otherwise, it displays as pending at the beginning of the route.

Time Slot

Select the period of time within which this activity can be started.

Activity Notes

Enter any notes associated with this activity.

Recurrence-Repeats-Daily

Apply to schedules such as every other day or every 3rd day. If you select this option, add
the frequency of occurrence in the field Days between occurrences.

Recurrence-Repeats-Everyday

Applies to every day schedules that repeat without exception and without any modification
options.

Recurrence-Repeats-Weekly

Apply calendars that have a regular weekly pattern. Select the days that apply to this shift
using the check boxes for the individual days. Indicate the frequency of this pattern weekly
by adding a value to the Weeks between occurrences field.

Recurrence-Repeats-Yearly

Occurs every year from the selected date entered in the From day until the date entered in
the To day field.

5. Click OK.

View Statistical Parameters
Oracle Field Service Cloud uses collected statistical data on actual activity and travel duration for calculating a resource’s
estimated time arrival for the pending activities and the delivery window. In addition, the Routing module uses the collected
statistics to assign activities to a resource in the most effective manner, according to the specified routing parameters.
Statistical parameters are calculated separately for each resource, group/bucket, and whole company. If the data is not
enough to predict the duration or travel for a resource, then the group/bucket or company values are used. Finally, if the data
is not enough at the company level, then the default values are used.
1. Click Configuration.
2. In the Subsystems and Integrations section, click Statistics.
The Statistics screen appears.
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Description

Duration parameters
Minimum relevant duration time in
minutes
Maximum relevant duration time in
minutes

To ensure that outlier activity durations (sometimes due to non-compliance) don't adversely
affect statistical calculations, durations with values less than or more than the minutes
entered in these fields will be ignored by the statistics engine.

Lower limit for personal ratio to
calculate duration (%)

The lower and upper limit percentages are with respect to the company level duration for
an activity. If the duration estimated for a resource’s assigned activity is beyond the lower
or upper limit, the estimate is corrected so that it lies within the set limits. The Lower limit
default value is 50 with an available range from 0-100. The Upper limit default value is 200
with an available range from 100-999. If the preference is always to use the personal learned
duration without any lower or upper limits applied, the ranges must be set for the outer
extremes with the lower limit set to 0 and the upper limit set to 999.
Example: Suppose the company-level estimation for an activity is 50 minutes and the
lower limit percentage is set to 80%. If the estimation for a resource is 30 minutes, the final
estimation for the activity will be calculated as the maximum of 30 minutes and 80% of 50
minutes, which will be 40 minutes. The lower limit would be in effect and 40 minutes would
be assigned to the activity.

Upper limit for personal ratio to
calculate duration (%)

Travel time parameters
Default travel average time

The average value and standard deviation (in minutes) used for travel time prediction when
there isn't statistical data for travel between two specific travel statistics keys.

Minimum relevant travel time in
minutes
Maximum relevant travel time in
minutes

In an effort to ensure that outlier travel durations (sometimes due to non-compliance) will
not adversely affect statistical calculations, durations with values less than or more than the
minutes entered in these fields will be ignored by the statistics engine.

Coordinate calculation weight

This parameter defines the weighting proportion between the statistic (average travel time)
and coordinate methods (straight line/airline) of calculating/predicting travel time between
two locations. The options are as follows:
0 = Use only travel key based estimation

◦
◦
◦
◦
◦

0.001 = Prefer travel key based estimation
0.5 = Use both estimations evenly
0.999 = Prefer coordinate method based estimation
1 = Use only coordinate method based estimation

Airline distance speed

The speed used to determine airline (straight line) distance time.

Departure/parking time

The amount of time that is allowed for parking and departure from one activity to another.

Delivery Window Parameters
Delivery window factor

Determines how much deviation should affect the calculation of future delivery windows
based on their ETAs.

Delivery window granularity

This defines the number of minutes to which delivery window values will be rounded.

Delivery window minimal size

When delivery window is calculated, this is the smallest value (in minutes) that will be
provided.

Delivery window maximal size

When delivery window is calculated, this is the largest value (in minutes) that will be
provided.
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Field

Description

Delivery window should not start
earlier than [ ] minutes prior to start of
service or SLA window

Prevents the delivery window from starting outside the previously agreed service window.
When the option is enabled, the statistically calculated delivery window cannot start earlier
than the specified number of minutes before the service window or SLA window start.

Stats Fields
Activity duration stats fields
Activity travel stats fields
Resource travel stats fields

This group represents the formation of the keys (made up of fields) used for the grouping of
work duration and travel duration values to find the averages.
The user-defined activity keys make it possible to sort the collected statistical data according
to various activity characteristics, such as work order type, activity properties, activity
postcode, etc.

Note: You can specify durations for specific activities and technicians through APIs. For more information,
see the REST API for Oracle Field Service Cloud guide.
Related Topics
• How Activity Duration Is Calculated
• Pre-Calculated Travel Statistics

Update Travel Statistics
Travel statistics are updated when the not-assigned activities with default travel time are assigned to a resource. Oracle
Spatial and Graph Route Server, which sends the travel time, updates the travel statistics in real-time.
1. Open Configuration > Statistics.
The Statistics page appears.
2. Set up the Default Travel Time and Minimal Statistical Travel Time to ensure there is no statistical information
for the travel time between these activities.
The setup time is applied to the activities of the bucket.
3. To assign the activities in the bucket to a resource, select the appropriate activities and click Move.
The travel time value is received from street level route service and set up as per this value.

Themes
View Themes
You can create custom Themes that use your own logos as headers in the user interface, including the Login page. In
addition, you can define a custom theme color, which appears as the header. The Themes visibility controls the access to
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Themes. For each user type that manages Themes, set the Read/Write permissions. When you set the visibility to ReadOnly,
the Themes screen is grayed, and when you don’t grant the visibility, the Themes screen is not visible at all.
1. Click Configuration.
2. In the Displays section, click Themes.
The Themes screen appears and displays these fields:
Field

Description

Name

The name of the theme.

Default

Displays whether the theme is selected as the default theme. The default theme has a check
mark next to it. When you click Select default, you can set whether all users or only new
users will have this theme set as the default.

Active

Displays whether the theme is active. An active theme has a check mark next to it. The Set
enable or Set disable actions determine whether the theme is active or not.

Actions

Displays the actions available for the Theme. these actions are available:
Edit – Allows editing the options for the selected theme. See the Add a Theme section
for an explanation of the options.
Set default - Sets this theme as the default theme. You can set whether all users or
only new users will have this theme set as the default.
Set enable - Enables a currently disabled theme.

◦
◦
◦
◦
◦
◦

Set disable - Disables a currently enabled theme.
Export – Exports the details of the theme to a zip file. The zip file can be used to
import the theme into another Oracle Field Service Cloud instance.
Delete – Deletes the theme.

Add a Theme
You can create custom Themes to use your own logos as headers in the user interface, including the Login page. In addition,
you can define a custom theme color, which appears as the header. The Themes visibility controls the access to the Themes.
For each user type that manages Themes, set the Read/Write permissions. When you set the visibility to ReadOnly, the
Themes screen is grayed, and when you don’t grant the visibility, the Themes screen is not visible at all.
1. Click Configuration.
2. In the Displays section, click Themes.
The Themes screen appears.
3. Click Add new.
The Add theme window appears.
4. Complete these fields:
Field

Description

Name

The name of the theme.

Color Theme

Displays the hexadecimal code for the theme’s color. Clicking this field displays a color
picker. Either enter the hexadecimal code for the color to be used for this theme, or select a
color using the color picker.
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Field

Description

Title Page

The HTML Title tag for this theme.
For example: https://demo2.etadirect.oracle.com

Copyright

Copyright information. The text should contain placeholders for {YEAR} and {VERSION} that
will be automatically replaced to current year and major version. Example: © 2003-{YEAR}
Oracle Corporation. All rights reserved. Version {VERSION}. The maximum length of this
string is 255 characters.

Big (logo)

Select the logo in .png format. This logo is used with screens of width 1024 and more, or
between 320 and 768.

Small (logo)

Select the logo in .png format. This logo is used in other cases within Core Manage and
Mobility.

Login (logo)

Select the logo in .png format. This logo is used in the login portal.

Custom Forms
From a business perspective, Forms are paper documents that Field Resources fill in, while performing their work. From
Oracle Field Service Cloud perspective, a Form is a pre-configured screen that can be configured using data elements that
exist only in the context of a Form.
Features of Forms:
• Administrators may create as many Forms as needed for the business.
• Forms are not User Type specific; they are independent screens that are connected to User Types screens through
links that are configured on context layouts.
• After the Form is configured, all users see the same Form and capture the same data regardless of their User Type.
• The Form Field data elements, which can be added to forms are not associated or “bound” to a specific field or
custom property.
• Forms are available only in Core Application, iOS and Android apps; they are not available in the Legacy Manage
application.
• Contents of a submitted Form cannot be changed, even if a related entity or Form configuration changes later.
• When a Form is submitted, all Form field elements, except those that have auto-calculated default values or values
filled through predefined parameters are blank.
• Forms don't support links to any types of screens such as standard actions, plug-ins, or other forms.
Forms are represented in three ways in Oracle Field Service Cloud:
• A configuration screen where all the required elements are added.
• A screen on a mobile device or a computer where technicians and dispatchers fill in data.
• A submitted Form result that represents every sample of the completed Form. These results are available to users on
separate screens and can be retrieved through APIs.
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Provide Access to the Forms & Plugins Screen
Users with access to the Forms & Plugins screen can add and modify custom Forms and plug-ins.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click Configuration > User Types .
Select the type of user for which you want to provide access.
Go to the Screen configuration tab.
In the Main menu tree, click Configuration.
Click Click to Add and select the Forms & Plugins check box.
Click OK.
Click Forms & Plugins and then click Add new visibility.
Select Read-write and click Save.
Click Close.
All the users of the selected User Type now have access to the Forms & Plugins screen.

How a Form is Configured
Here are the high-level steps to configure a Form.
1. Create the Form.
2. Configure the Form elements.
3. Add the Form to a screen.

Create a Form
You create a Form so that Field Resources can fill it to capture statutory or business data required for an activity.
1. Click Configuration > Forms & Plugins .
2. Click Add Form.
3.
4.
5.
6.

The Add Form screen appears.
In the English field, add a name for the Form in English.
Add the names in other required languages.
In the Label field, add a label for the Form.
Click OK.
The Form is saved. The next step is to add elements to the Form.

Configure the Form Elements
After you create a Form, you must add elements to it. Form elements are the fields in which a Field Resource can display and
capture the required data.
1. Click Configuration > Forms & Plugins .
2. Click the stack icon and click Modify content for the Form that you want to edit.
The Visual Form Editor screen appears. Another way to open this screen is when you add the Form to a screen. If
you are configuring a screen and there is a button that is configured to open a Form, then you can use the Modify
Form content option. In this case, a new editor session is opened with the specified Form content. Ensure that you
have saved all the changes to the screen configuration before you click Modify Form content.
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3. Drag and drop the element that you want to add to the Form. For example, add a section, a text box, a check box,
or a file element.
Here are some special elements that you can add:
◦ Form Field: Adds a field such as text box, list, check box and so on, to the Form. This type of fields exist on
the Form only for presenting and gathering information. The data entered in Form fields will only be captured
in a screen shot of the Form when the Form is Submitted. This data is not stored in the application. However,
data for other fields and properties is captured as normal.
◦ Barcode/QR Scanner: Adds an icon to the Form, using which users can scan a barcode or a QR code. The
embedded scanning functionality (that is, camera) on the resource's mobile device is used to scan the code.
The results of the scan is populated automatically in the associated field. This option is available as part of the
Input element. Before using the scan option, users must ensure that the Android and iOS app that is installed
on their devices has access to the device’s camera. In Core Application, Barcode/QR scanner is displayed as
a text box.
◦ Date and Time: Adds a date, time, or date and time field to the Form. The format of data in the data and time
field is controlled by user settings. Specifically 'Time' (sudate_fid) and 'Date' (sudate_fid) user fields. The data
captured from 'Date', 'Time', and 'DateTime' components is stored and exposed through the 'formSubmitted'
event of Events API in a predefined format. Date and Time are form fields and not available for binding to a
custom property. The formats are:
- yyyy-mm-dd for 'Date'
- HH:mm for 'Time'
- yyyy-mm-dd HH:mm for 'DateTime'
Integrators must convert data into other formats, if required.
◦ Hidden value: Adds a field to:
- Include calculated values, which are not required to be displayed when the Form is filled.
- Include pre-populated values by open parameters. The values for these parameters are configured on
the Form button. When the user opens the Form, these values are populated on the Form.
- Use in other expressions, whose values will be included into the submitted Form data with the values of
all other Form elements.
4. In the Data binding section, bind the elements to appropriate entities and fields:
a. Click the pencil icon.
The Bind visual element to data source screen appears.
b. Click the drop-down list and select the entity that defines the data source.
c. In the Data field list, select the specific field, which you want to associate with the selected element.
If the Show only fields appropriate for element type check box is selected, only the fields that are
appropriate for the selected entity and the element type are displayed. If the check box is not selected and a
different type of field is selected, the element type is changed accordingly. For example, if your element type
is Input and you select Activity Type [aworktype], then the element type is changed to the one that the Activity
Type belongs to.
d. Click OK.
5. In the Visibility section, configure the visibility settings.
a. To change the visibility, click Add new. In the Access mode section, select the required visibility.
b. If you want to add any conditions to make the element visible, click the plus icon.
c. Add the required condition and click Save.
The visibility is Read-write (RW) by default.
6. In the Translations section, add the labels for the field in the required languages.
The application adds a label by default and you can change it here. You can use this label in default expressions and
in the visibility conditions of other Form items. Further, you can use this label to refer to the submitted values in APIs.
Here is the screen that shows Form elements:
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7. Click Save on the Visual Form Editor screen.
The Form elements are saved. The next step is to add the Form to a context layout through a User Type screen
configuration.

Where Can Forms Be Used
You can open Forms from these screens:
• Activity details and Inventory details: You can open Forms from the links in the action bar and buttons inside the
content.
• Activity list, Inventory list, Forms history, User options, Print route: You can call Forms from the links in the action bar.
• Dispatch console: You can open Forms from the links on the activity hint.
• Screens containing resource tree: You can call Forms from the links on the resource hint.
• Time view, List view: You can add Forms to the action menu.
Forms relate to the entities from which they are opened and submitted. In other words, if a Form is submitted in the context
of an activity, then it remains connected to the activity. Users can view Form submission results from this specific activity. The
same idea applies to inventory and resources contexts.

Add the Form to a Screen
You add a Form to a context layout screen, so that Field Resources can open and fill it.
1.
2.
3.
4.

Click Configuration > User Types .
Select the type of user for which you want to add the Form.
Click Screen configuration.
Find and click the screen to which you want to add the Form.

The Visual Form Editor screen appears.
5. Drag-and-drop the Button element to the section from where you want to invoke the Form.
6. Click the button.
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7. In the Standard action screen field, click the pencil icon and then select Custom Forms.
8. In the Screens list, select the name of the Form that you want to open and click OK.
The label of the Form is displayed in the Custom Forms field, as shown in this figure:

By default all Forms have a visibility of Read-only.
9. In the Visibility section, add the conditions based on which the Form is visible.
10. In the Parameters section, add the values that you want the Form to be populated with:
a. Click Add new.
The Add parameter screen appears.
b. Click Entity and select Form data.
The Hidden value, Date, Time, and Date and Time elements added to the Form appear in the Field name list.
c. Select an element in the Field name list.
d. In the Value field, add the value that you want to be populated for the element.
For example, let’s say you have a field by name City and you want to populate it with New York. Select City in
the Filed name list and enter New York in the Value field. Whenever a Field Resource opens the Form, New
York is populated for City. In another example, let’s say you want to populate today’s date in a Date field.
Select the Date field in the Filed name list and enter ‘today’ in the Value field. Whenever a Field Resource
opens the Form, today’s date is displayed. Similarly, enter ‘current time’ in the Value field to display the
current time in the Time field.
e. Click Save.
11. In the Translations section, add a name for the Form.
This name is displayed on the screen from which the Form will be invoked.
12. Click Save on the Visual Form Editor screen. The Form is added to the selected screen.
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Call a Form From a Button or Link
Apart from adding a link to a Form on a screen, you can add a link to open a Form from read-only screens such as the
activity hint. This serves as a short cut to open the Form.
1. Follow the procedure described in the Add the Form to a Screen topic.
Note: You can configure the fields in the Form to populate values when Field Resources open the Form.
You use the Parameters section of the Button configuration screen to pass the values that need to
be populated. Further, using the Parameters section, you can also configure all the entities to populate
values, although they are not present on the Form explicitly.

View Form Submission Results
The Forms history screen (Formerly 'Requests history') collects all the Form submission results. The Forms history screen
for an activity gives all the Form submissions for the activity. The Forms history screen for an inventory item provides all the
Forms submitted for an inventory item. Similarly, Forms history available from the Activity list and User options provides a list
of Form submission results for a specific resource.
1. Click Forms history for an activity, an inventory, or a resource.
2. Click any record.
The specific form is displayed with the values that were entered at the time of submission.
When a user submits a Form, the application stores a snapshot of the values that the user has entered. The
snapshot data remains unchanged, even if the corresponding entities and fields change later. In addition, except
for the auto-calculated default values, or values filled through predefined parameters, the remaining field values
are erased. Further, every time a user submits a Form, the application creates a formSubmitted type of event. You
can retrieve the details of individual submissions by subscribing to this event. See the REST API guide for more
information.

Lifecycle of a Form
From the time a user opens a Form on a mobile device to the time a Dispatcher views its submission results, a Form is
viewed and processed in different ways.
The lifecycle of a Form is as described here:
• A user opens a Form on a device.

◦
◦

All Form field elements, except those that have auto-calculated default values or values filled through
predefined parameters are blank.
Form elements bound to fields and properties inherit their values.

• The user fills in data and submits the Form.
• Data is stored:

◦

All submitted data is stored as a Form snapshot.
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Values of fields and properties bound to screen elements are populated and saved separately.

• Data is available to customers:
◦ On the user interface.

◦
◦

In an event of Events API.
As a Service request, if conditions match.

• User goes to step 1 if there is a need to fill the Form again.
◦ All Form field elements, except those that have auto-calculated default values or values filled through
predefined parameters are blank.
◦ Form elements bound to fields and properties inherit actual values.

Export and Import Forms
You export the contents of a Form, so that you can import it and create a similar Form.
1.
2.
3.
4.

Click Configuration > Forms & Plugins .
Find the Form that you want to export.
Click the stack icon and then click Export.
Click Save and save the file the required location.

The Form is saved in .json format.
5. To import a Form:
a. Click Add Form and add the Form details.
b. Click the stack icon and then click Import.
c. On the Import form content dialog, click Browse and select a .json file.
The file is validated and the contents of the Form are saved.

Integrate with Other Applications
Your organization may have different software applications to take care of different business aspects. You can integrate those
applications so that when an event occurs in one application, the appropriate changes are performed automatically in the
other application. You can integrate applications in two ways: through Integration Cloud Service (ICS) and through REST
APIs.
Integrating using ICS
When you use ICS, you create an integration point in Oracle Field Service Cloud. When an event occurs in Oracle Field
Service Cloud, it is sent to the appropriate application through ICS. For example, a company in the manufacturing sector
may have an ERP application to take care of their stocks. The company can integrate the ERP application with Oracle Field
Service Cloud, so that when a field technician installs or deinstalls an equipment, the stock is updated in both, Oracle Field
Service Cloud and the ERP application.
Integrating using REST APIs
Use REST APIs to integrate third-party applications such as mobile apps. To let a mobile app access REST APIs on behalf of
a user, you use the OAuth 2.0 authentication. To use OAuth 2.0 authentication, you must register the client application with
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Oracle Field Service Cloud. Then, your client application requests an access token from Oracle Field Service Cloud or other
external token service providers such as, Oracle Identity Cloud Service. The client application then sends the token to the API
that you want to access.

Integrate with ICS
Your organization may have different software applications to take care of different business aspects. You can integrate
those applications, so that when an event occurs in one application, the appropriate changes are performed automatically
in the other application. For example, a company in the manufacturing sector may have an ERP application to take care of
their stocks. The company can integrate the ERP application with Oracle Field Service Cloud, so that when a field technician
installs or deinstalls an equipment, the stock is updated in both, Oracle Field Service Cloud and the ERP application. One of
the ways with which you can integrate the applications is through Integration Cloud Service (ICS). When you use ICS, you
create an integration point in Oracle Field Service Cloud. When an event occurs in Oracle Field Service Cloud, it is sent to the
appropriate application through ICS.
Note: Configure this integration only if you want to send events or data from Oracle Field Service Cloud to ICS.
1. Log in to Oracle Field Service Cloud.
2. Click Configuration > Integration Cloud Service (ICS) .
The Integration Cloud Service (ICS) screen appears.
3. To add a new integration, follow these steps:
a. Click Add new.
The Add Integration Cloud Service (ICS) Access dialog opens.
b. Add a name or description for the application for which you are creating the integration in the End Point
Label field.
If you are using multiple instances of an application, such as Production and Testing, you can create multiple
access points for the application.
c. Add the host name of the application for which you are creating the integration in the ICS Domain field.
For example, if the URL is “https://integration-a12345.integration.us2.oraclecloud.com/integration/flowsvc/
ofsccloudadapter/NAME/v01/" then ICS Domain is: “integration-a12345.integration.us2.oraclecloud.com”.
d. Add the user name of the ICS user in the ICS Username field.
This user must exist in ICS and have permissions to access the integration endpoint.
e. Add the password for the user name in the ICS Password and Confirm Password fields.
The user name and the password are used to authenticate with ICS when Oracle Field Service Cloud starts
sending events to ICS.
f. Click Add.
The integration details appear on the Integration Cloud Service (ICS) screen. Next, you must log in to ICS
to add the connection details and map the required fields.
4. To modify an integration, follow these steps:
a. On the Integration Cloud Service (ICS) screen, click Modify for the end-point that you want to modify.
The Edit Integration Cloud Service (ICS) Access dialog opens.
b. Edit the fields as required.
You can edit all the fields, except for ICS Domain.
c. Click Submit.
5. To delete an integration, on the Integration Cloud Service (ICS) screen, click Delete.
The application stops sending events and updates to ICS.
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Integrate with REST APIs
Oracle Field Service Cloud supports OAuth 2.0 authentication for API access. Use OAuth 2.0 authentication to let third-party
applications such as a mobile app access REST APIs on behalf of a user. To use OAuth 2.0 authentication, you must register
the client application with Oracle Field Service Cloud. Then, your client application requests an access token from Oracle Field
Service Cloud or other external token service providers such as, Oracle Identity Cloud Service. The client application then
sends the token to the API that you want to access.
Oracle Field Service Cloud supports these types of token service:
• OFSC Token Service: The client application uses Oracle Field Service Token service to obtain an OAuth2 access
token and authenticate with the APIs. OFSC token service supports two types of authentication:

◦
◦

Client Credentials: Authentication using client credentials is primarily used for back-end to back-end
integration. For example, an application that requires pushing data to Oracle Field Service Cloud.
JWT Assertion: JWT assertion authentication can be used for back-end to back-end integration or for mobile
applications. The Access Token generated using assertion flow may include the user identity, and Oracle Field
Service Cloud performs actions as that user. The advantage of using assertion flow is that user's password
is not shared with Oracle Field Service Cloud. When you use this type of authentication, the public key of the
third-party application is imported into the Application entity and the third-party application can make API calls
using its private key.

• External Token Service: The client application uses an external token service such as Oracle Identity Cloud Service to
obtain an OAuth 2.0 access token and authenticate with the APIs.
• Oracle Identity Cloud Service: The client application uses Oracle Identity Cloud Service to obtain an OAuth 2.0
access token and authenticate with the REST APIs. You can upload the signing certificate for Oracle Identity Cloud
Service and then configure Oracle Identity Cloud Service to issue OAuth2 Access Tokens. See the Oracle Identity
Cloud Service documentation for information about where to get the signing certificate: https://docs.oracle.com/en/
cloud/paas/identity-cloud/index.html.
Use these details to configure Oracle Identity Cloud Service:
• Primary audience: <your Oracle Field Service Cloud instance name>. For example, ‘ofsc-x1111'
• Scope: The scope name must begin with a slash ( / ), followed by the application ID that you created in Oracle Field
Service Cloud. For example, if the application ID is 'new_app' then the Scope is '/new_app'.
After filling in these details, note down the client_id and client_secret of the application.
Integrating applications using REST APIs includes these steps:
1. Register the OAuth client application.
2. Configure the authentication.
3. Enable access to specific APIs for your application.
For more information about calling REST APIs from third-party applications, see the REST API for Field Service Cloud guide.

Create an Application
If you want to call REST or SOAP APIs from a third-party application, you must register the third-party application by adding it
on the Application screen in Oracle Field Service Cloud.
1. Click Configuration > Applications .
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The Applications screen appears.
2. Click the plus icon, add these details, and then click Submit:
Field Name

Description

Application Name

Name of the third-party application that you want to register.

Application ID

A unique ID of the application.

3. On the Applications screen, click the application that you want to register on the left pane and complete these
fields:
Field Name

Description

Application general info section
Application Name

Name of the third-party application that you want to register. This field is populated
automatically.

Application ID

A unique ID for the application. This field is populated automatically.

Active

Status of the Application. Inactive Applications don't authenticate or authorize anyone. When
you make an active Application inactive, previously-issued access tokens don't work.

Token Service

Type of token service or identity provider the Application uses. Default is OFSC.

4. Select the authentication service using these fields:
Field name

Description

Authentication settings section
Authenticate using Client ID/ Client
Secret

Select this check box to authenticate the application using client ID and client secret. Click
Show Client ID/Client secret to view the client ID and client secret.

Client ID

The client ID for the third-party application. This ID is automatically generated.

Client Secret/Show Secret

The client secret for the third-party application. This information is automatically generated.

Authenticate using JWT assertion

Select this check box to authenticate the application using JWT assertion.

Authenticate using external access
token

Select this check box to authenticate the application using an external access token. This
field is displayed if you select External for Token service.

Client Certificate/Upload

The certificate signed by the private key of the Application. If this is absent, you cannot use
OAuth2 JWT Assertion authentication. Click Upload to upload the certificate.

5. Select specific APIs for your application using these fields:
Field name

Description

API Access section
Add new

Click to add new APIs. The Add API access dialog appears. Select the APIs you want to
add and click Submit.

Available methods

The list of the API methods available for the corresponding API. Click the menu to modify the
fields or methods and to remove access to the API.

Available entities

The list of entities that the users of the current Application have access to. This option is
available only for Core API and Metadata API fields.
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Field name

Description

Available resource fields/ Available
activity fields/ Available inventory
fields/ Available service requests
fields/ Available user fields

The list of the fields available for the corresponding API. Clicking this opens the layout
structure screen, where you can select the fields that the users of the current Application
will be able to use to set or update using the API. This screen functions as a context layout
structure screen where the fields and their visibilities are set.

Remove access

Removes access to this API. Users that have access to this Application cannot use the
corresponding APIs anymore.

6. Add any access restrictions using these fields:
Field name

Description

Additional restrictions section:
Visible resources

The resources that are visible to the Application. The Application performs actions only on
the resource tree nodes that are included in this setting. If no resources are specified, the
Application has access to entire resource tree. Click the pencil icon to select the resources
that are visible to this Application.

Allow access only for certain IP
addresses

The IP addresses that can access the current application. Add the IP address in the box.

Allow Cross-origin resource sharing
(CORS) from these web domains

The white-list of domains from which you can make AJAX requests to Oracle Field Service
Cloud REST API. Enter each domain name on a separate line. these rules apply:
The maximum length of a domain names is 253 characters.

◦
◦
◦
◦
◦
◦

The maximum number of domain names you can add is 100.
No leading or trailing white space must be present in a domain name.
Wildcards or special characters are not supported.
A single asterisk “*” indicates that all domains are allowed.
Domain names that are added or modified take a few minutes to be populated across
the application.

this table describes how the Visible resources field works:
Visibility restrictions

Behavior

Empty

When a user is authenticated on behalf of this Application, their location in the resource tree
is used for visibility restrictions. The Application cannot authorize itself, it can only authorize
users.

Present

When a user is authenticated on behalf of this Application, an intersection (not union) of their
location in the resource tree and the application visibility restrictions are used for visibility
restrictions.

Activity Booking
When a technician performs an activity at the customer's premises, the customer may enquire about the possibility to
perform another job for them on a different day. The technician must be able to collect the information about the new job,
create an activity, and schedule it right away. To book an activity, the technician must also have the ability to check the
available capacity for that specific date and time. This situation is handled by the Activity Booking option in Mobility. You
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must configure the activity booking context properly to get the most accurate and precise capacity calculation. The Book
new activity option is configured in the Mobility section of the Screen Configuration screen.
Accessed via the Mobility application, the feature of allows a user to create an activity in a specified capacity bucket and time
slot, which will be then routed on a general basis. To be able to book an activity, the quota must be available in the selected
capacity bucket on the selected date and time slot for a specific capacity category. As soon as the activity is booked, the
capacity required for its performance is subtracted from the available capacity and added to the used capacity. The used
capacity is compared to the quota values to make sure that orders for new activities are accepted only when the capacity is
still available. �s having capacity information up-to-date is crucial for the functionality, Activity Booking is available only in the
online mode.

Create a Layout for Booking an Activity
Use the Book new activity option in the Application screens section of the Screen Configuration screen to create a
layout for booking an activity.
1.
2.
3.
4.

Click Configuration > User Types.
Select the user type for which you want to add a layout for booking a new activity.
In the Access settings section of the General tab, select the Allow access via web application check box.
Expand the Application screens section and click Book new activity.

The Visual Form Editor opens.
5. Drag-and-drop the fields that you want on the Book new activity screen.
You must have Activity type (aworktype) field. However, you cannot add file type of fields or properties, tabs, and the
Time slot field.
6. Select the visibility settings for all the fields.
7. Click Submit.
The layout is saved.

Activity Type Constraints
The activity booking function applies a number of constraints on certain activity types.
Some activity types determine whether at all an activity can be booked, while others affect the configuration of different
properties on the context. The list of activity types is available in the Activity Types screen. Click Configuration > Activity
Types to access the Activity Types screen. Describe only those activity type constraints and conditions that apply equally
to all the activity types that you want to be available for booking.

Time Slot Support
You must enable the Support of time slots option for each activity type that is to be considered for booking.
To select this option, click Configuration > Activity Types . On the Activity Types screen, select the type of activity that you
want to be considered for booking. Open the activity, select Support of time slots, and click Update.
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Calculate Travel
If you enable the Calculate travel feature for the activities to be booked, then the capacity calculation will additionally
consider all fields and properties in the Activity travel stats fields.
To select the Calculate travel feature, click Configuration > Activity Types . On the Activity Types screen, open the
activity type for which you want to add the feature. Select the Calculate travel check box and click Update. When you
select this feature, you must add all the fields that you have selected for the Activity travel stats fields in the Statistics
screen to the Book new activity context layout and set the visibility as Mandatory.

Calculate Activity Duration
If you enable the Calculate activity duration using statistics feature for the activities to be booked, then the capacity
calculation will additionally consider all fields and properties in the Activity duration stats fields.
To select the Calculate activity duration using statistics feature, click Configuration > Activity Types . On the Activity
Types screen, open the activity type for which you want to add the feature. Select the Calculate activity duration using
statistics check box and click Update. When you select this feature, you must add all the fields that you have selected for
the Activity duration stats fields field in the Statistics screen to the Book new activity context layout and set the visibility
as Mandatory.

Enable Work Zone Support
You must enable work zone support for booking activities. If you have enabled work zones support, at both, the company
level and the activity level for the corresponding activity types, all fields from the work zone key are considered for capacity
calculation.
To enable work zone support at the company level, click Configuration > Business Rules . Select Work Zone support
in the General section. To select this option at the activity level, click Configuration > Activity Types . On the Activity
Types screen, select the type of activity that you want to be considered for booking. Open the activity, select Support of
work zones, and click Update. Click Configuration > Work Zones and note down the field selected for Work Zone Key.
Add this field with a Mandatory visibility in the Book new activity context layout.

Enable Work Skill Support
You must enable work skill support for booking activities. If you have enabled work skill support, at both, the company level
and the activity level for the corresponding activity types, all fields from the work skill conditions are considered for capacity
calculation.
To enable work skill support at the company level, click Configuration > Business Rules . Select Work Skill support
in the General section. To select this option at the activity level, click Configuration > Activity Types . On the Activity
Types screen, select the type of activity that you want to be considered for booking. Open the activity, select Support of
work skills, and click Update. Click Configuration > Work Skills and click Work skill conditions. Open the work
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skill that you want to be considered for booking and note down the work skill conditions. Add these field with a Mandatory
visibility in the Book new activity context layout.

Time Slot Screen Configuration
The Schedule booked activity context defines the layout of the Time Slot screen. While the time slot selection widget is
pre-configured and cannot be changed, all other details of the booked activity can be specified in the Schedule booked
activity context.
these restrictions apply to the context configuration:
• You can add only read-only visibility condition for activities or properties on the context layout.
• You cannot create tabs in the Schedule booked activity context.
Otherwise, there are no special constraints, as opposed to the Book new activity context. The Schedule booked activity
context is available in the Mobility section of the Screen Configuration screen.

Activity Booking Error Messages
This section provides the list of possible errors and the corresponding messages the user may encounter while booking
activities.

Missing Context Error
If at least one of the two contexts ('Book new activity', 'Schedule booked activity') is not added before using the Activity
Booking functionality, the message: Form is misconfigured. Context layout missing appears. Depending on which context is
missing, the error is shown so, you can access the corresponding screens.

Validation Errors
If any of the mandatory fields is empty on the booking activity contexts ('Book new activity', 'Schedule booked activity'), the
validation message, Validation failed, please review your form is shown. If a time slot has not been selected on the Time Slot
screen, the activity is not booked and the message, Validation failed, please review your form. Time slot is not selected is
displayed.

Capacity Calculation Errors
Capacity is not calculated in these cases:
• Data entered in the previous step (creating booked activity) is insufficient.
• A configuration has not been properly performed.
• There is no available capacity that matches with the activity parameters.
The possible error messages that may occur at the capacity calculation stage, that is after submitting information entered in
the booking activity form are as follows:
• Work skills support is disabled at the company level.
• Work skills are not supported by this type of activity.
• Capacity category cannot be determined using the given activity fields.
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• The selected activity type is inactive.
• Work zone cannot be determined by the given activity fields.
• Field or property that is required for work zone 'location' value calculation is missing.
• Time slots are not supported by this type of activity.
• Field or property that is required for the duration estimation is missing.
• Field or property required for travel estimation is missing.
• The matching buckets found don't have the required quota for booking this activity.
• Unable to find appropriate quota bucket for this activity.

User Types
Use user types to manage permissions and restrictions for all users. You can create user types for your business that
correspond to your existing business roles. Each user type has a profile that defines security and display permissions, such as
the user’s login method, the ability to use certain functions, and access to menu items and properties. They may also include
custom screen context layouts.
You assign each user exactly one user type. You can add or change user types at any time, and delete those which are no
longer needed. You can also copy existing user type configurations to make new ones. This makes it easy to create multiple
user types that share similar configuration settings.
For each screen or function that you want to make available for a given user type, you set the visibility to Read-only or
Read-write. If you don't define a visibility value, that screen or function is hidden for that user type. Access to a screen or tab
automatically includes access to the actions on that screen.

User-Type Settings
A new user type has to be configured according to its business role. Similarly, alterations of a business role may require
modifications of the corresponding user-type settings.
Changes to a user type assigned to Oracle Field Service Core Manage Cloud Service users are applied shortly after they are
saved on the User Types screen. Changes to a user type assigned to Oracle Field Service Mobility Cloud Service users are
applied after the next synchronization.
User-type settings fall into these four categories, which appear as tabs:
• General
These basic settings define the user-type options with respect to resource types and other users, as well as the
user-type access to the system and to its functions.
• Screen configuration
These settings define the screens, windows, pop-up windows and other elements visible to a certain user type and
supports the context layout editor where the content, arrangement and visibilities of each context are set.
• Restrictions and Filters
These settings define the restrictions on the activities and fields that are visible to the users of the current type.

97

Oracle Field Service Cloud

Chapter 1

Administering Oracle Field Service Cloud

Configure Oracle Field Service Cloud

General Tab Settings
this table describes the fields available on the General tab:
Setting

Description

Notes

Label

A unique identifier of the user type.

Required. No spaces are allowed.

Name

A user-friendly name that describes the user
type.

Required. Spaces are allowed.

Active

Indicates whether the user type is active.

Activating a user type simply makes it
assignable to users. Inactive user types still
apply to users that are assigned to them.

Login Policy

Defines the user authentication method to
Oracle Field Service Cloud

Assigned resource types

Shows the resource types available for this
user type.

To change the assigned resource types,
click the pencil icon. You cannot remove
a resource type if any users are currently
assigned to this user type.

Can create users of these user types

Lists the user types that this user type can
create.

Inactive user types are greyed out and
cannot be created by this user type.

User Type Info

Permission to create user types is reciprocal.
For example, if user type Manager can create
user type Dispatcher, user type Dispatcher
can create user type Manager.
To change the user types this user type can
create, click the pencil icon.
Can be created by users of following user
types

Lists the user types that can create the
current user type.

Inactive user types are greyed out.
Permission to create user types is reciprocal.
For example, if user type Manager can create
user type Dispatcher, user type Dispatcher
can create user type Manager.

Access Settings
Allow access to web application

When enabled, users of the current type can
use the unified Core Application to manage
dispatch operations.

Use Legacy Manage for Dispatch operations

When enabled, users of the current type
can use the legacy Manage and Mobility
interfaces, as it used to be in the earlier
versions. However, even those users will be
presented with the unified login screen.

This functionality is deprecated and is not
recommended for new implementations.
Note: If you have cleared the previous
check box and want to clear this
check box as well, ensure that you
have configured the Configuration
screen for Mobility and the User Types
screen for any other User Type. If you
have not configured these screens,
you cannot get back the access to
Legacy Manage.
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Setting

Description

Allow access via installed application for
Android

When enabled, users can access the
application through the Oracle Field Service
Cloud Mobile for Android application.

Allow access via installed application for iOS

When enabled, users can access the
application through the Oracle Field Service
Cloud Mobile for iOS application.

API access permissions are configured using
selected application

Select the Application that provides API
permissions to the users of the selected user
type.

Notes

Create an Application and configure API
permissions in the Applications screen.

Permissions
Maps

When enabled, the user can access the
Map View on the Activities, Quota, and
Resource Work Zones screens.

Use real-time traffic data

When enabled, the check box, Show Traffic
is shown on the Map view. Users can select
the Show Traffic check box to view the
current traffic data in the selected route.

Enable GPS Telemetry

When enabled, the user's geopositioning
information can be collected directly from the
user's device.

Allow access to required inventory

When enabled, the Mobility user is able to
access the Required inventory functionality
and perform all related actions.

Enable Smart Location alerts

When enabled, the user can receive alerts on
their mobile device whenever any compliance
issues have occurred and have been
identified by the SmartLocation module.

Parts Catalog

When enabled, the user can search for
particular spare parts in the catalog using the
standard search function.

This option is not available for Contingent
Workers (set as ‘Resource is a Contingent
Worker’ parameter in Manage, under
Configuration, and Resource Types).
The real-time update is available to users of
Oracle Field Service Enterprise Cloud when
Oracle Field Service Standard Map Cloud
Service with Google Maps or Baidu Maps is
part of your subscription.

The Required Inventory permission for
Manage is implemented as visibility for the
Required Inventory tab in the Add activity
or Activity details context.

Collaboration
Collaboration

Select the check box to view the
collaboration settings.

Allow inventory move via chat

In addition to chat functions, allows the user
to transfer inventory via chat.

Allow image sharing via chat

In addition to chat functions, allows the user
to share images via chat.

Allow activity move via chat

In addition to chat functions, allows the user
to transfer activities via chat.

Activity Management
Allow activity move between resources

When enabled, the user can move an activity
from one resource to another
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Setting

Description

Allow activity move from non-scheduled pool
to scheduled one

When enabled, the user can convert a nonscheduled activity to one that is scheduled.

Allow access to non-scheduled pool

When enabled, the user can access the
pool of non-scheduled activities and perform
actions to them.

Allow activity reorder inside the route

When enabled, the user can change the
position of an activity in the route.

Allow activity reschedule/move to nonscheduled pool

When enabled, the user can move an activity
to a different date or make it non-scheduled.

Allow activity deletion

When enabled, the user can delete an activity
together with canceling it. Otherwise, a
canceled activity remains in the system.

Ignore work zones/work skills mismatch on
activity move

When enabled, the user can move activities
to resources with work zones and/or work
skills not matching those of the activity.

Allow repeating/mass activity creation

When enabled, the user can create mass and
repeating activities.

Allow action time adjustment in legacy
Manage

When enabled, the user can manually adjust
the time of activity actions in the legacy
Manage application. Otherwise, the action
time is logged as the current time.

Display the remaining Activity Time

When enabled, the activity work progress
countdown is displayed.

Allow next activity selection on Complete

When enabled, the user completing an
activity can select the next activity to start.
Otherwise, only the next activity in the route
can be started.

Display and allow adjustment of remaining
Travel Time

When enabled, the Travel Time Countdown is
displayed and the user can adjust travel time
in Mobility. Available values are: 5, 10, 15, 30,
45 minutes, 1 hour, 1 hour and 30 minutes,
2, 3, 4 and 8 hours.

Suggest activity by location

When enabled, displays the number of
activities that are assigned in the same
location for a technician. This information
is displayed above the Start button on the
Resource Info screen.

Notes

The distance within which a location falls is
determined by the Resource is considered
to be at the activity location if the
distance to it is less than X meters setting
in the SmartLocation/GPS section on the
Business Rules screen.

Resource Management
Allow changes in working calendar

When enabled, the user can modify the
working calendar of the resource.

Allow to move resources between
Organization Units

When enabled, the user can move the
resources to different organizations in the
resource tree.

Screen Configuration Tab
this table describes the fields available on the Screen Configuration tab:
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Setting

Description

Application screens

Includes the contexts used in the Core
Application.

Legacy Manage

Includes the contexts used in the legacy Core
Manage.

Collaboration and Identifiers

Includes the contexts used in Collaboration
and the entity identifier contexts.

Plugin API

Includes the plug-ins used with activity,
inventory, and resource properties. This
context layout is deprecated with release
19A. Use the Forms & Plugins screen to
configure new plug-ins and migrate the
existing plug-ins. When you finish migrating
all the plug-ins, the Plugin API section will be
removed.

Notes

Restrictions and Filters Tab
these table describes the fields available on the Restrictions and Filters tab:
Setting

Description

Hide all activities

Determines if the users will or will not be able
to access any activities in the system after a
certain time. When enabled, the administrator
also has to set the time after which the
activities are to be hidden.

Hide activity fields

Determines if the users will or will not be able
to access certain activity fields after a certain
time. The fields to be hidden are defined in
the Field restrictions context accessible
by clicking the Activity fields link. When
enabled, the administrator also has to set the
time after which the activity fields are to be
hidden.

Filters restricting visible activities

Defines whether the users of the current
type will be able to view the entire routes
or only some activities. Setting the visibility
restrictions requires proper configuration of
the applicable filters.

Notes

Screen Configuration Settings
Screen configuration settings define the screens, windows, pop-up windows and other elements visible to a certain user type.
They also support the context layout editor, in which the content, arrangement, and visibilities of each context are set.
The Screen configuration tab contains the list of all contexts available in Oracle Field Service Cloud. All contexts are split
into three sections that correspond to their location in the system:
• Application screens: The contexts used in Core Application.
• Legacy Manage: The contexts used in the legacy Oracle Field Service Core Manage Cloud Service.
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• Collaboration and Identifiers: The contexts used in Oracle Field Service Collaboration Cloud Service and the entity
identifier contexts.
The Screen configuration tab is active when the Allow access to web application option is enabled for the user
type. The same settings also influence the availability of the screen configuration sections. If the Allow access to web
application option is disabled for the user type, the Application screens section will be collapsed and inactive.
The list of settings is organized hierarchically and shows the relationships between different contexts. All context names are
links to the context layout editor screens. This figure shows the Screen configuration tab:

Note: Any screen configuration settings made in the Application screens section are retained if the Allow
access to web application option is disabled afterwards for the user type. If access is allowed again, the same
screen configuration settings apply again for the user type.
Links to new (not edited) or empty contexts are shown in red, while links to edited contexts are shown in blue. If you remove
all elements from a context, its link color changes from blue to red to indicate that the context is now empty. If you create a
user type without copying the settings of another user type, all contexts are shown in red. When configuring screens for a
user type, the Context layout structure page provides an indicator to show that a property is configured. When you add
an item to the Layout structure column of the page, it appears in red until you add visibility to the field. After you define a
visibility for the item, it is no longer highlighted in the Layout structure column.
Note: You can add or remove the Collaboration Group and Operator of Helpdesk properties from the context
layout structure of the Add/Edit User context for each user type. After you update the properties in the Add/
Edit User context, select a user from the Resource Settings, Users screen and click Modify to view the
updated properties.
The hierarchy of contexts starts from the Main menu items context defining the main menu items available or unavailable for
the current user type. The configuration of the Main menu items context defines the menu bar elements visible or hidden
for a particular user type. Each menu bar element opens a certain screen and, therefore, provides access to its functionality.
If a certain screen has been made available for a user type, all users of such type will have access to the entire functionality
implemented on that screen. Similarly, if a screen has been made unavailable for a user type, all users of such type will not be
able to use the functionality implemented on that screen.
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Changing the visibility of the Message Scenarios menu item to Read-write allows the user to view and edit all elements of
a message scenario. With the Read-only visibility, they can only view them. these figure shows the Settings tab of the View
scenarios step, which was set as read-only in the Screen Configuration screen:

The links to contexts are connected with arrows showing the relation between the contexts. Hovering the mouse over an
arrow highlights it in red for better visibility. This figure shows a highlighted arrow, which means you are hovering the mouse
over that arrow:

Click a link to open the Context layout structure screen and define the fields and actions of the context, and their visibilities
for the user type. You can copy a context layout to another user type if the other user type uses the same or slightly modified
layout of the same screen or window. For this purpose, the Context layout structure screen has the Copy to button, which
opens the list of all user types in the system.
For the form type contexts, the link leads to the Visual Form Editor screen, allowing the user to edit context layouts in an
easier and more transparent manner. You can delete the default Read/Write visibility on the sections and tabs in the Visual
Form Editor. Additionally, Read/Write visibility is not added after migration. When the visibility condition for a property is
mandatory and the property value is cleared, the value is set to null and the visibility is selected.
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If the screen configuration of the current user type is shared with one or more other user types, such user types will be
preselected in the Copy to list. If the user type selected in the list shares its screen configuration with other user types, such
user types will be automatically selected as well. The current context layout will be applied to the selected user types. In this
case it replaces the previous context layout settings, if any.
When a context layout is copied for another user type, only the current context is copied while the rest of the screen
configuration remains unchanged. When a context layout is copied, two separate identical context layouts are created. Each
layout can be edited independently causing no changes in the other one. However, if the destination screen configuration is
shared with other user types, the current context layout will be copied to all user types sharing the same screen configuration.
Context layout copying is confirmed with the message, Layout has been successfully copied. Closing the Context layout
structure screen returns the user to the User types screen.
The Collaboration and Identifiers section contains the contexts falling under two groups:
• Identifiers: Includes the identifier contexts for activity, inventory and service request
• Collaboration: Includes all contexts related to the Collaboration module, as shown in this figure:

Note: Text formatting such as modifying the text size, bold/non-bold, italic, or coloring or properties is not
supported.
If the user type is created as a copy of another user type and the screen configuration is shared, the message, Screen
configuration shared with: {User type} displays on the Screen configuration tab. When the screen configuration is shared
with another user type, the same set of settings is used for both user types, and both user types refer to them simultaneously.
A shared screen configuration means that all context layouts and their visibilities are similar for all user types sharing them. If
the screen configuration is modified for one of the user types, the same changes will immediately apply to all other user types
sharing it.
The Copy or share screen configuration link allows selecting a different source of the screen configuration for the current
user type. In this case the current user type is dissociated from the shared screen configuration. Three options are available:
• Use Screen configuration of {User Type}: The screen configuration is shared with one or more user types. Only
one set of configuration settings exists, and any changes of the screen configuration of one of the user types causes
similar changes of the screen configuration of other user types. In this case sharing is inherited, that is, if the user
type selected for sharing already shares its screen configuration with other user types, the same screen configuration
will be used for all of them. The note underneath advises the user about the user types sharing the same screen
configuration.
• Create Screen configuration as copy of {User Type}: the screen configuration is copied from another user type.
In this case two independent sets of settings are created, and any changes apply only to the user type for which they
are made. The note underneath advises the user about the user type whose screen configuration will be copied.
• Create empty Screen configuration: The current screen configuration is cleared. Only the settings of the current
user type are cleared. If the screen configuration had been shared with or copied from another user type previously,
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it is disconnected and a new independent screen configuration is created. The note underneath advises the user that
only the screen configuration of the current user type will be cleared.
If a user type has an independent screen configuration, it can be replaced with another by sharing or copying the screen
configuration of another user type. All user types with screen configurations not related to those of other user types have the
Copy/share screen configuration link. This link leads to the same screen configuration options as are offered for changing
the current screen configuration. However, as the current screen configuration is not used elsewhere in the system, selecting
any option will remove it permanently. The note warns the administrator that the current configuration will be lost.

Configure Header Icons
The application includes two distinct themes—a classic style and a modern style. The modern style theme is called Vanilla
and it displays icons in the header region for the most frequently accessed screens. It has a menu to the left of the screen,
which provides access to the remaining screens. The classic style theme displays tabs with text. these image shows the
Vanilla theme user interface with the left pane, hamburger icon, and the header regions marked 1, 2, and 3 respectively:

This topic describes how to configure the header.
1.
2.
3.
4.

Click Configuration > Themes. .
Click Set default in the Vanilla theme row.
Click Configuration > User Types .
Select the user type that you want to modify (you can also select the one that you are using). Click Screen
configuration.
5. Click Main menu items.
The Context layout structure screen appears.
6. In the Dispatch section, reorder the menu items as required.
The first item in the list becomes the Home page and gets the Home icon. The application displays only four icons
before the ‘|’ marker, regardless of the number of items you place in the Dispatch section.
7. Click Close and refresh the browser.
The newly configured theme and the icons appear.

Configure the Main Menu
You can configure the main menu using the Main Menu context layout structure. The configuration affects the Supervisor
view. The Manage, Maps, Calendars, and Resources menus are pre-configured for this layout and are available by default.
1. Log in to the application.
2. Click Configuration > User Types .
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3. Select a User Type for which you want to add the main menu. Click Screen configuration.
4. Click Application screens > Main menu .
The context layout structure screen appears.
5. Click the Click to add button and add any item that you want to display on the main menu.
New layout items are available as Read-Only.
6. Click X at the top-right corner.
7. Sign out and sign in to the application.
The newly configured main menu appears.

Edit the Context Layout Screen
Use the Context Layout Screen to configure the fields that appear on the application screens.
1. Click Configuration > User Types .
The User Types screen appears.
2. In the left pane, select the user type for which you want to edit the context layout.
3. Click Screen Configuration.
4. Expand Application screens, Legacy Manage, Collaboration and Identifiers, or Plugin API. For example, click
Application screens.
5. Click the screen for which you want to edit the context layout. For example, click Add activity/Activity details.
The Context layout structure for the selected screen and the selected user type opens. On this screen, you
can add or edit properties, actions, tabs, columns, and sections. Properties appear as fields and actions appear
as buttons. Tabs, columns, and sections define the structure of the layout. You can also configure visibilities to
properties and define the conditions under which the visibility settings are effective.
6. Follow these steps to add a property:
a. Click the Click to add button.
The Add property dialog appears.
b. Select the property that you want to add and click OK.
7. Follow these steps to configure the visibility for the newly added property:
a. Click Add new visibility.
The [property name] visibility screen appears.
b. Select the access mode.
c. To add a condition for visibility, click Add new condition.
The corresponding fields appear.
d. Select a property, select the condition, select the additional condition if available, and then click the tick mark.
For example, the condition can be equal, not in, empty, and so on. If you have selected the property as
activity status and the condition as equal, the additional condition can be suspended and pending.
8. Follow these steps to add an action:
a. Click the Click to add button under Actions.
The Add action dialog appears.
b. Select the action that you want to add and click OK.
After adding the action, set visibility for it. Visibility is not set by default, so you must configure it for every field
and action that you add.
9. Follow these steps to add a tab:
a. Click a property and click Group.
The Add to group dialog appears.
b. Enter the name of the group.
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c. Select one of these options and then click OK:
Option

Description

Section

Select this option to start a new section or block.

Tab

Select this option to start a new tab with the name provided earlier.

Predefined tab

Select this option to include a predefined tab. Select the tab from the Tab type dropdown list. Predefined tabs are the tabs available in the application by default.

10. Follow these steps to add a column or section:
a. Select a property or an action and click Add marker.
b. In the Add marker dialog, select End of column or End of section.
c. Click OK.

Visual Form Editor
The Visual Form Editor is used to configure context layouts in the Mobility application for each user type. After configuring the
context layout, you must select the Allow access to web application check box for each user type to view the context in
the application.
The editor enables you to configure these entities, when available, for each form:
• Fields: Displays properties that are relevant for the selected context or that belong to a specific entity.
• Actions: Displays actions that are relevant for the selected context or that belong to a specific entity.
• Special elements: these options are available:
◦ Add Text: Enables you to add text to the section of a form.

◦

Section and Tab: Contains the selected fields and actions from the Fields and Actions objects.

You can define Visibility settings for each object of the form. Values with identical visibility settings are grouped and the
grouping happens after the settings are saved. Also, using the Translations section, you can translate the text that displays
on each object to any of the supported languages.
By default, the Visual form editor displays these elements:
• Header: Displays the selected actions from the Actions object.
• Footer: Contains the default Dismiss and Submit buttons for a form. You can only define visibility settings for the
Submit button.
• Submit and Dismiss buttons: Indicates the button that is visible for all forms.

Default Values and Validation Rules
You can configure string and integer fields to include default values and validation rules. This helps when your business needs
some fields to be populated by default and some fields to be calculated automatically, based on the value of another field.
The fields that you configure here are applicable only to Oracle Field Service Mobility Cloud Service. Further, this function is
allowed only for `string`, `int` and `enum` custom properties.
You can configure the fields and properties in these ways:
• Add a default value: A default value is an auto-calculated value of a field or property. This value is based on certain
business rules and is dependent on the values of other fields and properties. The default value is represented as
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formula filled in the corresponding configuration field. For example, when a property is filled with a specific value,
another property is filled with the current date or time.
• Add a validation rule: A validation rule is a restriction based on certain business rules and is dependent on the values
of other fields and properties. A validation rule is represented as a formula filled in the corresponding configuration
field. For example, the value entered for a property (property A) falls within a specific range (between values of
property B and property C).
• Use a formula for configuring the visibility and the value visibility: The formula is based on certain business rules and
is dependent on the values of other fields and properties. The formula for the visibility of the field and its value must
be filled in the corresponding configuration field. It's possible to transform an existing visibility configured through a
constructor to a formula. The application uses this formula for calculating visibility as the primary path and visibility
from the constructor as the secondary path.
Note:
• If a default expression is configured with an empty value for a read-only field or property, it will NOT be
hidden on the screen. This means, the user will see the field or property name on the screen, but it will
not have any value.
• For read-only fields, default values take priority over calculated values.

Auto-Generated and Auto-Calculated Fields
Auto-generated and auto-calculated fields can have a visibility of Read-Only. Regardless of the configured visibility, the
application displays such fields as Read-Only. Further, such fields are not available for selection on the Context Layout
Structure screen of add screens such as, 'Add activity' and 'Add inventory'. The fields that can be set only as read-only are
as given in these table:
Entity

Field

Description

ACTIVITY

ETA

Estimated time of arrival

acoord_status

Coordinate status

acoord_x

Coordinate X

acoord_y

Coordinate Y

activity_alerts

Activity alert

activity_capacity_categories

Activity capacity categories

activity_compliance

Activity compliance

activity_workskills

Activity work skills

aid

Activity ID

astatus

Activity status

atravelarea

Travel area

atype

Activity Type

auto_routed_to_date

Auto-routed to date

auto_routed_to_provider_id

Auto-routed to Provider ID

auto_routed_to_provider_name

Auto-routed to Provider name
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Field

Description

aworkzone

Work Zone

date

Date

delivery_window

Delivery window

end_time eta_end_time

Estimated end time

first_manual_operation

First manual operation

first_manual_operation_interface

First manual operation (interface)

first_manual_operation_user_id

First manual operation (user ID)

first_manual_operation_user_login

First manual operation (login)

first_manual_operation_user_name

First manual operation (user name)

service_window

Service window

time_delivered

Time of delivery

inv_aid

Activity Id

inv_change_invid

Changed Inventory ID

inv_pid

Resource Id

invid

Inventory Id

invpool

Inventory pool

required_available_quantity

Quantity in Resource Pool

required_model

Model

required_quantity

Quantity

required_type

Type

appt_ident

Activity

srcreated

Created

srdate

Date

srid Id

Request Id

sr_aid

Activity

sr_invid

Inventory Id

sr_pid

Resource Id

sr_uid

User Id

uname

User

alerts

(always hidden)

calendar

Calendar

oncall_calendar

On-call calendar

pcapacity_bucket

Capacity area

pending

Pending activity
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Field

Description

pid

ID

pinitial_ratio

Initial ratio for activity duration

p_rprid

Routing profile ID

queue_status

Queue status

reactivated

Reactivated

resource_capacity_categories

Capacity categories

resource_effective_workskills

Effective work skills

resource_time_slots

Time slots

resource_workskills

Work skills

resource_workzones

Work zones

skip_days_for_stats

Working days left for reported data to start
impacting duration estimation

total

Total

pcolor

(always hidden)

last_login

Last login

last_password_change

Last password change

login_attempts

Login attempts

login_blocked_to

Login blocked to

main_resource_id

Main resource ID

mobile_activity_count

Mobile activity count

mobile_inventory_count

Mobile inventory count

mobile_provider_count

Mobile provider count

show_placeholder_id

Show placeholder ID

sucreated

Registered

sustatus

Status

suupdated

Updated

uid

User ID

Limitations
these limitations exist for default values and validation rules:
• Work skills and work zones are not supported for default values and validation rules.
• Custom properties with the "Geolocation element" GUI is not supported for default values and validation rules.
• these limitations are applied to the configuration of expressions:
◦ 2000 characters for configuring default values

◦

2000 characters for configuring validation rules
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4950 characters for configuring visibility as an expression

Supported Screens
You can configure default values and validation rules only on these Activity and Inventory screens for Oracle Field Service
Mobility Cloud Service:
Screen

Label

Edit/View activity

mobile_activity_details

Cancel activity

mobile_cancel_activity

Delay activity

mobile_delay_activity

End activity

mobile_end_activity

End prework

mobile_end_prework

Not done activity

mobile_notdone_activity

Add activity

mobile_set_activity

Start activity

mobile_start_activity

Start prework

mobile_start_prework

Suspend activity

mobile_suspend_activity

Add/Details inventory

mobile_add_details_inventory

Deinstall inventory

mobile_deinstall_inventory

Install inventory

mobile_install_inventory

Send/View activity request

mobile_activity_request

Add/View inventory request

mobile_inventory_request

Add/View resource request

mobile_provider_request

Edit Required Inventory

mobile_add_edit_required_inventory

Supported Fields
You can configure default values and validation rules only on these fields:
Property name

Property label

Type

Entity

GUI

Account Number

customer_number

field

activity

text

Activity Type

aworktype

field

activity

combobox

Address

caddress

field

activity

text

Appointment Number

appt_number

field

activity

text

City

ccity

field

activity

text

Customer Email

cemail

field

activity

email

Customer Mobile Number

ccell

field

activity

phone
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Property name

Property label

Type

Entity

GUI

Customer Phone Number

cphone

field

activity

phone

Duration

length

field

activity

text

Inventory Type

invtype

field

inventory

combobox

Name

cname

field

activity

text

Points

apoints

field

activity

text

Quantity

quantity

field

inventory

text

Serial Number

invsn

field

inventory

text

Service Request Type

srtype

field

service request

combobox

State

cstate

field

activity

text

Time Slot

time_slot

field

activity

text

ZIP/Postal Code

czip

field

activity

text

Calculation Order
The result of a configured expression is calculated in these order:
1.
2.
3.
4.
5.
6.
7.
8.

Value (Number, String, variable, function, expressing in round brackets)
Special operators (BETWEEN, IN, CONTAINS)
Unary operators (NOT, -)
Multiplicative operators (*, /)
Additive operators (+, -)
Comparison operators (=, <>, <, >, <=, >=)
Logical operator AND
Logical operator OR

Configure Default Values and Validation Rules
When you configure fields on the Visual Form Editor, you can add a default value or a validation rule for fields and
properties. You can also use formulas to configure visibility and visibility value.
1.
2.
3.
4.
5.

Click Configuration.
Click User Types in the Users, Security, Integration section.
Click Screen configuration.
Expand the Application screens section and click the screen that you want to modify.
Select the field for which you want to add a default value or a validation rule. If the field is not added to the context
layout, drag it from the left pane and drop it in the right pane.

By default, the field is assigned with a visibility of Read-Write (RW).
6. Follow these steps to change the default visibility:
a. Click Add New in the Visibility section.
The Visibility settings dialog appears.
b. Select the required option in the Access mode section.
c. If you want to change the visibility based on a condition, add it in the Conditions section.
You can add a formula to determine the condition for visibility. The conditions entered here are given priority
over the visibility inherited by the field or property.
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Note: When setting up the visibility for a specific property, you cannot create a visibility condition
based on the property itself. For example, suppose that you want to set up the visibility of the
property "City" as Read Write. You cannot set up a condition such as "City contains New York".
Further, ensure that there are no circular dependencies. For example, the Customer Name field is
displayed if the Customer Address field is filled and the Customer Address field is displayed if the
Customer Name field is filled. Although the application does not display an error message when you
configure such fields, the screen on which the fields appear may not work properly.
d. Click Show conditions as formula to view the conditions as a formula.
These rules apply to showing conditions as formula:
- If you click Show conditions as formula, the standard conditions constructor hides and a text area
appears containing the auto-generated formula of the conditions.
- If you don’t change the auto-generated formula, the formula is not saved. Show conditions as list is
shown, so you can switch back.
- If you change the formula and it differs from the auto-generated content, Show conditions as list is
disabled.
- If you change the formula and save the changes, the next time this dialog opens with the formula
without the Show conditions as list link.
7. Follow these steps to add a default value or a validation rule:
a. Expand the Default value and validation section.
b. Enter a value in the Default value field.
c. Enter a validation for the value in the Validation field.
You can use arithmetic operators, comparison operators, or functions to form the validation rule.
8. Click Save.
The details are saved and enforced when a user edits the corresponding screen the next time.

Language Expressions
The language containing operators and functions is used for configuring default values, validation rules, and visibility of fields
and properties.
The language is described in this table:
Argument

Description

Usage Pattern

Use in
Default rules

Validation
rules

Visibility

Variables, entities, and properties
this

Value of current element

this > 100

No

Yes

No

entity.property
entity.`label`

Value of property of entity. Use for
wrapping labels with spaces.

activity.aworktype = 1

Yes

Yes

Yes

White spaces and comments
[space], [tab], [line
break]

Assuming multiple white spaces
as single space. Assuming white
space as separator.

this + 100

Yes

Yes

Yes

/* Any comment */

Assuming comment block as single
white space.

activity.PROP_A1 > 77 /* 77
- is predefined parameter */

Yes

Yes

Yes

Logical operators (case sensitive, operands will be converted to Boolean)
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Description

Usage Pattern

Use in

OR

Logical disjunction

a OR b

Yes

Yes

Yes

AND

Logical conjunction

a AND b

Yes

Yes

Yes

NOT

Logical not (operand will be
converted to Boolean)

NOT (a AND b)

Yes

Yes

Yes

—

Arithmetic inversion (operand will
be converted to Number)

- activity.PROP_A1
this * (- activity.PROP_A2)

Yes

Yes

Yes

Unary operators

Equal Comparison Operators (case sensitive for Strings). Operands will be converted to String
=

Equal to

a=b

Yes

Yes

Yes

<>

Not equal

a <> b

Yes

Yes

Yes

Comparison Operators (case sensitive for Strings). Use toNumber() for arguments if number comparison is needed.
<

Less than

a<b

Yes

Yes

Yes

>

Greater than

a>b

Yes

Yes

Yes

<=

Less than or equal to

a <= b

Yes

Yes

Yes

>=

Greater than or equal to

a >= b

Yes

Yes

Yes

Arithmetic Operators (all operands will be converted to Number, any arithmetic operation with Infinity/NaN returns Infinity/NaN)
+

Addition

a+b

Yes

Yes

Yes

-

Subtraction

a—b

Yes

Yes

Yes

*

Multiplication

a*b

Yes

Yes

Yes

/

Division
Division by zero: Division by zero
returns infinity, which will be
converted to "" (empty string).

a/b

Yes

Yes

Yes

this CONTAINS "A0"
activity.PROP_A1
CONTAINS concat("-", this)

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Additional Operators (case sensitive)
string CONTAINS
needle

Return true if `string` contains
`needle` (operands will be converted
to String)

NOT activity.PROP_A2
CONTAINS
activity.PROP_A3
value IN (value1[,
value2, [, valueN]])
maximum 1000
arguments

Returns true if `value` is equal to
any `value1`...`valueN` (value will be
converted to String)

this IN (1, 2, 3, 4)
activity.PROP_A1 IN
("value1", "value2")
NOT activity.PROP_A2 IN
("value1")

value BETWEEN
(min, max)

Returns true if `value` is equal to
`min`, equal to `max` or between
them. The same as: value >= min

1 BETWEEN (0, 100)
NOT 200 BETWEEN (99,
100)
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Description

Usage Pattern

Use in

AND value <= max (operands will
be converted to Number)
Functions (case sensitive)
if(condition, value1,
value2)

Function which returns value1
argument if condition is true and
value2 argument if condition is
false (condition will be converted to
Boolean)

if(activity.PROP_A1 > 0, 1,
0)

Yes

No

No

now(string)

Returns current date in required
format. View corresponding section
for details

now("yyyy-MM-dd
HH:mm:ss")

Yes

No

No

toNumber(value)

Formatting object to required
number format

toNumber(activity.PROP_A1)
toNumber("123.45")

Yes

Yes

Yes

toString(value)

Formatting object to string

toString(activity.PROP_A1)
toString(123.45)

Yes

Yes

Yes

concat(string1,
string2 [... ,stringN]])
maximum 20
arguments

Concatenate strings (all operands
will be converted to String)

concat(this, "#",
activity.PROP_A1)

Yes

Yes

Yes

toLowerCase(string)

String to lower case (operand will
be converted to String)

toLowerCase(activity.PROP_A1) Yes

Yes

Yes

toUpperCase(string)

String to upper case (operand will
be converted to String)

toUpperCase(activity.PROP_A1) Yes

Yes

Yes

empty(value)

Returns true if `value` is undefined
or empty string or NaN or Boolean,
false in all other cases

empty(activity.PROP_A1)
NOT
empty(activity.PROP_A2)

Yes

Yes

Yes

Data Type Conversion
this table describes the types of data used for validation rules and the way the application converts them:

Number

Number

String

Boolean

NaN

Infinity

Undefined

NA

123 = “123”
1.5 >= “1.5”

1 = True
0 = True

NA

NA

NA

NA

NA

NA

NA

NA

NA

-10 = True
String

Boolean

“”—0
“1asda” = 0

NA

“ ” = False
”anything” = True

“1.5” = 1.5

“0” = True

“2,3” = 0

“False” = True

True = 1
False = 0

True = “True”
False = “ ”

NA
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Number

String

Boolean

NaN

Infinity

Undefined

NaN

NaN

“”

False

NA

NA

NA

Infinity

Infinity

“”

False

NA

NA

NA

Undefined

0

“”

False

NA

NA

NA

Examples of Validation Rules
Scenario 1: Report Gas Consumption
Suppose that an activity contains information about gas consumption. There are three of types of consumption: predicted,
actual, and removed. The 'predicted' amount of consumed gas is saved in the activity. When a Field Technician chooses to
report the actual information about the consumed gas, then the difference between 'actual' and 'predicted' data should be
calculated automatically. If the actual consumption exceeds the predicted consumption by more than 20 cubic meters and
the conditions of the gas counter are good, then the 'Reporting notes' property is displayed.
Prerequisites: Let us assume that 'Predicted gas consumption', 'Actual gas consumption', 'Difference', 'Counter is not
broken' and 'Reporting notes' string-type properties are configured in the application. And, there is the 'Counter is not
broken' integer property with a check box on the GUI.
Configuration: The expressions should be configured in the 'Default' field for the 'Difference' property. It should look like:
activity.real_consumption-activity.predicted_consumption
Visibility: The visibility for 'Reporting notes' should be set as Read/Write with the same formula as the condition:
(activity.real_consumption-activity.predicted_consumption) >20 AND activity.counter_conditions=1

Scenario 2: Checking Ratio
A Field Technician has to enter the Upstream Signal-to-Noise ratio to complete an activity (it is mandatory). The range
should not be seen and it has to be anywhere between +32 to 52 dBmV. When the Field Technician enters a value of
55dBmV, which is not in the range then the Field Technician should know that is not the range and has to try again. The Field
Technician measures again and enters 51dBmV, which is in the range allowing to complete the activity.
Prerequisites: Let's assume that the Upstream Signal-to-Noise' property is configured in the application. The 'Upstream
Signal-to-Noise' property is configured on the 'Complete activity' screen as mandatory.
Configuration: The expression should be configured in the 'Validation' field for the 'Upstream Signal-to-Noise' property. It
should: this BETWEEN (32,52).
Custom error message should be configured in the corresponding field to be displayed to the tech in Mobility.

Processing Rules
This topic describes the rules based on which default values and validation rules are calculated.
Default value rules
For read-only fields and properties:
• Default value is always calculated for empty fields and properties.
• Default value is not calculated for not-empty fields and properties.
• Default value is recalculated every time a dependent field is changed, where dependent fields are fields used in the
formula of the rule.
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For read-write or mandatory fields and properties:
• Default value is always calculated for empty fields and properties.
• Default value is not calculated for not-empty fields and properties.
• Default value is recalculated every time a dependent field is changed, when the dependent fields are used in the
formula of the rule.
• Default value stops calculated once it's manually changed on the open form.
• Default value stops calculated once it's submitted with not-empty value.
• Default value is not calculated for fields and properties with pre-filled values defined on the Properties configuration
screen.
Validation rules
For read-only fields and properties: Not applicable to read-only fields
For read-write fields and properties:
• Are used for read-write fields and properties.
• If a value of certain field or property does not match with the configured validation rule, then the form can be
submitted.
For Mandatory fields and properties:
• Are applicable to mandatory fields and properties.
• If a value of certain field or property does not match with the configured validation rule, then the form cannot be
submitted.
• For fields and properties where validation rules are not configured, the 'NOT empty' rule is automatically applied
(current logic).
• For fields and properties where validation rules are configured, the system uses that rules on the submission of the
form. That is, if a validation rule states that a mandatory field 'IS empty' then it will be submitted without value.

Conflict Resolution
If a configured visibility rule contradicts with a configured default value, these rules are applied to resolve the conflict:
• for read-only fields and properties, the form is submitted and warning a message is displayed
• for mandatory fields and properties, the form is not submitted and an error message is displayed

Syntax for Default Values and Validation Rules
This topic describes the syntax to configure the default values and validation rules.
Naming of entities: Use these names to relate custom properties and product fields to required entities:
• activity - prefix for activity properties/fields. Example: activity.PROP_A1
• inventory - prefix for inventory properties/fields. Example: inventory.PROP_I1
• resource - prefix for resource properties/fields. Example: resource.PROP_R1
• user - prefix for user properties/fields. Example: user.PROP_U1
• request - prefix for service request properties/fields. Example: sr.PROP_SR1
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Operators: All operators are case sensitive and must be used in the configuration as described in the "Language expression"
section. Examples:
• activity.PROP_A1 = 100 OR activity.PROP_A1 = 200 - is correct
• activity.PROP_A1 = 100 or activity.PROP_A1 = 200 - is incorrect
Numbers and Strings: String-type values must be used in expressions in double or single quotes. For example:
• "string expression"
• "12345"
• 'single'
Escape sequences: The allowed string escape sequences are:
• \' – To escape ‘ within single quoted string
• \" – To escape “ within double quoted string
• \\ – To escape the backslash
• \n – To add line breaks between string
• \t – To add tab space
To ignore other escape sequences:
• \radasd => radasd
• \x123 => x123
To use integers in expressions, use them without of quotes. For example:
• 12345
• 6
Use float numbers with a dot as delimiter and without quotes. For example: 2.86954.
Properties and Fields
For properties and fields, the entity is given first followed by the label, and separated by a dot. If the label contains anything
other than a to z, A to Z, 0 to 9, or underscore, wrap it with backticks. Examples:
• activity.PROP_A1 = 25
• activity.PROP_A1 <> activity.PROP_A2
• inventory.`LABEL WITH SPACE`

Functions in Language Expressions
Use functions in expressions in the format where the function's name is given first followed by the expression in brackets.
Separate arguments by comma. All functions are case sensitive and must be used in the configuration as described in the
"Language expression" topic.
Examples for functions are:
• toNumber("string expression")
• if(activity.PROP_A1 > 10, 15, activity.PROP_A2 + 200)
• toLowerCase(activity.PROP_A1) - is correct
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• tolowercase(activity.PROP_A1) - is incorrect

‘if’ function
The function consists of three attributes separated by comma. The function represents these logic: if attribute 1 is <some
value> then set <some value> else set <other value>. Example: if (activity.PROP_A1 > 0,15, activity.PROP_A2+200)

`now` function
The function can be set as now("format") where the format can be DATE, DATETIME, TIMESTAMP. Include the value of the
format between double quotes, similar to strings. Examples:
• DATE - now("yyyy/MM/dd")
• DATETIME - now("yyyy/MM/dd hh:mm:ss tt")
• TIME - now("HH:mm:ss")

`toNumber` and `toString` functions
The rules described in the "Numbers and Strings" and "Properties and Fields" sections are applicable to the toNumber and
toString functions. Examples:
• toNumber("12345")
• toNumber(activity.PROP_A1)
• toString(1245)
• toString(activity.PROP_A2)

'concat' function
The function can contain any number of operands separated by comma and placed in between brackets. Examples:
• concat("abc", 15,"cde")
• concat(activity.PROP_A1,activity_PROP_A2)

`toLowerCase` and `toUpperCase` functions
The functions are used to convert strings to lower or upper case. The functions contain only one operand placed in brackets.
Examples:
• toLowerCase("ABCD")
• toLowerCase(activity.PROP_A1)
• toUpperCase("abcd")
• toUpperCase(activity.PROP_A1)

'empty' function
The function can be set with some field or property defined in brackets followed by the function. Examples:
• empty(activity.PROP_A1)
• if(empty(activity.PROP_A1),1000,activity.PROP_A2 +200)
• NOT empty(activity.PROP_A1)

119

Oracle Field Service Cloud

Administering Oracle Field Service Cloud

Chapter 1

Configure Oracle Field Service Cloud

Activity type groups
You can configure a group of activity types for default values, validation rules, and visibility fields and properties. It is
configured in the format of activity.awortype_group = "LABEL", where the value defining a label of an activity type group is
included in double or single quotes. Examples:
• activity.awortype_group = "internal"
• activity.aworktype_group IN ('customer', 'maintenance')

The now Function
The 'now' function returns the date and time in the resource time zone.
You can configure the function according to the format given in this table:
Format Character

Description

Example

d

Day of the month, 2 digits

1 to 31

dd

Day of the month, 2 digits, with leading zeros

01 to 31

H

24-hour format of an hour

0 through 23

h

12-hour format of an hour

1 through 12

HH

24-hour format of an hour, with leading zeros

00 through 23

hh

12-hour format of an hour, with leading zeros

01 through 12

M

Numeric representation of a month

1 through 12

m

Minutes

0 to 59

MM

Numeric representation of a month, with leading zeros

01 through 12

mm

Minutes, with leading zeros

00 to 59

s

Seconds

0 through 59

ss

Seconds, with leading zeros

00 through 59

t

Short uppercase Ante meridiem and Post meridiem

A or P

tt

Uppercase Ante meridiem and Post meridiem

AM or PM

yy

A two digit representation of a year, with leading zeros

17

yyyy

A full numeric representation of a year, 4 digits

2017

z

The time zone offset

+0 to ±11

zz

The time zone offset, with a leading zero

+00 to ±11

zzz

The full timezone offset, with a leading zero

+00:00 to ±11:30

Configure a Context Layout Screen
You configure the Context layout structure for a screen, when you want to change the visibility of fields, add conditions for
visibility, or add more fields and buttons.
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Let’s say you want to create a Edit/View Activity form for the context, Edit/View Activity that belongs to the user type,
Administrator with these objects:
• Start and End actions.
• Special element, Section
• Name and Address fields.
This example explains how to configure the entities, namely, fields, actions, and special elements for the form.
Note: Properties configured on the Edit/View Activity context (also known as Activity Details screen) are
ReadOnly, even if the property visibility is set to ReadWrite. To set the property visibility to ReadWrite, you must
add the properties to a tab.
1. Click Configuration, User Types in the Users and Security section.
The existing users display in the left pane.
2. Select Administrator from the left pane.
3. Select the Screen Configuration tab.
4. Expand Application screens and select Edit/View Activity.
5.

6.

7.
8.

9.

The Visual Form Editor displays.
To add the special element, Section to the grid:
a. Select Special Elements.
b. Drag and drop Section to the grid to add a section to the form.
To add Name and Address fields to the section:
a. Drag and drop the Name property from the Fields section.
b. Drag and drop the Address property from the Fields section.
Click Save.
To add the Start and End actions:
a. Drag and drop the Start action to the header from the Actions section.
b. Drag and drop the End action to the header from the Actions section.
Click Save at the top of the form editor.

After you configure the entities for a form, log in to the application and view the configured form.
Note: Visibility of tabs is the aggregated result of the configured visibility conditions for the child elements (for
example, property, text). these rules apply:
• The tab is visible and accessible, if at least one element is configured to be visible (for example, Readwrite or Mandatory) or a Read-only element contains data.
• The tab is not visible or accessible, if none of the configured elements is visible (for example, no Readwrite or Mandatory property or Read-only element without data).
• If a tab has all Read-Only elements, then the buttons are shown. If at least one element in the tab is
Read-Write or Mandatory, then the buttons are not shown.
• If a tab has been configured with visibility conditions, it will be displayed in accordance with those
conditions ignoring inner elements.

Restrictions and Filters
The Restrictions and Filters tab sets the restrictions on activities and fields visible to the users of the current type.
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The Restrictions and Filters tab has two sections:
• Field restrictions
• Filters restricting visible activities
The Restrictions and Filters tab is shown in this figure:

Options in the Field restrictions section define whether all activities and/or certain activity fields are to be hidden from the
users of the current user type. There are two options in this section:
• Hide all activities: Determines if the users will or will not be able to access any activities in the system after a
certain time. When the Hide all activities option is enabled, the administrator must set the time after which the
activities are to be hidden. Two options are available:

◦
◦

starting tomorrow: When selected, all users of the current type will only be able to access today's activities
starting day after tomorrow: When selected, all users of the current type will only be able to access today's
and tomorrow's activities. No activities beyond the selected time will be visible to these users.

• Hide activity fields: Determines if the users will or will not be able to access certain activity fields after a certain
time. The fields to be hidden are defined in the Field restrictions context accessible by clicking the activity fields
link. When the Hide activity fields option is enabled, the administrator must set the time after which the activity
fields are to be hidden. Two Hide all activity fields menu options are available:

◦
◦

starting tomorrow: When selected, all users of the current type will only be able to access the selected fields
of today's activities
starting day after tomorrow: When selected, all users of the current type will only be able to access the
selected fields of today's and tomorrow's activities. The restricted activity fields beyond the selected time will
not be visible to these users.

Options in the Filters restricting visible activities section define whether the users of the current type will be able to view
entire routes or only some activities. Setting the visibility restrictions requires proper configuration of the applicable filters.
To be used as a restriction on visible activities, a filter must be defined as applicable for activity in the Add Filter window.
In addition, the Restriction on visible activities option must be selected. Clicking Add displays the User Types screen,
where you can apply the current filter as a visibility restriction filter for the user type. This figure shows the Add filter dialog
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with the Applicable for, Restriction on visible activities and the Go to User Types screen to apply the current filter
as visibility restriction filter for user type fields highlighted:

The filters you add then display in the list of available filters in the Restrictions and Filters tab of the user-type configuration.
When a filter has been set for a user type, all users of such type will see only the activities defined in the filter settings
according to the conditions set in the filter configuration.
The User Types section of the filter does not apply when setting restrictions on visible activities. The User Types section is
inactive only when the Restriction on visible activities option is selected. However, it is used in configuring the filter to be
used on List/Time/Map/Daily screens. This figure shows the Filters menu:
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When the List/Time/Map/Daily option is selected, the User Types section becomes active. The note in the User Types
section suggests that the List/Time/Map/Daily filter will be applied for selected user types.
When a filter is defined as a filter for List/Time/Map/Daily for a user type, this filter will appear in the View window on the
Activities and Daily screens for users of such type. The list will include only the filters configured as described above.
Note: If the same filter is defined both as applicable for List/Time/Map/Daily and as a Restriction on visible
activities, it works for two different groups of user types. The List/Time/Map/Daily filtering will be available for
the user types selected in the same filter configuration window. However, the Restriction on visible activities
will be set for the user types for which this filter is selected in the Restrictions and Filters settings.

Add Access Schedule Fields
You add the Access Schedule fields to an activity to define the time or date range between which your technicians can
access the equipment used for the activity, or the facility in which the activity must be performed.
To access the Access Schedule fields, add the Access Schedule (access_schedule) and/or Access Hours (access_hours)
fields to the appropriate display context. While Access Schedule can be added in Read-Only and Read-Write mode, Access
Hours can only have the Read-Only visibility. In most of the contexts (including activity-related screens, lists and hints, with
the only exception of Activity details) the Access Schedule field also includes Access Hours if it is calculated.

User Management
How you configure and manage user types and individual users is dependent upon user-type settings.
User type settings affect the user management process. You should consider these points when configuring user types and
individual users:
• These settings allow the user logging in under this user type to open the Users screen and manage users.
• A user having access to the Users screen can see the list of all users existing in the system. However, the user can
modify only the users of types defined under Can create users of these user types. Users of other types have no
buttons and cannot be included in group actions (that is, no check boxes are available to them).
• If no user types have been defined in the Can create users of these user types section, the user can see the
users list but cannot modify existing user settings or add new users.
• A user is always related to one or more resources. The choice of resources for creating a new user is affected, on
one hand, by the Assigned resource types setting in the User Type configuration and, on the other hand, by the
Users can be created at the level of this resource feature of the resource type.
• When creating a new user type, the User Type field contains the list of user types defined in the Can create users
of these user types field of the current user type.

Create a User Type
A user type is a template that specifies permissions and screen configurations. These settings are applicable to all the users
of the user type.
You must be logged into Oracle Field Service Cloud as an administrator.
When you create a user type that is not copied from an existing one, most of the options are disabled, and you must define
the settings manually. When you use a copy, the new user type inherits all the settings from the copy.
1. Access the User Types screen.
2. Click the + icon at the upper left corner of the screen.
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The Add User Type window appears.
3. Enter a Label for the user type.
This is a unique string identifier of the user type.
4. Enter a Name for the user type.
This is a human-friendly name.
5. Optionally, choose an existing user type to copy settings from.
a. Choose an existing user type from the available list.
b. Optionally, click Share screen configuration.
Choose this option if you want the new user type to have the same screen configuration options as the copied
user type. If you change a shared screen configuration, the change will apply to all user types that use the
configuration.
6. Click OK
The User Type Settings screen appears.
7. Edit the user type values as necessary.
8. Click Save.
Changes to a user type assigned to manage users are applied shortly after they are saved. Changes to a user type
assigned to Mobility users are applied after the next synchronization.

Delete a User Type
You can delete a user type only if there are no users assigned to it.
You must be logged into Oracle Field Service Cloud as an administrator.
1. Access the User Types screen.
2. Select the user type you want to delete from the list.
3. Click the - icon at the upper left corner of the screen.
The Confirm window opens.
4. Click OK.
If the selected user type is assigned to any users, an error message displays indicating that the user type cannot be
deleted. Else, the user type is deleted.

Export User Types
You export user types from one instance to another, to create users with all their settings, such as associated resource types,
permissions, context layouts, and filters.
these actions are available on the Export user types window:
• Select all: Exports all user types existing in the application.
• Clear all: Clears any previously selected user types.
The search field at the top of the window allows you to filter the list by entering a search string. All items are exported under
their labels. Clicking Export creates an XML file containing the data of the user types you selected. If you have not selected
any user type, the error message Nothing to export displays.

Import User Types
You can import user types from an XML file. The imported user types replace the existing user types, if any.
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The Import user types window allows you to select the XML file containing the user-types data. Import can process only
XML files. If you select any other type of file, the application rejects the import and displays the error message, Import file
type must be XML. Before importing a user type, the application checks to ensure that its entities (such as resource types,
permissions, and context layout items) are valid.
Note: You cannot import your own user type. Your user type must be imported by a user of a different user
type. For example, if your user type is Admin1, you cannot import it. You can create another user type Admin2,
and Admin2 can import Admin1.
Validation messages are as follows:
• Successfully imported: The user type is imported successfully.
• Imported with warnings:
One or more entities is invalid, but the user type is imported.
• Not imported: The user type is missing critical data and has not been imported.
During the import process, a progress window displays these information:
• A number in the Import column means that the number of imported items differs from the number of validated
items.
• A green check mark means that the number of validated items is identical to the number of imported items.
The User type import details window displays the details of all successfully imported user types, user types imported with
warnings, and user types that were not imported.

Manage Users
You must first configure several user-type settings, so that a user type can create and manage other users.
1. On the General tab, do these:
a. In Can create users of these user types, select all the user types from which users can be created.
b. In Access settings, ensure that the Allow access via web application option is selected.
2. On the Screen configuration tab, do these:
a. Ensure that the Main menu context includes the Users screen with the read-write visibility.
b. Ensure that the Company Configuration context includes the User Types screens with the read-write
visibility.

Manage Your Own User Type
Any user can change his or her user type.
You can change your user type when you configure the My Display context layout so that it contains the User Type field
with read-write visibility. However, the available options include only the user types defined in the Can create users of
these user types field of the current user type, and your own user type must be among the user types selected in the field.
Otherwise, the User Type field appears as read-only, even when its visibility has been defined as read-write. This figure
shows the My Display screen that lets you change the user type:
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CAUTION: Be very careful when changing your own user type. Your new user type might have different visibility
and access settings that may make reverting to the previous user type impossible.

User Groups and User Permissions
User Groups and User Permissions are part of the tools used to manage Oracle Field Service Cloud Collaboration Cloud
Service functionality settings.
User Groups are used to create roles, structure, and assign permissions. The user group list displays name and membership
information, group description, and status. The User Permissions section provides a list of users that have access to Oracle
Field Service Cloud Collaboration Cloud Service. For more information about User Groups and User Permissions, see the
Oracle Field Service Cloud Collaboration Cloud Service User Guide.

Work Schedules
Create and Delete Work Schedules
Work schedules are templates that are made up of a combination of shifts (working time) and non-working times. When
grouped as a work schedule, you can apply these shifts all at once to a bucket or to an individual resource.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules screen appears.
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3. Click Add work schedule.
The Add work schedule window appears.
4. Enter a name and a unique label for the new work schedule.
While the name must be representative of the work schedule time frame, there is no functional correlation between
the name and the shifts that will be contained within the schedule.
5. Select the Active check box if you want the work schedule to be visible for assignment.
6. Click OK to save the work schedule.
7. To delete a work schedule, select the check box and click Delete.
Note: You cannot delete a work schedule if it is currently assigned to a resource. You must remove it from
the resource or bucket first, and then delete it from the list.

Add Shifts to a Work Schedule
After you have created a work schedule, you can add the shifts and non-working times that will be included in the overall
period of time.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules screen appears.
3. Click Items to the right of the work schedule that you want to add a shift to.
The shift list for the selected work schedule appears.
4. Click Add Shift.
The Add shift window appears.
5. Click the Shift drop-down menu to view the available shifts.
6. Select a Start date and End date for the period of time that this shift should be associated with the work schedule.
Leaving the End date field empty implies that the shift will be a part of the work schedule indefinitely.
7. Add any comments for clarification or detail.
8. Select one of these options in the Repeats drop-down menu:
◦ Daily – Allows for inclusion of the shift such as every other day or every 3rd day. This option requires a value in
the field labeled every _____ day(s).
◦ Everyday – The shift applies to everyday without exception.

◦
◦

Weekly – Allows for shifts that are used on a regular weekly pattern. Select the days that apply to this
particular shift using the check boxes for the individual days. Indicate the frequency of this pattern weekly by
adding a value to the every ____ weeks(s) field.
Yearly – Select a date range for the shift that will recur every year.

9. Click OK to save the shift to the work schedule.
10. Repeat the steps for each additional shift that you want to apply to this work schedule.
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Add Non-Working Time to a Work Schedule
In addition to shifts, you may apply non-working time to certain work schedules. This could accommodate work schedules
that include non-standard work time such as four-day workweeks or even holidays that occur on the same day every year.
Keep in mind that many of the non-working reasons (illness, bereavement, etc.) tend to be used more frequently on a one-off
basis for individual resources as days off occur.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules screen appears.
3. Click Items to the right of the work schedule that you want to add non—working time to.
The selected work schedule appears.
4. Click Add non-working time.
The Add non-working time window appears.
5. Complete these fields:
this table describes the fields available on the Add non-working time screen:
Field

Description

Shift Type

Select from Regular or On Call depending on which shift type you want the non-working
reason to be associated with.

Reason

Select the applicable reason from the drop-down menu. This list is populated from entries in
Company Settings, Non-Working Reasons.

Start Date | End Date

Select the date range that this non-working will be valid for. Open-end dates imply that the
non-working reason will be indefinitely associated with the work schedule.

Comments

Enter any comments about the non-working reason. If Other is selected as a reason, then
the Comments field becomes mandatory.

Repeats

Select the appropriate option from the drop-down menu. Options are:
Daily – Allows for inclusion of the shift such as every other day or every 3rd day. This
option requires a value in the field labeled every _____ day(s).
Everyday – The shift applies to everyday without exception.

◦
◦
◦
◦

Date Selections

Weekly – Allows for shifts that are used on a regular weekly pattern. Select the days
that apply to this particular shift using the check boxes for the individual days. Indicate
the frequency of this pattern weekly by adding a value to the every ____ weeks(s) field.
Yearly – Select a date range for the shift that will recur every year.

Enter the date selections based upon the previous selection. Dates are inclusive.

6. Click OK.
The new non-working reason is added to the work schedule.
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Work Skills
Work skill is the job-specific skills necessary to perform an activity. These act as a defining criteria to match activities with the
resources.
The Work Skills feature lets you to capture the task attributes to assign the work. Work skills identifies the following
attributes:
• The expertise of a resource
• The expertise required to perform an activity
You must create the work skills and then assign them to the resources and work skill conditions.

Create a Work Skill
Work skills are client-specific sets of skills or competencies, required by resources to perform their assigned activities.
1. Click Configuration.
2. In the General section, click Work Skills.
The Work Skills screen appears.
3. Click Add new.
The Add work skill window appears.
4. Complete these fields:
Field

Description

Name

Enter a descriptive name for the work skill in at least one of the language fields (for example,
New Install, Video, Outage, etc.). This is the wording that will appear to users within the
application.

Label

Enter a unique string for this work skill. This is how the work skill will be identified within the
database.

Sharing of the skill in the team

Select from the drop-down menu:
Maximal — Team gets the maximal work skill level of all the team members (default).

◦
◦
◦
◦

Active

Minimal — Team gets the minimal work skill level of all the team members.
No Sharing —This work skill, if assigned to a team member, it does not affect skills of
the team.
Summary — Team gets the total sum of work skill levels of all the team members
The work skill sharing parameters will define if a specific activity can be assigned to a
team-holder but not higher than 100.

Select the check box to activate. If active, the work skill and its conditions are used by the
routing engine. If inactive, the skill and its conditions still exist but are not used by the routing
module.

Work Skill Sharing Example
Team gets the total sum of work skill levels of all the team members The work skill sharing parameters will define if a specific
activity can be assigned to a team-holder but not higher than 100. In this example will consider how sharing influences
work skill allocation in the group. Keep in mind that if a resource is assigned a group of work skills (G) and some work skills

130

Oracle Field Service Cloud

Chapter 1

Administering Oracle Field Service Cloud

Configure Oracle Field Service Cloud

explicitly (WS), in case of intersection the explicitly assigned work skills will prevail. Resource that is not assigned any work
skills is considered to obtain all the work skills with 100 qualification.
Work Skills

Team Holder

Team Member 1

Team Member 2

WS0 - Maximal
WS1 - Maximal

WS0 (100)
WS3 (100)

G: [WS0 (1),WS1 (1),WS2 (1) ,
WS3 (1), WS4 (1)]

WS4(10)
G: [WS0(20), WS2(20)]

WS2 – No Sharing

G: [WS3 (10), WS4(10)]

G: [WS0(30), WS2(30)]

WS3 - Minimal WS4 – Summary

Effective work skills of the team-holder:
• WS0(100) - Maximal(100, 1, 30)
• WS1(1) - Maximal(0, 1, 0)
• WS2(0) – No Sharing (0, 1, 30), team-holder doesn't have this skill
• WS3(0) - Minimal(100, 1, 0)
• WS4(21) – Summary (10, 1, 10)

Delete, Activate, or Deactivate a Work Skill
You cannot delete a work skill that is currently assigned to at least one resource. You can set the active/de-active status at
any time.
1. Click Configuration, Work Skills.
The Work Skills screen appears.
2. Select the check box next to the work skill that you want to delete, activate, or deactivate.
3. Click Delete, Activate, or Deactivate.
4. Click OK.

Temporary Work Skills
Determine the skills required to perform an activity and the skills of the technicians. Based on these technician skills activities
are assigned to perform.
This feature allows you to set up a date range during which a skill is considered actual. These settings are part of the work
skill settings of a resource and define the period during which the resource is considered having a certain skill of a certain
level. This feature is helpful when some skills require periodic certification, some equipment is available for limited time only
and if a planned maintenance is scheduled which requires special skills.
If no work skills have been explicitly assigned to a resource, the resource is assumed to permanently have all work skills
configured in the system with the maximum ratio. If any work skills have been assigned, the resource has only those work
skills with the specified ratios.
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Related Topics
• Video: Assign temporary work skills

Define a Temporary Work Skill
Set up the assignment period for each work skill or work skill group assigned to a resource. When a work skill or work skill
group is selected for a resource, its start and end dates can be defined in the calendar.
1. Open Settings > Resource Info > Work Skills
2. Click the add (plus) button.
The Add Work Skills window opens, as shown in this figure:

3. Select the appropriate work skills from the list.
4. (Optional) Assign the work skill ratio.
If the ratio is not defined, the resource is considered to have the maximum work skill ratio of 100.
5. Select the From and To dates of the skill assignment period from the Calendar.
By default, the start date is always set to the current date making the work skill applicable immediately. If the start
date is changed to a past date, it will still be replaced with the today's date, as the application does not support
changes to past data. The end date can be left blank to mark the skill assigned permanently
6. Click Save.
The work skill is assigned to the resource separated with semi colons. The name of each work skill is followed by its
ratio and assignment dates in parentheses. The work skills are displayed according to these rules:
◦ Work skills terminated in the past are not displayed

◦
◦

Assignment dates are shown in the 'from… to…' format. When the start date is in the past, from date is not
shown. When end date is not set, to date is not displayed.
If a work skill level is set to 100, the level is not displayed.

132

Oracle Field Service Cloud

Administering Oracle Field Service Cloud

◦

Chapter 1

Configure Oracle Field Service Cloud

Inactive work skills are shown in gray font.
Note: If the resource is not assigned with the work skills, the resource is assumed to permanently have all
the work skills configured in the system with the maximum work skill ratio.

Related Topics
• Video: Assign temporary work skills

Edit Work Skills
Update the work skills of a resource as an when the resource acquires more skills or proficiency. You can also delete the
work skills of a resource.
1. Open Settings > Resource Info > Work Skills
2. Click edit button.
The Edit Work Skills window opens, as shown in this figure:

3. Update the changes and click Save.
The work skills are updated based on these rules:
◦ Overlapping records with same work skill and same ratios are automatically merged into one. The start date of
the merged record is the To date of the first record, and the end date of the merged record is the From date
of the latest record
◦ Records with same work skills and different ratios will not be merged. Two different records are created.
However, if their assignment periods overlap, the input is rejected with the message, Overlapping of intervals
for the same skills is not allowed. The assignment periods have to be adjusted so that they no longer overlap.
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these figure shows the Work skills screen, where you have tried to add the same work skill with overlapping
intervals, and the corresponding error message:

◦
◦

If a work skill is deleted, it is marked terminated on the previous day.
If a work skill is updated, the old work skill is marked terminated on the previous and the new work skill record
starts from the current date.

Work Skill Conditions
To ensure that a resource has the ability to perform subsequently assigned activities, a correlation must be made between
incoming activity skill requirements and the skills specified for each resource. The Work skill functionality is what that
correlation is based on. Work skills are set up first, and then are assigned to resource records, with the appropriate levels of
qualification set for each.
Incoming activities are also assigned Work Skills, which are then matched up with resources with corresponding skills during
routing. For the application to know which Work Skills to assign to the activities, however, another correlation must be made.
This correlation is referred to as Work Skill Conditions – criteria that is based on certain field values of activities. Work Skill
Conditions are what the application uses to define which Work Skills should be assigned to activities. Each Work Skill has at
least one condition that refers to a specific field and value in the incoming activity record. An example of this could be where
an install Work Skill’s condition is to look for the field/value of “WO_TYPE = 1” (“1” being code for an install). If this condition
were found within the activity record, then the application assigns that Work Skill to the activity.
• The application assigns as many work skills to an activity record as there are conditions found.
• If multiple works skills are assigned to an activity, then the same list of skills must be associated with a resource
record in order for that resource to be considered for that job.
• If required and preferred skill levels are used to define Work Skills and conditions, then routing matches activities to
available resources with equal or higher qualifications of the skills as it determines who should be assigned which
activities.

Create a Work Skill Condition
A work skill condition correlates incoming activity skill requirements with the skills possessed by resources. Work skill
conditions are used to determine which activities are assigned to which resources.
You must add work skills before adding work skill conditions.
1. Click Configuration.
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2. In the General section, click Work Skills.
3. Click Work skill conditions.
The Work skill conditions screen appears.
4. Click Add new.
The Add work skill condition dialog appears.
5. Complete these fields:
Field Name

Description

Work skill name

The work skill for which you want to add a condition. These work skills are created in the
Add work skill dialog.

Required level

The minimum qualification level of the skill a resource must have, to be considered for
the activity. Only resources that have the required level or better skills are selected for the
activity.

Preferable level

If more than one resource meets or exceeds the required level, then the one(s) with the level
that is closest in number to the “preferable level” is selected for the activity.

Add new condition

A new condition for the work skill. Three new fields appear. Select the field for which you
want to add the condition and select the condition. For example, suppose you want the
work skill Install to be assigned to a technician who has a minimum skill level of 75, for work
order types IN. Select the Work skill name as Install, enter 75 for Required level, click Add
new condition and then select W/O Type, In, and IN.

6. Click Save.
The work skill condition is saved. When a new activity is added, these work skill conditions are used to determine
which work skills are assigned to the activity.

Work Skill Groups
Create a Work Skill Group
You can bundle selected work skills into work skill groups, This creates greater ease and flexibility for assigning skills to
resources. You can continue to assign individual work skills and work skill groups, creating a more accurate resource work
skill record. You must define work skill groups to be used for capacity categories, if different work skills must consume quota
from a single capacity category.
1. Click Configuration.
2. In the General section, click Work Skills.
3. Click Work skill groups.
The Work skill groups screen appears.
4. Click Add new.
The Add work skill group window appears.
5. Complete these fields:
Field

Description

Name

Enter the work skill group name. If you have set multiple languages for the application, input
boxes appear for the different languages.
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Field

Description

Label

Enter a unique identifier for this work skill group.

Active

Select the check box to make this work skill group active.

Can be assigned to a resource

Select the check box if you want the work skill group to be able to be assigned to a resource
record. If a group is assigned to a resource, then that the resource obtains all the work skills
defined for the group.

Can be added to a capacity category

Select the check box if you want the work skill group to be able to be assigned to a capacity
category. If a capacity category contains a group of work skills, then an activity is considered
a match to the category if it 'requires' at least one of work skills from the group.

6. Click Save.
The Work skill groups screen appears.
7. Click the pencil icon in the Work Skills cell to add work skills and their qualification level.
The Edit work skill window appears.
8. Click to select the work skill and activate the Qualification Level field.
9. Click Save when done.
10. To modify a work skill group, click the Name cell.
The Edit work skill group: [Work skill group name] window appears, which is similar to the Add work skill
group window.

Delete a Work Skill Group
You can delete a work skill group, if you don’t need it any more.
1. Click Configuration.
2. In the General section, click Work Skills.
3. Click Work skill groups.
The Work skill groups screen appears.
4. Select the check box next to the work skill group that you want to delete.
5. Click Delete.
6. Click OK.

Work Zones
A work zone is the defined geographical area within which a resource can perform activities. Work zones are defined within
the work zone dictionary, and are then assigned to resource records.
A temporary work zone is a work zone that is not a resource’s typical work zone, but that is assigned to the resource for a
specific period of time. Temporary work zones override a resource's regularly assigned work zones. A work zone key consists
of a field (or combination of fields) and length-specific values, that when identified within an activity record, determines which
work zone gets associated with that activity. You can view, add, and modify work zones from the Work Zone screen.
Routing assigns activities to resources taking into account the work zones of those resources and assigning only those
activities that are within his or her work zone.
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Add a Work Zone
Work Zone is unique to each company and reflects how geographic regions are divided for more effective and efficient
routing.
Ensure that you have added the required travel areas.
1. Click Configuration.
2. In the General section, click Work Zones.
The Work Zones screen appears.
3. Click Add new.
The Add Work Zone window appears.
4. Fill up these fields:
Field

Description

Work Zone Name

A meaningful name to describe the group of Work Zone key values that make up the Work
Zone.

Work Zone Label

A unique identifier for the Work Zone.

Status

Status of the Work Zone—active or inactive.

Delimiter

Choose whether commas separate locations in the Work Zone Keys list or each location
appears on a new line.

Travel Area

A higher level bundling of zones used by the application’s statistics engine.

Work Zone Keys

Values within and formatted as defined by the overall Work Zone field key, that will positively
associate an incoming activity with a particular Work Zone.

Actions

Click Modify to edit the Work Zone.

Work Zone Shapes

Work Zone shapes are used as visual representations of Work Zones on the map and, as
a tool for yet more subtle definition of Work Zones. For example, if the company chooses
to define its Work Zones by city names or postal codes the Work Zones may be rather
large. At the same time, several shapes can be attached to the Work Zone dividing it into
geographically smaller areas. This way, one team can work in one shape and another
team – in another shape while still working in the same Work Zone. Work Zone shapes are
displayed in Core Manage and Mobility.
If used, enter the shape identifier. The property serving as the shape identifier is defined
during the shape configuration via the Metadata API. For example, if ZIP code is used as
shape identifier, enter one or more ZIP codes associated with Work Zone shapes.

5. Click Add.
The Work Zone is saved.
Note: The Work Zone identifiers must be unique. If the identifier has already been used for another Work
Zone, the input is rejected with the error message: Key {identifier} conflicts with key {identifier} of Work
Zone {work_zone_name}.
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View Work Zone
Work Zone is unique to each company and reflects how geographic regions are divided for more effective and efficient
routing. The keys that define zones can be anything with geographic relation – a zip code, address portion, network items
(nodes, sub-nodes), map grids, or even geo-coding.
1. Click Configuration.
2. In the General section, click Work Zones.
The Work Zones screen appears and displays these fields:
Field

Description

ID

System-generated number used to identify a unique Work Zone.

Status

The Work Zone can be active and available for routing or inactive and not available for
routing. Green tick mark indicates active and red cross indicates inactive.

Work Zone Name

A meaningful name to describe the group of Work Zone key values that make up the Work
Zone.

Work Zone Keys

The exact values that can be found within the primary key (field) that are used to associate
the activity record with a Work Zone.

Actions

Click Modify to edit the Work Zone.

Shapes

Link appears if one or more shapes have been added to at least one Work Zone. Clicking
Shape opens the map showing the shapes associated with the selected Work Zone. For
adjacent shapes the map shows one common area formed by the combined shapes.

3. Click View to filter the Work Zones.

Modify a Work Zone
After you create a Work Zone, you cannot delete it, but you can activate or deactivate it. You can also modify the work zone
by changing the name, or by adding or removing locations from it.
1. Click Configuration.
2. In the General section, click Work Zones.
The Work Zones screen appears.
3. Click Modify for the Work Zone that you want to modify.
The Edit Work Zone window appears.
4. Change as required and click Update.
Current activities are recalculated per the modifications. Any future activities will be routed according to the newly
modified Work Zones. For precautionary reasons, any Work Zone changes must be performed outside of the
application’s peak usage time.
Note: Changing the status of a Work Zone to Inactive stops routing from using the Work Zone or any of
its locations.
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Modify a Work Zone Key
A work zone key helps you identify a work zone with a short name. The work zones that you create are automatically
assigned with the key or convention that you define in the Work Zone Key dialog. By default, City is the work zone key in the
application.
1. Click Configuration.
2. In the General section, click Work Zones.
3. Click Modify next to Work Zone Key in the header area.
The Work Zone Key dialog appears.
4. To retain City as the key and just change the length of the key, change the number in the Length field. In the next
field, select whether you want the entire key as case insensitive, or just the first letter.
5. Click OK.
The existing work zone keys are modified to conform to the new configuration.
6. To add a new field as the key, click the plus icon in the Work Zone Key dialog.
The list of fields available in the application is displayed in alphabetical order.
7. Select a field of your choice and click Add.
The newly added field is displayed in the Work Zone Key dialog.
8. Add the length of the key in the Length field. In the next field, select whether you want the entire key as case
insensitive, or just the first letter.
9. Click OK.
The modifications are applied to the existing work zone keys.

Export and Import Work Zones
You can export and import Work Zones to move the information between two instances. You can export and import Work
Zones either through API or through the user interface. The Export and Import buttons available on the Work Zones screen.
1. Click Configuration > Work Zones .
2. Click Export.
An XML file is generated with these information:
◦ XML format and product version

◦

◦

Information about Work Zone keys
- field
- property (can be present only if 'field' equals 'property')
- function ('case insensitive' or 'first word case insensitive')
- length
- order
Information about Work Zones:
- Work Zone name
- travel area
- status (active or inactive)
- Work Zone shapes
- Work Zone keys (order and formula are taken into account)
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3. To import Work Zones, click Import.
You can import only the Work Zones that are exported from this application.
4. Click Browse and select the file that you want to import and then click Import.
The Work Zones are imported based on these rules:
◦ Work Zone keys and shape IDs for imported Work Zones must be unique. If either of them is not unique, the
Work Zone is not imported.
◦ If a Work Zone is present in the company configuration and is absent in the imported XML file, the Work Zone
is deactivated.
◦ If a Work Zone is present in both, company configuration and imported XML file, it is updated if valid.

◦

If a Work Zone is absent in the company configuration and is present in the imported XML file, it is created if
valid.
The Work Zones are imported and the summary of results is displayed. The results show the number of successfully
imported Work Zones and number of Work Zones which failed to import.
Related Topics
• Example of Work Zone Export XML Structure

Example of Work Zone Export XML Structure
When you export Work Zones, an XML file is generated. This topic provides a sample structure.
<?xml version="1.0" encoding="UTF-8"?>
<workZones formatVersion="1" productVersion="16.8.0">
<workZoneRules>
<rule field="ccity" collation="case insensitive" length="4" order="0" />
</workZoneRules>
<items>
<item status="active" travelArea="sunrise_enterprise" workZoneLabel="ALTAMONTE SPRINGS"
workZoneName="ALTAMONTE SPRINGS">
<keys>
<key>alta</key>
</keys>
<shapes>
<shape>cass</shape>
<shape>gene</shape>
</shapes>
</item>
<item status="active" travelArea="sunrise_enterprise" workZoneLabel="TEX" workZoneName="TEXAS">
<keys>
<key>andr</key>
<key>colo</key>
<key>kerm</key>
<key>lubb</key>
<key>midl</key>
<key>odes</key>
</keys>
<shapes>
<shape>wint</shape>
<shape>port</shape>
</shapes>
</item>
<items>
</workZones>
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Add a Travel Area
Travel areas define the maximum allowed travel territory for a company and can contain groupings of work zones. Typically,
companies have at least one high-level travel area listed.
1. Click Configuration.
2. In the General section, click Work Zones.
3. Click Travel Areas.
The Travel Areas screen appears.
4. Click Add travel area.
The Add travel area pop-up window appears.
5. Fill up these fields:
Field

Description

Name

Name of the travel area.

Label

Your company specific unique identifier for the area.

6. Click OK.
The Travel Areas screen appears.

Travel Time Prediction
Oracle Field Service Cloud uses time-based prediction for travel time. This topic describes how travel time is calculated in the
application.
Travel time between two activities is calculated as a combination of:
• Statistical “Learned” estimation
• "Straight-Line" estimation
Note: You can specify durations for specific activities and technicians through APIs. For more information, see
the REST API for Oracle Field Service Cloud guide.
Statistical “Learned" estimation
Statistical Learned estimation is based on the historical travel times between two locations. These locations are represented
by geographical areas, termed as Travel Keys. A Travel Key is typically a portion of or the entire Post Code or ZIP Code.
When a resource records travel between two locations, the values are added to the statistics to produce a learned estimate
of the travel between that set of Travel Keys. To produce and use a Statistical Learned Estimate for the travel time between
two activities, both activities must contain a value that is part of the Travel Key and the Travel Keys must have enough
historical travel data.
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Note:
• The travel time between two Travel Keys will be adjusted over time as more data is collected.
• Generally travel time for an activity is considered to be the time between the end of the previous activity
and the start of the current activity. If there is idle time after the end of the previous activity (before the
start of predicted travel to the current activity), then the recorded travel time is not considered for the
statistics.
Straight Line estimation
Straight Line estimation uses the time taken to travel the distance when a straight line is drawn between two locations. To
calculate this travel time, the application must have the latitude and longitude of both the locations. The formula to calculate
the total travel time is:
Total Time = Straight Line Time + Arrival (or Parking) Time
Where:
Straight Line Time = Distance / Speed

Here, speed and arrival (or parking) time are constants that are configured at the company level.
Travel time estimation
Oracle Field Service Cloud uses a parameter called Coordinated Travel Weight (CTW) to combine the two methods of
estimations described earlier. CTW is a company–level value and is calculated using the Coordinate calculation weight
parameter. Coordinate calculation weight is configured at the company level, in the Statistics screen. The formula is:
Travel Time = Statistical x (1-CTW) + Straight Line x CTW

For example, if you set CTW to 0.5, the travel time is the average of the two.
Exceptions:
• If the CTW value is 0.0, only the Statistical Learned estimation is used. If no Travel Key is available, the Default
Travel time is used.
• If the CTW value is 1.0, only the Straight Line estimation is used. If coordinates are not available for both activities,
the Default Travel time is used.
• If neither Statistical Learned estimation nor Straight Line estimation is available, the Default Travel time is used. The
Default Travel time is a single configuration at the company level.
Additional adjustments
After routing is performed, the application may adjust Travel Time further for activities that are pending and ordered on a
route. This adjustment may occur when one of these situations occurs:
1. Application is unable to find a Statistical “Learned" record that matches a Travel Key
a. When only the coordinate method is used.
b. When the "default" value is used.
2. The statistical value is produced as a result of the expansion algorithm.
a. The expansion algorithm expands travel estimations using the pathfinder algorithm. For travel key pairs that
don't have real travel data collected, the expansion tries to find a path using existing pairs (paths) and stores
travel time as a sum of these travels. For example, if there is no statistical data for travel between keys 1 and
2, but there is for travel between keys 1 and 3, and between keys 3 and 2, travel time 1-2 is calculated as a
sum of travels 1-3 and 3-2.
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b. This is not applicable for new customers where the statistics are not yet available.
When either of the above occurs, the application attempts to adjust travel time using two methods:
• Generate “actual travel" data: The application submits the origin and destination addresses to the Oracle Spatial
and Graph Route Server, if the accuracy level of each activity = “address”. The application calculates the travel time
between the activities, adds the results to the temporary statistics, and recalculates the travel time on the route using
the updated statistics.
• Generate "street/post code level" estimate travel between post codes

◦
◦

This method requires post or zip code to be configured as the travel key.
The application submits the origin and destination post or zip codes to the Oracle Spatial and Graph Route
Server and the application calculates the travel time between them. The returned information is used to
improve the quality of the temporary statistics.
Note: When the post code is the same for both the activities, this method is not used.

Temporary statistical travel data is calculated and used until real data is accumulated. This is accumulated as resources
record travel between two locations based on the status of the activity. As soon as actual resources learned statistics are
obtained, the temporary record is deleted. The Daily Extract - Appt data set contains the ‘travel_estimation_method’ field,
which identifies what travel method was used for the travel time estimation. This field is only available in the Daily Extract file.
these values can be present:
Value

Description

0 - travel is not calculated

Travel is not calculated. This is not calculated because the Activity Type feature = “Calculate travel”
is not selected.

1 - company default

Travel estimation uses the company default found in “Configuration - Statistics”

2 - statistics only

Travel estimation uses only the Statistical Learned estimation. This could be a result of an activity not
being geocoded or the Coordinated Calculation Weight parameter set to 0.

3 - expansion statistics only

Travel estimation is based on the expansion statistics. See 2A above for a definition.

4 - initial statistics only

Travel estimation is based on the temporary statistics that were generated based on the results
received from street level routing.

5 - coordinates only

Travel estimation only uses the Straight Line estimation. This could be a result of an activity not
having a physical address or the Coordinated Calculation Weight parameter set to 0.

6 - statistics + coordinates

Travel estimation is based on a combination of the Statistical Learned estimation and Straight Line
estimation using the ‘Coordinate calculation weight’ setting.

7 - expansion statistics + coordinates

Travel estimation is based on a combination of expansion statistics and the Straight Line estimation
using the ‘Coordinate calculation weight’ setting.

8 - initial statistics + coordinates

Travel estimation is based on the statistics that were generated as part of the results received from
street level routing and the Straight Line estimation using the Coordinate calculation weight setting.

9 - "manual" adjustment

Travel estimation is based on the value that was updated using an API. This value can be
set via Core API (update activity). For this goal, “manual” should be passed as a value of the
“setTravelTime/source” field.

10 - "street level" adjustment

Not available – reserved for future use.
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Value

Description

11 - "externally estimated value provided
via API" adjustment

Travel estimation is based on the value that was updated using an API. This value can be
set via Core API (update activity). For this goal, “manual” should be passed as a value of the
“setTravelTime/source” field.

12 - same location

Travel was not calculated because the location is the same based on address or geocode. (Travel =
0)

13 - statistics (not-ordered, bucket, notscheduled)

Travel estimation only used the Statistical Learned estimation. In this case the origin location of the
travel is still unknown and the application estimates an average traveling time value. A presence of
these estimations is important for capacity management.

14 - company default value (notordered, bucket, not-scheduled)

Travel estimation used the company default found in “Configuration - Statistics”. In this case the
origin location of the travel is still unknown.
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About the Integration
Customer field personnel, such as dispatchers and technicians, can enable integration between Oracle Service Cloud, Oracle
Knowledge Advanced Cloud, and Oracle Field Service Cloud in order to access the Oracle Knowledge Advanced Cloud
knowledge base content within their Oracle Field Service Cloud application.
Quick answers to customer questions or other information on activity-related topics can then be found without having to leave
the Oracle Field Service Cloud application.
Prerequisites
Complete these prerequisites:
• The administrator or web developer must first complete the steps found in: Administration Steps to Configure
Oracle Service Cloud Customer Portal for Oracle Knowledge Advanced Integration with Oracle Field Service
Cloud . For more information, see the Knowledge Base article Configuring Oracle Service Cloud Customer Portal
for Oracle Knowledge Advanced Integration with Oracle Field Service Cloud .
• You must have an implementation of Oracle Service Cloud and Oracle Knowledge Advanced Cloud configured within
Oracle Service Cloud, and Oracle Field Service Cloud installed and configured.
• You must own a license to use Oracle Knowledge Service Cloud in order to integrate Oracle Knowledge Service
Cloud with Oracle Field Service Cloud.

Related Topics
• Access Oracle Knowledge Service Cloud in Core Manage Cloud Service
• Access Oracle Knowledge Service Cloud in Mobility Cloud Service
• Configure Access Settings
• Enable Access

Configure Access Settings
Before using Oracle Knowledge Service Cloud, you must configure several basic settings in Oracle Field Service Core
Manage Cloud Service.
To complete the setup process, you need a user name and password. Contact your Oracle Support representative for
assistance.
1. In Oracle Field Service Core Manage Cloud Service, go to Configuration > User Types .
2. Select a user type, and then select the Screen configuration tab.
3. Select Company Configuration from the list of contexts.
4. In the Actions pane, select Oracle Knowledge. If Oracle Knowledge does not appear in the list of actions, click
Click to add to find and add it.
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5. On the Add action screen, add a new Oracle Knowledge read/write visibility.
6. Click Close.
7. Click Configuration to return to the Configuration screen.
The Oracle Knowledge icon now displays in the Subsystems and Integrations section.
8. Click the Oracle Knowledge icon.
The Oracle Knowledge configuration screen displays, as shown in this figure:

The screen contains two sections:
◦ Knowledge access— complete these fields:
- URL: The URL to access the knowledge base.
- User Name: User name is a concatenation of your Oracle Field Service Cloud user name
and the string &p_li_passwd followed by the value of PTA_SECRET_KEY. For example,
'john.smith&p_li_passwd=ThisIsASecret'.
- Password: Your Oracle Field Service Cloud password.
Knowledge
fields mapping— provides the possibility to �onfigure the parameters of the context search and
◦
filtering, based on activity properties.
Note: By default, the fields in this section are not used, and configuring these properties is optional.
If you don't make any selections, no context search will be executed. You can, however, specify
your search criteria manually on the Oracle Knowledge page.
9. Select the desired search, category, and product properties from the drop-down lists.
10. Click Save.
The search engine uses the value of the selected search activity property as an initial search query to scour the Oracle
knowledge base. The results of the search are then filtered by the selected category and product activity properties.
Subsequently, the Oracle Knowledge page will show those information articles relevant to the parameters of the current
activity when opened.
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Related Topics
• About the Integration
• Access Oracle Knowledge Service Cloud in Core Manage Cloud Service
• Access Oracle Knowledge Service Cloud in Mobility Cloud Service
• Enable Access

Access Oracle Knowledge Service Cloud in Mobility Cloud
Service
Click the Knowledge tab on the Activity details screen to access Oracle Knowledge Service Cloud in Oracle Field Service
Mobility Cloud Service, as shown in this figure:

When you click the Knowledge tab, the Oracle Knowledge Service Cloud screen displays the knowledge articles relevant to
the activity from which you accessed them.
These articles are a result of the context search that is based on the activity-related search parameter and filters configured
on the Oracle Knowledge configuration screen. The search field located on the top of the page displays the search query
that was used for the current search, based on the configuration settings. You can enter a new query or change the filter
parameters to refine the search.
If no prior search configuration has taken place, the screen displays an empty search field without any search results.
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Related Topics
• About the Integration
• Access Oracle Knowledge Service Cloud in Core Manage Cloud Service
• Configure Access Settings
• Enable Access

Access Oracle Knowledge Service Cloud in Core Manage
Cloud Service
You access Oracle Knowledge Service Cloud in Oracle Field Service Core Manage Cloud Service by clicking the Knowledge
tab on the Activity details screen, as shown in this figure:

When you click the Knowledge tab, the Oracle Knowledge Service Cloud screen displays the knowledge articles relevant to
the activity from which you accessed them.
These articles are a result of the context search that is based on the activity-related search parameters and filters configured
on the Oracle Knowledge configuration screen. The search field located on the top of the screen displays the search query
that was used for the current search, based on the configuration settings. You can enter a new query or change the filter
parameters to refine the search.
If no prior search configuration has taken place, the screen displays an empty search field without any search results.
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Related Topics
• About the Integration
• Access Oracle Knowledge Service Cloud in Mobility Cloud Service
• Configure Access Settings
• Enable Access

Enable Access
After you configure Oracle Knowledge Service Cloud in Oracle Field Service Core Manage Cloud Service, create the
Knowledge tab on the Activity details screen to provide access to the feature in Oracle Field Service Core Manage Cloud
Service and Oracle Field Service Mobility Cloud Service.
1. In Oracle Field Service Core Manage Cloud Service, go to Configuration > User Types .
2. Select a user type, and then select the Screen configuration tab.
3. Do one (or both) of these:
a. Go to Step 4 for Oracle Field Service Core Manage Cloud Service.
b. Go to Step 5 for Oracle Field Service Mobility Cloud Service.
4. Do these to add the Knowledge tab to Oracle Field Service Core Manage Cloud Service:
a. In the Manage section, click Add activity/Activity details.
b. In the Layout structure pane, first click Activity status, and then click Group.
c. On the Add to group window that displays, enter a name for the tab.
d. Select Predefined Tab as the type, and then select Knowledge as the tab type.
e. Click Submit.
f. On the new activity screen that displays, add a new read-write visibility and click Save.
Your changes are saved and all current activities are automatically recalculated.
5. Do these to add the Knowledge tab to Oracle Field Service Mobility Cloud Service:
a. In the Mobility section, click Edit/view activity.
b. Find (or search for) Knowledge/activity_knowledge in the Actions section and drag-and-drop it to the
desired location in the set of tabs on the right.
c. Ensure that the visibility setting is read-write, and click Save.
Related Topics
• About the Integration
• Access Oracle Knowledge Service Cloud in Core Manage Cloud Service
• Access Oracle Knowledge Service Cloud in Mobility Cloud Service
• Configure Access Settings
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Daily Extract
Daily Extract is used to report on the main Oracle Field Service Cloud entities, such as activities, inventory, and messages, for
storage and further analysis. Extracted data is stored in the Daily Extract Database as a package of XML files. You can create
or update a Daily Extract configuration by importing the configuration from an external source.
Configure Daily Extract
The set of files to be extracted by Daily Extract can be configured manually at the implementation stage. At a later stage
they can also be modified when necessary. In addition, you can also configure custom Daily Extract file sets in the Manage
Application screen. Access to the Daily Extract configuration functionality is controlled by adding a read/write visibility to the
User Type that requires access to the Daily Extract report.

Daily Extraction Files
Daily extract files are the result of data processing by the application and contain the details such as activities, inventory, and
messages. Only data structures described in this document can be received as part of the Daily extract. To get access to
other data elements of the application, different interfaces should be used (e.g. Resource Management API). The extracted
files are intended for reporting and historical analysis of the events in the application.
Extraction Period
Daily extract files are typically generated once a day and contain all data the processing of which has been finished since the
previous extraction. If the company does not support overnight shifts, the extraction period covers time since the previous
extraction and till the end of the previous day. If the company supports overnight shifts, the daily extract data for the previous
day are available for extraction after the overnight expiration, that is, at 00:00 AM + overnight. If the data is extracted before
that time, the resulting files contain data of two days before.
A company can operate in several time zones, however, the Daily Extract functionality extracts data according to the time
zone defined for the company in the Business Rules. Only these files are extracted in GMT:
• General Message Details
• Message Text Details
• PAS Answer Details
• Gpstracks Details
Upon the first extraction all available data is collected. The maximum Daily Extract archive file size supported is:
• For archive with .xml files - 5 GB
• For archive with property files - 5 GB
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Create Daily Extract Files
You use the Daily Extract files to extract data from OFSC to store, analyze, and report on events. You can extract data related
to activities, inventory, and messages. The Daily Extract function can only receive data structures that are described in this
document. To get access to other data elements of the application, you must use different interfaces such as, Resource
Management API. You can use the extracted files for reporting and historical analysis of the events in the application. You can
configure the files to be extracted by the Daily Extract report manually at the time of implementing the application. The daily
extract files are always created in XML format.
1.
2.
3.
4.

Log in to Oracle Field Service Cloud Manage interface.
Select the Navigation button.
Click Configuration.
In the Outbound Integration section, click Daily Extract.
The Daily Extract screen appears. The screen displays the list of files for extraction organized as a grid. For each file
name the list shows the entity to which the extraction file is related (the Entity column) and the fields exported in the
file (the Exported field column).

5. Click Add new.
The Add configuration file window appears.
6. Enter the Table Name.
The table name must be in the {COMPANY_NAME}-company identifier format. The place holder
{COMPANY_NAME} is mandatory. If you specify an incorrect format, the file is not created.
7. Select the fields that you want to export from the Entity drop-down menu.
8. Click Submit.
The new file configuration is saved. When you edit the configuration, you can only edit the file name and not the
entity.

Choose Daily Extract Fields to Export
A new daily extract file is created empty and for the export to work, you must specify a minimum of two fields.
1. Click Configuration.
2. In the Outbound Integration section, click Daily Extract.
The Daily Extract screen appears.
3. Click the stack menu to the right and click Fields to add fields to the entity.
4. Click the plus icon and select the required field that you want to add to the entity.
5. Select a field to view its properties. Change the Name if required.
You can arrange the list of properties by dragging and dropping. You cannot change property names for the GPS
Track Fields, Type List Fields and Property File Fields entities. If a custom property is deleted from the application,
you must also delete it from the field list of any daily extract files; otherwise the extraction returns an error.
6. Click Ok.
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Extraction Files and Extraction Data Sets
Data on details of different entities processed during the extraction period or available by the end of extraction period can
be collected and extracted in the files (in this document during the extraction period means that if at any time during the
extraction period the entity was available in the system it will be extracted, and by the end of extraction period means that if
an entity was created at some time during the extraction period and was deleted before the end of extraction period, it will not
be extracted).
This data can be divided into data sets, that is, groups of details related to one and the same entity in the system. In some
cases data related to one entity is divided in several different data sets.
Note: Data from several data sets cannot be extracted in one file but data from one data set can be divided to
be extracted in any number of files. For example, the file created for the Activity Fields entity cannot also include
data for the Resource Fields entity. At the same time, one file can refer to several database tables according
to the exported field’s configuration. For example, an Activity Fields file may include data from the queue table,
when configured so.
these data sets are available for export. The actual list of data sets to be exported can be configured according to your
company preferences.
• Activity Fields – Data on all fields/properties assigned to activities that were to be performed or were performed.
• Activity Link Fields – Details of all links between activities defined in the application.
• Activity Work Skill Fields – Details of work skills per activity.
• GPS Details – Details of all GPS data gathered.
• Inventory Fields – Data on all fields/properties assigned to all inventory items available in the system.
• Message Details – Data on all messages generated during the extraction period divided into two data sets:
◦ Message Fields – Details on the messages excluding the actual text of the message.

◦

Message Text Fields – The text of each specific message.

• PAS Answers Fields – Details of the customer's answers to questions asked in the Post Appointment Survey that are
present in the system with status Delivered.
• PAS Questions Fields – Details of questions for Post Appointment Surveys.
• Property Fields – Details of all fields and custom properties available in the system.
• Property File Fields – Contents of file properties (images, etc.) available in the system.
• Property Lookup Fields – Sets of values that can be used to identify a field or custom property for all fields and
custom properties available in the system.
• Queue Fields – Data on all fields/properties assigned to routes that were to be executed during the extraction period,
including all fields and properties assigned to resources, to which a route is directly assigned.
• Resource Fields – Details of the properties of all resources available in the system (including inactive resources) and
their position in the Resource Tree.
• Resource Location Fields – Details of locations defined for each resource in the system.
• Resource Property Fields – Details of all properties defined for each resource in the system.
• Resource Work Skill Fields – Details of work skills per resource.
• Service Request Fields – Details of service requests created in the system.
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• Time Slots Fields – Details of time slots defined in the system.
• Type List Fields – Sets of values used to identify the type of entity by its ID for all types available in the system.
• User List Fields – Details of all users existing in the system.
• User-Resource Relation Fields – Details of the resources visible to each user as defined in the system.
Note: Daily Extract processes property labels regardless of whether any special symbols or capital letters are
used.

Configure a DBaaS Integration
Use the Outbound Integration icon to create a channel for DBaaS to transfer data in near real time to a DBaaS instance. The
data is transferred to the DBaaS instance when the events corresponding to the entities are triggered in Oracle Field Service
Cloud. Oracle Rest Data Service (ORDS) is used to standardize the data flow between Oracle Field Service Cloud and DBaaS.
1. Click Configuration.
The configuration page displays.
2. Click Outbound Integration.
The Outbound Integration Channels page displays.
3. Click Add Channel to configure a new channel.
The Add Channel page displays.
4. Select Database as a Service Access from the Channel Type drop-down list and fill up these fields:
a. Name: Enter a name for the channel.
b. Host: Enter the host name for ORDS. It can be an IP address or a domain name, and must start with https.
c. Schema Alias: Enter the schema alias configured for the target schema, which is used for generating the
ORDS end point. The value is same as the parameter p_object_alias in ORDS.enable_object. For PDBs, add
the PDB name (<PDB_Name>/<object_alias> ) <host_name>/ords/<schemaAlias>. For example, PDB1/
pdbadmin (For PDB).
d. User Name: Name of the user used for basic authentication. Make sure that the user has two roles, "SQL
Loader" and "oracle.dbtools.autorest.any.schema".
e. Password: Enter the password of the user used for basic authentication.
f. Confirm Password: Re-enter the password.
The screen now looks like this figure:
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A new DBaaS channel is created.
5. Click the DBaaS channel and click Add New to create an entity.
6. Specify the required details in these fields:
a. Entity: Select a list of Oracle Field Service Cloud fields that you want to view in the DBaaS instance.
b. Table Name: Enter the table name that you want to create in the DBaaS instance.
c. Data Transfer: Select one of these options:
- Once Daily: Data is transferred to the DBaaS instance once in a day as per the daily extraction period
configured in the system.
- Real-time: Data transfer from Oracle Field Service Cloud to DBaaS occurs in near real time.
7. Click Submit.
The entity is added to the channel with the specified details.

Modify an Existing DBaaS Integration
DBaaS connectivity is now available only through Oracle Rest Data Service (ORDS), so all new integrations connect through
ORDS. However, if you have an existing DBaaS integration, the application displays a note in the DBaaS connection widget
and on the Modify Channel page to change the configuration settings. Use this topic to understand how to modify your
existing integration to implement ORDS connection details.
1. Click Configuration.
The configuration page displays.
2. Click Outbound Integration.
The Outbound Integration Channels page displays.
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3. Click the stack icon for the DBaaS channel that you want to modify and click Modify.
The Modify Channel page displays, with a note at the Connection Method field, as shown in these figure:

4. Edit these fields:
Field Name

Description

Channel Type

The type of the channel you are modifying. The application populates this field and it cannot
be edited.

Name

The name of the DBaaS connection.

Connection Method

The connection method with which you want to connect to the database. Select Oracle Rest
Data Services.

Host

The host name for ORDS, which can be an IP address or a domain name. The host name
must start with https.

Schema Alias

The schema alias configured for the target schema, which is used for generating the ORDS
end point. The value is same as the parameter p_object_alias in ORDS.enable_object.
For PDBs, add the PDB name (<PDB_Name>/<object_alias> ) <host_name>/ords/
<schemaAlias>. For example, PDB1/pdbadmin (For PDB).
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Field Name

Description

User Name

The name of the user used for basic authentication. Make sure that user has two roles, "SQL
Loader" and "oracle.dbtools.autorest.any.schema".

Password

Password of the user mentioned earlier.

Confirm Password

Retype the password.

5. Click OK.
The channel details are modified to use ORDS.
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The Administrator Role
The Administrator plays an essential role in the application. The Administrator user type is assigned to an individual or group
of individuals who oversee the regular maintenance and updating of users, resources, calendars, and the Resource Tree.
Administrator is responsible for a combination of functions that can include:
• Managing users—Adding new users and inactivating users.
• Assigning user types to users. Resetting passwords.
• Managing the Resource Tree.
• Managing the Resource Calendars, Shifts, Teamwork.
• Working with work zones, work skills, work conditions, and work skills groups.
The Administrator user type is unique to each company and includes any combination of the responsibilities mentioned
earlier, depending upon the visibilities assigned to the user type. As a general rule, the user administrator:
• Has read/write access to the Web interface.
• Can manage user and resource related information.
• Can manage own account (password).
Note: This document covers all aspects of an administrator’s role. Based on your company’s configuration and
modules purchased, some of the functionality described in this document may not apply.
As an administrator, one of your key responsibilities is to manage user information. There are two primary types of users:
• Users who use the manage aspect, for example, dispatchers and field managers.
• Field service resources who use the mobility aspect, for example, field service personnel.
In either case, a user is someone who requires access to some part of the application’s interface.

Manage Users
You can set up users and maintain their accounts through the Users screen that opens from the Resource Settings dropdown menu. Much of the information that you enter will be standard, based on your company’s login and password policies,
but some will be unique to the user and to the role they will play in your configuration. The options included in this section of
the Guide include one-time activities as well as those that are updated periodically to conform to changes in the user’s role
as well as company policy. For example, if users persist in attempting to log in with an incorrect password, they will be locked
out of their accounts. This section describes how to unlock the account and reset the password.
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Access User Details
You can access user information to view the details and modify them.
1. Select the appropriate Resource level in the Resource Tree, for which you want to view the users. If you want to view
all users, select the highest level in the Resource Tree.
2. Click Resource Settings > Users .
By default, all the users that belong to the selected bucket, and their children are displayed. The Users screen
displays these columns:
Column

Description

Check box

Select the check box to activate links when you want to unlock, activate, deactivate, or set
user type for users.

User Name

The user’s actual name.

Login

The name used to log in to the application.

Resource

Resource record synched to the user account.

Status

Whether the user is active or inactive. A green tick mark indicates active and a red cross
mark indicates inactive.

Locked

Indicates the login state of the user:
Green indicates that the user is active and has logged in successfully.

◦
◦
◦

Yellow indicates that the user has entered a wrong password, but the account is not
yet blocked.
Red indicates either the user is inactive, or the account is blocked.

Language

Language assigned to user.

User type

The user type assigned to the user.

Last Login

Date/time stamp when the user last logged in to the application.

Main Resource

The resource that this user will use for telemetry and collaboration. This will, typically, be the
same as the resource.

Resource type

The resource type of the user, for example, Technician.

User classification

The classification assigned to the user—Contingent for contingent workforce, or Regular for
a regular user.

Collaboration Group

The collaboration group that the user is part of.

Operator of Helpdesk

Whether the user is an operator of a helpdesk.

3. Click View to add criteria for filtering the user list.

Activate, Deactivate, or Delete a User
You can control users’ access to the application by activating or deactivating them. Active users can log in and use the
application. Deactivated uses can be re-activated when needed. Deleted users are no longer available in the resource tree.
1. In the resource tree, select the user that you want to change the status for.
2. Click Resource Settings > Users .
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The User screen displays.
3. Select the check box next to the user that you want to change the status for.
4. Click the Activate, Deactivate, or Delete link located above the list of users.
5. Click OK.

Unlock a User Account
When a user makes too many unsuccessful attempts to log in, the account is locked.
These color codes indicate locked and unlocked users:
• When a user is active and logged in successfully, the account displays a green check mark in the Locked column of
the user account screen.
• When a user has unsuccessfully logged in a few times but has not yet locked the account, a yellow X displays in the
Locked column of the user account screen.
• When a user has unsuccessfully logged in too many times, the account will be locked. A red X displays in the
Locked column of the user account screen.
If the user forgot their password, you might also have to change their password.
1. In the resource tree, select the name for the user whose account is locked.
2. Click Resource Settings and then select Users in the drop-down menu.
The User screen displays.
3. Check the box next to the user whose account you want to unlock.
4. Click the Unlock link above the list of users.
5. Click OK.

Add a User
All system users must have user accounts.
The part of the resource tree that you choose when you create a user determines what the user can or cannot see when they
log in. For example:
• Let’s say you want to add a dispatcher who manages a bucket and the resources under the bucket. Select the
bucket to place the dispatcher so that the user can see only the bucket and the resources under that bucket.
• If you are creating a manager who may see the entire enterprise, select the parent level of the resource tree to add
the manager.
• If you are adding a technician resource, select just the technician in the resource tree, so that the user sees only their
individual routes.
To add a user:
1. From the resource tree, select the bucket or group to which you want to add the new user.
2. Click Resource Settings and select Users from the drop-down menu item.
The User table displays in the work area.
3. Click Add new.
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The Add new user window displays add window.
4. Complete the fields on the form.
Field name

Action

User Type

Choose a user type for this user.
The user type determines what the user can access within the application, the layout and
screen configuration.

Self-Assignment

Select this check box to enable this resource to add new activities to his or her individual
route.

Resource

Select the organization unit or bucket that the resource is in.
The option you select here determines which resources, groups, and buckets the resource
can view. This field is automatically populated with the group, or bucket that you selected in
the first step, but you can add or change the list of viewable resources, groups, and buckets
here. You must assign a user who has self-assignment permission directly to a bucket.
Users who can assign activities to themselves cannot be in groups.

Main resource

Click the pencil icon and search for the required resource. This setting establishes
the connection between the user and the resource ID, and is used in Telemetry and
Collaboration.

Login

Enter a user name for this user.

User name

Enter the user's first and last name.

Password

Enter an initial login password for the user.

Confirm password

Re-enter the user's initial login password.

Status

Select active or inactive.
Only active users can use the application.

Force password change at next login

Select this option to require the user to create a new password when he or she logs in for
the first time.

Language

Select the language that the user sees in the interface.

Phone Number

Enter the user's telephone number.

Time format

Choose the time format that the user will see and use in the interface. This can be either 12hour or 24-hour.

Date format

Choose the date format that the user will see and use in the interface. This can be either
month-day-year or day-month-year. The date format controls the display of dates in
numeric format.

Long date format

Choose how to display the long date to the user. A long date is a date that includes words.
For example, Wednesday, February 20, 2013.

Time zone

Choose a time zone for the user.

Design Theme

Choose a UI theme for this user.

Default export format

Choose the default data export format for this user. Options are CSV, XML and XLS.

5. Click OK.
If this user is also a resource, you must create a corresponding resource.

162

Oracle Field Service Cloud

Administering Oracle Field Service Cloud

Chapter 4

Administer Oracle Field Service Cloud

Reset a User’s Password
As a user administrator, one of the most common jobs you do is reset passwords. If a user is locked out, it is most often
because the user exceeded the maximum number of password attempts. Sometimes in addition to unlocking a user’s
account, you may also have to change their password.
1. Select the appropriate Resource level in the Resource Tree, for which you want to view the users. If you want to view
all users, select the highest level in the Resource Tree.
2. Click Settings > Users .
By default, all the users that belong to the selected bucket, and their children are displayed.
3. Search for the user whose password must be reset and click Change Password in the Action column.
4. Type in the new password in both the New Password field and the Confirm Password field.
5. Click OK to save the changes.

The Resource Tree
The resource tree provides a hierarchical view of your organization’s resources, typically sorted by geographical region. It
displays on the left side of the screen.
You can click the toggle button to show or hide the resource tree. When you select a resource from the resource tree,
the resource’s activities display in the work area on the right. Click the plus sign (+) next to an entity in the resource tree to
expand and view the entities under that group or bucket. Click the minus (-) sign to collapse that view.
The resource types and the overview of the roles performed by each item in the resource tree are:
• Field resource: This resource can perform work, has work skills, work zones associated, and has a related user that
is an actual person performing work or a crew or people.
• Vehicle: This resource can have work skills, inventory, and geolocation tracking enabled. When assigned to a team it
may add the required work skills and inventory to be used by the team.
• Tool: This resource represents specific tools such as 30-feet ladder and excavator. This resource can have work
skills, inventory, and geolocation tracking enabled. When assigned to a team it may add the required work skills and
inventory to be used by the team.
• Bucket: This resource is used to accumulate work that is not yet distributed to field resources. Only the application
can assign activities to this resource. This resource is used for Quota Management.
• Organization unit: This resource aggregates field resources, vehicles, and tools in the tree-like hierarchy to simplify
management and reporting. This resource is used for Quota Management.

Add an Organization Unit or a Bucket
You can use organization units to sort and organize the items in the resource tree. You can use buckets to hold the activities
that are not assigned to field resources.
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Difference between resource, user, and child resource: A resource can be a field resource (a human being), a vehicle, or a
tool. All resources are elements of the resource tree. A user is any user that has access to Oracle Field Service Cloud. A child
resource is a resource that is added to a bucket or an organization unit element of the resource tree. In the hierarchy of the
resource tree, the bucket or the organization unit appears at a higher level than the child resource. A child resource can be a
field resource (a human being), a vehicle, or a tool.
Organization units are typically used to group resources by location. Organization units cannot be route owners and activities
cannot be assigned to them. Buckets can have activities, and only Routing can assign activities to buckets. To add an
organization unit or a bucket:
1. In the resource tree, select the organization unit or bucket to which you want to add the new organization unit or
bucket.
2. Click Resource Settings.
3. Select Resource Info from the drop-down menu.
4. Click Add Child Resource.

The New resource info screen displays.
5. Complete the fields.
Field name

Action

Name

Enter the resource name the way you want it to appear in the resource tree.

External ID

Enter the ID number from an external system, such as the employee ID number. These IDs
are optional. If you use them, each resource must have a unique ID.

Status

Select active or inactive.
Active resources can use the application. Inactive resources cannot use the system.

Email address

Enter the resource's email address.

Phone

Enter the resource's telephone number.

Time format

Choose the time format that the resource will see and use in the interface. This can be either
12-hour or 24-hour.

Date format

Choose the date format that the resource will see and use in the interface. This can be either
month-day-year or day-month-year.
The date format controls the display of dates in numeric format.
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Field name

Action

Resource Type

Select Group or Bucket. The available fields on the screen change to display the relevant
fields.

Credence

Enter information about the resource that you want to provide to a customer.

6. Click OK. The new organization unit or bucket appears in the Resource Tree.

Designate Buckets for Capacity or Quota Management
After adding a bucket, you must select whether you want to use it for Capacity Management or Quota Management.
1. Click the bucket name in the Resource Tree.
2. Select the Use as Capacity Area check box.
The Routing profile, Capacity categories, and the Time slots fields appear.

Add Capacity Categories and Time Slots
If you designate a bucket as a capacity bucket used for quota calculation, then the screen displays the capacity categories
and time slots fields. The selections you make here determine how the Quota section appears. Configuring capacity
categories and time slots on a bucket-by-bucket basis is helpful when different regions and types of resources within these
buckets require different skills and time slots.
1. Click the bucket name in the Resource Tree.
2. Select the Use as Capacity Area check box.
The Routing profile, Capacity categories, and the Time slots fields appear.
3. Select the Time Slots that will be used for Quota Management in this bucket. Click the pencil icon next to the Time
Slots field.
The Edit Time Slots box appears.
4. Select the time slots that will be used for quota management for this bucket then click Save.
5. Select the Capacity Categories that will be used for Quota Management in this bucket. Click the pencil icon next
to the Capacity Categories field.
The Edit Capacity Categories box appears.
6. Select the capacity categories that will be used for quota management for this bucket. Click Save.
7. Select the level at which quota is defined in this bucket (i.e., day, time slot, capacity category).
This determines the visibility of the Day, Time slot, and Capacity category tables in the Quota view.
8. Select the levels on which quota can be closed in this bucket.
Note that quota can also be closed by work zone.
9. Select the levels for which maximum capacity should be estimated.
Maximum capacity is the maximum number of minutes for activities booking. The application checks that the total
duration of booked activities plus the total duration of other activities does not exceed maximum capacity.
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10. Click OK to save the bucket information.

Add a Resource
When a user is also a resource, you must create both a user account and a resource.
By default, the data in the Status, language, time zone, time format, and date format fields are copied to the Add User
for New Resource dialog when the resource type, Field Resource, Tool, or Vehicle is selected.
Difference between resource, user, and child resource: A resource can be a field resource (a human being), a vehicle, or a
tool. All resources are elements of the resource tree. A user is a field resource or any other user that has access to Oracle
Field Service Cloud. A child resource is a resource that is added to a bucket or an organization unit element of the resource
tree. In the hierarchy of the resource tree, the bucket or the organization unit appears at a higher level than the child resource.
A child resource can be a field resource (a human being), a vehicle, or a tool.
To add a resource:
1. In the resource tree, click the organization unit or bucket to which you want to add this resource.
2. Click Resource Settings and then select Resource Info from the drop-down menu.
The Resource Info screen displays.
3. Click Add Child Resource.
The New Resource info window displays.
4. Fill in the fields:
Field name

Action

Name

Enter the resource name the way you want it to appear in the resource tree.

External ID

Enter the ID number from an external system, such as the employee ID number. These IDs
are optional. If you use them, each resource must have a unique ID.

Phone

Enter the resource's telephone number.

Email address

Enter the resource's email address.

Status

Select active or inactive.
Active resources can use the application. Inactive resources cannot use the system.

Resource Type

Select a resource type. Resource types are configured by your organization. Typical
resource types are Bucket, Group, Technician, and Tool. For the resource types Technician
and Tool, the Add User for New Resource dialog displays.

Organization

The organization to which the resource belongs. If you are adding a bucket or an
organization unit, select the organization or organization unit that the bucket or group
belongs to. You cannot select the organization for a technician; it is derived from the parent
bucket or group.

Time format

Choose the time format that the resource will see and use in the interface. This can be either
12-hour or 24-hour.

Date format

Choose the date format that the resource will see and use in the interface. This can be either
month-day-year or day-month-year.
The date format controls the display of dates in numeric format.
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Field name

Action

Initial ratio for activity duration

Indicates the percentage by which the company-wide estimations will be multiplied to get
the estimated duration at the resource level for new activities. This ratio will be applicable
only for those activities that are relatively new to the resource and there is no significant past
data.
The field is displayed only if these conditions are met:
The Personalize the estimation of activity duration field is selected in the Add/
Edit Resource Type screen.
The field is added for your user type from the Configuration, User Types, Screen
Configuration tab.

◦
◦

these conditions apply to this field:
You can edit this field only if the resource has not completed any activity. Once
activities are reported, the ratio gets modified based on the reported durations.
For existing resources for which this field was not set during resource creation, this
field is read-only with a initial value of 100%.
The value of this field is modified regularly based on the durations reported for
relatively new types of activities. The updated value displays as read-only.

◦
◦
◦

Working days left for reported data
to start impacting company level
duration estimation

This field displays the number of days left until the resource starts affecting the company
averages, and it is based on the settings on resources type. This is a countdown value
and it decreases by one everyday. The resource starts affecting the company average only
when the value of this field reaches 0 (zero). This field can be edited till the value reaches 0
(zero), after that the field is not displayed. This field is displayed only if the Use durations
reported to enhance company-wide estimations field is selected in the Add resource
type screen.

Related Topics
• Associate a Resource with a User Account

Rules for Removing Inactive Resources
Resources that have an inactive status for more than 12 months are automatically removed from the application to improve
performance and remove clutter from the resource tree.
these rules are applied to remove the resource:
1. Resource Type Role = ‘Field Resource’, ‘Vehicle’ or ‘Tool’ will be deleted and removed if:
◦ resource has inactive status

◦
◦
◦
◦
◦
◦

resource was last updated more than 12 months ago
resource does not have activities in future days (non-scheduled activities, teamwork, and so on)
resource is not used in visibility conditions in User types configuration (via ‘pid’ or ‘external_id’)
resource is not used in blocking conditions of Message steps (via ‘external_id’)
resource is not used in conditions of Filters (via ‘external_id’)
resource does not have related user whom ‘uid’ is used in visibility conditions in User types configuration

2. Resource Type Role = ‘Bucket’ or ‘Organizational Unit’ will be deleted and removed if:
◦ resource has inactive status
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resource was last updated more than 365 days ago
- any field/property for resource was changed
- resource calendars were changed
- resource work zones were changed
- resource locations were changed
- resource inventories were changed
- resource time slots were changed
- resource capacity categories were changed
- resource routing profiles were changed
- visibilities between users and this resource were changed
resource does not have any children
resource does not have activities in future days
resource is not used in visibility conditions in User types configuration (via ‘pid’ or ‘external_id’)
resource is not used in blocking conditions of Message steps (via ‘external_id’)
resource is not used in conditions of Filters (via ‘external_id’)
resource does not have related user whom ‘uid’ is used in visibility conditions in User types configuration

Update means:
• any field or property for resource was changed
• resource calendars were changed
• resource locations were changed
• resource work zones were changed
• resource inventories were changed
• resource associated as Field Resource for some user
• visibilities between users and this resource were changed

Associate a Resource with a User Account
Adding a resource to the Resource Tree does not automatically give login access to the user. To activate their routes and
provide status for their work, these new users must log in like any other user. Use this procedure to understand how to
associate a new resource with its corresponding user account.
If you are adding a child resource of type Technician (or something similar configured by your organization), the fields listed in
step 3 are displayed on the New resource info dialog itself. In that case, you can skip steps 1 and 2.
1. Select the appropriate Resource level in the Resource Tree that contains the user that you want to modify.
2. Click Resource Settings > Users .
3. Complete these fields:
Field

Description

User Type

Select the user type associated with this resource. The user type is group of rules and
visibilities that can be applied to a user or group of users.
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Field

Description

Login

This is the name that appears when the user logs in.

User Name

Name used for login (company standard should be defined).

Password

Type a new password that meets your company’s standards.

Confirm Password

Enter the same password as above to confirm the correct password.

Force password change at next login

Select this check box to force the new user to change his/her password.

Language

Select the user’s preferred language from the drop-down menu of choices.

Long date format

Select the way in which you wish to display the long date to the user.

4. Click OK.
The resource is added, synchronized with a user record, and displayed on the Resource Tree within its parent
location.
After you have added a new resource, you must add the work skills, work zones, and Calendar.

Configure Activity and Resource Hints
Activity hint is a context menu that is displayed when you click an activity on the List, Time, or Map view. Similarly, resource
hint is displayed when you click a resource in the resource tree. These menus can include static text such as activity type
or capacity category and buttons for actions such as adding or starting an activity. The menu can also include links to open
forms and plug-ins.
1.
2.
3.
4.

Click Configure > User Types .
Select the type of user for which you want to configure the hint and click Screen configuration.
Expand Application screens.
To add an activity hint, locate Activity hint in the Dispatch Console tree and click it. To add a resource hint, locate
Resource hint in the Main menu tree and click it.

The Context layout structure opens for the selected hint. This screen displays two sections—Layout structure
and Actions.
5. Click Click to Add in the Layout structure section and select the required items.
The items in the Layout structure are static text items.
6. Click Click to Add in the Actions section.
The Add action screen appears and displays these options:
◦ Standard action screen: Lets you add standard actions such as Activate route, Add child resource, and so on.

◦

Plugins: Lets you add plug-ins. The plug-ins that you have added on the Forms & Plugins screen are listed
here.
◦ Custom forms: Lets you add custom forms. The Forms that you have added on the Forms & Plugins screen
are listed here.
7. Select one of the three options and then select the required item in the Available list.
8. Click OK.
The properties of the newly added item are displayed.
9. Click Add new visibility.
Read-only is selected by default on the [item] visibility screen.
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10. Click Conditions and add any conditions based on which you want to display the link.
11. Click Save.
The new item or link is added to the hint. The item will be displayed when the user refreshes the application, or logs
in to it the next time. To add a hint in Oracle Field Service Core Manage Cloud Service, expand Legacy Manage in
Step 3 and follow the remaining steps.

Configure Time and List Views
You can configure the columns that display on the Time and List views to suit your business requirements.
1.
2.
3.
4.

Click Configure > User Types .
Select the type of user for which you want to configure the views and click Screen configuration.
Expand Application screens.
Click List view columns in the Dispatch Console tree.

The Context layout structure opens and displays the default items available on the screen. You can more static
text or action items to it.
5. Click Click to Add in the Layout structure section and select the required items.
The items in the Layout structure are static text items.
6. Click Click to Add in the Actions section.
The Add action screen appears and displays these options:
◦ Standard action screen: Lets you add standard actions such as Activate route, Add child resource, and so on.

◦

Plugins: Lets you add plug-ins. The plug-ins that you have added on the Forms & Plugins screen are listed
here.
◦ Custom forms: Lets you add custom forms. The Forms that you have added on the Forms & Plugins screen
are listed here.
7. Select one of the three options and then select the required item in the Available list.
8. Click OK.
The properties of the newly added item are displayed.
9. Click Add new visibility.
Read-only is selected by default on the [item] visibility screen.
10. Click Conditions and add any conditions based on which you want to display the link.
11. Click Save.

The new item or link is added to the hint. The item will be displayed when the user refreshes the application, or logs
in to it the next time. To add a hint in Oracle Field Service Core Manage Cloud Service, expand Legacy Manage in
Step 3 and follow the remaining steps.

Provide Access to the Required Inventory Screens
You must provide access to the desired resources for the Required Inventory screens, so that the resources can add, edit,
and delete Required Inventory.
1. Follow these steps to provide access to the Add Required Inventory screen:
a. Click Configuration, User Types.
b. Select the user type for which you want to provide access.
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Click Screen configuration.
Locate and click Inventory grid.
Click Click to add. Search for and select Add to Required.
Click OK.
Click Add new visibility and then click Save.

The Add to Required button is added to the Inventory list on the Activity details screen.
2. Follow these steps to provide access to the Edit required inventory and Delete required inventory screens:
a. Repeat the steps a to c mentioned earlier.
b. Click Edit required inventory.
c. Add a button and select the Edit required inventory screen. Similarly, add a button and select the Delete
required inventory screen.
d. Click OK and then click Save.
The Edit required inventory and Delete required inventory buttons are added to the Inventory list on the
Activity details screen.

Configure the Inventory Identifier Context Layout Structure
Screen
You must configure the Inventory identifier Context Layout Structure screen to view the inventory details on the Inventory
screen.
1. Click Configuration > User Types .
2. Select the User Type for which you want to configure the Inventory identifiers screen.
3. Expand Application screens and click Inventory identifier.
The Inventory Identifier Visual Form Editor appears.
4. To add a new column to the inventory table, add a new property.
5. Click Add new visibility and add rules to hide or show the columns.
6. Change the order of properties to the order in which you want to display the columns of the table.
The columns are added to the inventory table.
7. Click X or Close.
These rules apply to the columns that you configure here:
◦ The columns of the table don't support custom styles.

◦
◦
◦
◦
◦
◦
◦

The column order corresponds to the order you have configured here.
If a column name is longer than the column width, then the full name shows as a tool tip.
If there are more columns than can be shown on the screen, the horizontal scroll bar appears.
By default, Quantity is shown as the extreme right column and is fixed on the right side of the screen, if there
is a scroll bar.
Required inventory displays first with the columns Inventory type, Inventory Model, Missing Quantity, and
Quantity. You cannot configure the columns for this section.
Pool statements are expanded by default and saved after you collapse or expand them.
You can hide the columns using the visibility conditions on the 'Inventory identifier' context layout, if there is no
value.
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Resource Entities
The ongoing management of resources typically involves managing one or more entities described in this topic.
Calendars, Work Schedules, and Shifts – This involves creating calendars that illustrate when a resource is available for work
and when he/she is off duty. Between calendars, work schedules, non-working time, internal activities, holidays, and shifts,
there is a great deal of flexibility available in the application. Some parameters can be set in advance for planning, and others
are considered more day-to-day adjustments.
Work Skills –This refers to the correlation between what is required to complete incoming activities, and which resources have
the capabilities to accomplish them.
Work Zones – This refers to the area within which a resource is able or allowed to travel to complete activities.

Time Zones
When you configure the application, it is possible to set different time zones for a user and for a resource. These time zones
are used in different contexts on different screens. This topic gives an overview of how time zones are displayed throughout
Oracle Field Service Cloud.
Today's date
The time zone of the currently logged in user is used when determining the today's date. For example, if it is 1:00 PM, Jun 10
in a UTC+00:00 time zone and you log in as a user who is in UTC+12:00 time zone, then after logging in you will see that the
current date is set to Jun 11. This is because, in the user's time zone it is already 01:00 AM, Jun 11. Today's date is used as
the initial date on these screens in Oracle Field Service Core Manage Cloud Service: Activities, Daily, Offline synchronization,
Dashboard, and Print route. For example, on the "Activities" screen, it is the date for which the activities will be shown after
you log in to the application. You can change the date on these screens to see the information for another date. Nevertheless,
when you click the date field, the calendar widget shows you today's date in light blue color. This figure shows the calendar
with today’s date highlighted:
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The same behavior is present in Oracle Field Service Mobility Cloud Service. When a field resource logs in, today's date is
marked with light red color on the date selection panel in the header, as shown in this figure:

When a field manager looks at the Calendars screen in Oracle Field Service Mobility Cloud Service, then today's date is
marked in blue, as shown in this figure:
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The same date is used in Oracle Field Service Core Manage Cloud Service when searching for activities "starting today".
Current date of the resource
The current date of the resource is always determined in the time zone of the resource. You can activate the route and start
an activity only on the current date of the resource time zone.
Changing past activities
Every instance has a specific time when all the data that is related to the previous day is frozen and can't be changed any
more. This time is configured on the Business Rules screen in the Overnight work section, shown in these figure:

For example, you have configured that the working time is 5 hours since midnight in the Eastern time zone. This means that
at 5:00 AM in the Eastern time zone all data for the previous day becomes frozen.
Important: If you configure an instance to use in several time zones, you must set the time zone on the
Business Rules screen to the most "western" time zone. If the work is performed several hours after midnight in
this most "western" time zone, then you must also specify the number of hours after midnight.
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Time view in Oracle Field Service Core Manage Cloud Service
The screen Activities > Time can display aggregated information for the hierarchy of resources. The information is
presented in the same time zone to look consistent on the time line. The time zone is determined as the time zone of the
resource selected in the resource tree on the left of the screen. The current time which is shown as a red vertical line is also in
the time zone of the selected resource, shown in this figure:

Note: The only exceptions are the resource hint, activity hint, and activity label. Information on the resource hint
is displayed in the time zone of the resource this hint belongs to. Information on the activity hint and activity label
is displayed according to the rules described in the Activity related information section later in the topic.
Manage screen in Oracle Field Service Mobility Cloud Service
The Manage screen in Oracle Field Service Mobility Cloud Service shows the information similar to the Activities > Time
screen. The difference is that there is no resource selected in Oracle Field Service Mobility Cloud Service. The information is
shown for the list of resources identified as a group, and the group is configured by a user. Since it is not possible to identify
which resource time zone should be used as the primary time zone, the time zone of the currently logged in user is used
instead.
Note:
• The only exceptions are the resource hint, activity hint, and activity label. Information on the resource
hint is displayed in the time zone of the resource this hint belongs to. Information on the activity hint and
activity label is displayed according to the rules described in the Activity related information section later
in the topic.
• When a user opens the non-scheduled or non-ordered activities on the right of the screen, the activity
identifier shows information according to the rules described in the Activity related information section
later in the topic.
Organizations with multiple time zones
If your organization operates in multiple time zones, it is important that you configure both, the field resource and activity time
zones correctly. Configuring these time zones is even more important if they are different. A field resource sees all the data
in their own time zone, but when the activity (customer) is in a different time zone, both times are shown as appropriate. The
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activity time zone is used for notifications and can be used in APIs (for example, for sending messages). Typically, the time
zone of a physical location is used for notifications, but you may use your preferred time zone, such as your headquarters
time zone or any other in which you prefer to get notifications.
Resource related information
Information that is related to a resource and the resource’s route is entered in the resource time zone. It includes:
• Route Status (queue_status) which includes the time when route was activated
• Reactivated (reactivated)
• Resource working hours (calendar)
• Resource on-call hours (oncall_calendar)
Time view shows this information differently in Oracle Field Service Core Manage Cloud Service and Oracle Field Service
Mobility Cloud Service. See the earlier sections for more details.
Activity related information
Time related information on an activity is displayed and entered in the time zone of the resource for which the activity is
assigned. This information includes:
• Start (ETA)
• End (end_time)
• Start - End (eta_end_time)
• Delivery window (delivery_window)
• Activity Time of Booking (atime_of_booking)
• Activity Time of Assignment (atime_of_assignment)
The only exceptions are:
• Time slot or service window (depending on what is used for the particular activity type)
• SLA window
These properties are either in the resource time zone or in the customer time zone. It depends on the SLA and Service
window use customer time zone field set on the activity type. Time view shows this information differently in Oracle Field
Service Core Manage Cloud Service and Oracle Field Service Mobility Cloud Service. See the earlier sections for more details.
User related information
All user related information is shown in the time zone of the user. It includes:
• When the user was registered
• When the user was updated
• When the user logged in last time
• When the user changed his password
• Date and time till when the user is blocked
Field Collaboration
Each message in Field Collaboration includes the time when it was sent. This time is shown in the time zone of the currently
logged in user.
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Change a Resource’s Organization
You can change the Organization for bucket and Organization unit resources. Resource types such as field resources, tools,
and vehicles inherit their parent’s Organization.
1.
2.
3.
4.

Select the resource in the resource tree.
Click Resource Settings > Resource Info .
Locate the Organization field and select the desired Organization.
Click OK.
The resource is displayed under the selected Organization in the resource tree.

Provide Access to Group Actions for Resources
You can provide access to users to select multiple users of a user type to perform actions such as deactivate, unlock, delete,
or activate.
If a user doesn’t have the permissions to change the resources or users of a particular User type, then the user can't select
such resources or users. Verify the Can create users of the following user type setting on the Configuration > User
Types > General screen.
1. Click Configuration > User Types .
2. Select the user type for which you want to provide the access.
3. Go to the Screen configuration tab and click Resources under Application screens.
4. Click Click to add and select Activate, Deactivate, Delete, Set Collaboration Group, and Unlock.
5. For each button that you just added, click Add new visibility and then click Save.
The Activate, Deactivate, Delete, Set Collaboration Group, and Unlock buttons are displayed on the
Resources screen, when a user with this permission selects a resource.

Calendars, Work Schedules, and Shifts
Whether they are set at the organization unit, bucket or resource level, overall calendar options are made up of combinations
of work schedules, shifts, working, and non-working time. Ultimately they represent a holistic view of who is available or not
available for work at any given time on any given day.
Here are a few rules regarding the hierarchy of calendars in general, and their levels of precedence:
• Work schedules, shifts, and working time applied to a bucket or an organization unit will, by default, also apply to all
resources that fall under that bucket or organization unit.
• Calendars created or adjusted at a lower level will override the calendar at a higher level. In other words, what is set
up at a resource level overrides that which the resource may have inherited from its parent entity. However, the work
schedule defined at the child level doesn't override the non-working time defined at the parent level.
• A calendar at the individual resource level will apply only to that resource and will override all other calendars.
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To better understand calendars and their potential components, we must define the different options. The components of a
calendar are:
• Work Schedules - Work schedules contain multiple shifts and non-working times and are the mechanisms for
grouping these items so that they can be applied to a single resource or an entire organization unit or a bucket. Work
schedules represent the highest level of calendar options.
• Shifts - Shifts are used to define the different working times as defined by a given organization. They can be
created once and used by a variety of work schedules, simplifying the assignment of schedules. In addition to work
schedules, shifts can also be assigned directly to organization units, buckets or resources.
• Working Time – The time frame in which a resource is scheduled to work that does not comply with one of a
company’s standard shift definitions.
• Non-working Time - Non-working time is used to identify known absences such as bereavement, illness, holidays
and vacations.
Earlier portions of this guide covered the creation of work schedules, shifts and non-working time; therefore this section will
concentrate on assigning those calendar options to entities on the Resource Tree (organization units, buckets, resources).
While the process is the same for each – depending on the selection made from the Resource Tree – the implications differ.
This ties back in with the explanation of the calendar hierarchy.
When associating calendar options with higher-level entities (organization units, buckets), their child resources assume the
same options. However, if options are set at the resource level, they take precedence over their inherited settings. For the
purpose of this guide, the steps for building calendars at the resource level will be covered. The steps will be the same for
organization units and buckets – simply select them from the Resource Tree instead of individual resources.

Add a Work Schedule or a Shift
You can assign a work schedule or a shift to a resource, bucket, or group. You can also define the on-call schedule of a
resource using the Calendar view.
1. Click the hamburger icon and click Calendars.
The calendar appears for the resources in your group or bucket.
2. For the resource for which you want to modify the calendar, click the shift for the required date.
The modify calendar dialog appears for the selected resource and date.
3. To change the work schedule or shift for the resource, update these fields:
Name

Description

Schedule

This list includes work schedules and shifts. Select the work schedule or shift that you want
to apply to the resource.

End date

The date on which the new work schedule or shift ends. If you want to apply it for an
indefinite time, click No date specified.

4. To add the details of on-call for the resource, click On-Call and update these fields:
Name

Description

On-Call Schedule

The field that specifies that the resource is on-call. Select On-Call. An On-Call shift visually
shows the resources that are available to be contacted outside of a regular working
shift. On-Call shifts that are not activated are not used in routing optimization or capacity
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Description
calculations. However, when an on-call shift is activated, routing can assign activities to the
resource.

Repeat for

The number of days for which the resource will be on-call, starting from the day that you
have selected in the calendar earlier. The dates for which the selected schedule applies
appear at the bottom.

5. Click Submit.

Add a Shift to a Resource's Calendar
Shifts are standard patterns of working time. They determine when a resource is available for work. Shifts applied at the
resource level override the shifts applied at a higher level in the resource tree.
1. Select a resource from the resource tree.
2. Click Resource Settings > Resource Calendars .
The Resource Calendars screen displays.
3. Click the gear icon and select Add shift from the drop-down menu.
The Add Shift window displays.
4. Complete the fields.
Field name

Action

Shift

Select a pre-configured shift from the drop-down list.

Start date

Select the start date of the shift.

End date

Select the end date of the shift, if applicable.

Comments

Enter comments, if any.

Recurrence-Repeats-Daily

Apply to schedules such as every other day or every 3rd day. If you select this option, add
the frequency of occurrence in the field Days between occurrences.

Recurrence-Repeats-Everyday

Applies to every day schedules that repeat without exception and without any modification
options.

Recurrence-Repeats-Weekly

Apply calendars that have a regular weekly pattern. Select the days that apply to this shift
using the check boxes for the individual days. Indicate the frequency of this pattern weekly
by adding a value to the Weeks between occurrences field.

Recurrence-Repeats-Yearly

Occurs every year from the selected date entered in the From day until the date entered in
the To day field.

5. Click OK.

180

Oracle Field Service Cloud

Chapter 5

Administering Oracle Field Service Cloud

Resources

Add Working Time to a Calendar
Working time differs from shifts in that it represents start and stop times that may differ from the pre-defined shifts. Use
working time when resources work a different number of hours than they normally do or when they work at a different time of
the day than the other resources.
1. Click the hamburger icon and click Calendars.
The calendar appears for the resources in your group or bucket.
2. For the resource for which you want to modify the calendar, click the shift for the required date.
The modify calendar dialog appears for the selected resource and date.
3. Fill up these fields:
Field name

Action

Schedule

Select Custom Working Time from the drop-down list.
Note: You can create only one on-call shift per day. If you create a second oncall shift, the first one is deleted. You can remove an on-call shift, if you assign a
schedule for a resource. You can't remove an on-call shift, if you assign a regular
shift, custom working time, or non-working time.

Time From

Enter the time when the resource's work is to begin.

Time

Enter the time when the resource's day ends.

Points

If you are using points to cap activity assignments, you can enter them here. These points
work the same way as points associated with a shift.

Repeat for

Number of days starting from the day selected on the calendar to which the new working
time applies. The start and end dates of the new schedule are displayed below the field.

this figure shows the dialog where you add the custom working time:

4. Click Submit.
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The new schedule is displayed on the calendar.

Add Non-Working Time to a Calendar
Use non-working time to identify times when a resource, an organization unit, or a bucket is not available for work.
1. Click the hamburger icon and then click Calendars.
The Calendar view appears for the group or bucket assigned to you.
2. Select the bucket, group, or resource for which you want to change the calendar.
3. Click the date for which you want to add the non-working time.
4. To add non-working time for the resource, click On-Call and update these fields:
Name

Description

On-Call Schedule

The field that specifies that the resource is not working. Select Non-Working Time.

Reason

The reason for which the resource is not working.

Repeat for

The number of days for which the resource will not be working, starting from the day that
you have selected in the calendar earlier. The dates for which the non-working time applies
appear at the bottom.

5. Click OK.
If the non-working time can be applied, the resource is marked as a non-working resource for the selected date
range. If the non-working time can't be applied, a warning message appears. If you click OK, the non-working time
is applied, but a warning message appears on the resource tree for that resource on that day. Non-working time
can't be applied if the technician has anything other than repeating, shift, or mass type of activities assigned on this
route. The activities on the resource’s route, other than mass and repeating activities, are rerouted or assigned to the
bucket, if these conditions are met:
◦ The routing plan has the Enable reoptimization check box selected.

◦

The resource meets the routing plan filter conditions.

Delete Items from a Calendar
When you want to remove a work schedule, shift, working time, or non-working time, or override an item from a resource’s
calendar, you can delete it.
Note: When you delete an item from a resource calendar, the resource reacquires any like items that are set
at a higher level. For example, if you delete a work schedule from a calendar, the resource reacquires the work
schedule of it's bucket or group.
1. Select a resource from the resource tree.
2. Click Resource Settings > Resource Calendars .
The Resource Calendars screen displays.
3. Click the check box next to the item that you want to delete and then click Delete.
4. Click OK.
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Use Filters in Daily View
The Daily View helps dispatchers or managers manage resource calendars efficiently. It provides a weekly calendar
snapshot for the selected resource, bucket or group.
You can view a separate calendar by day for each resource or you can view a calendar for an entire organization unit or a
bucket. Use the check boxes on the View drop-down to display additional information in the Daily calendar view, as shown in
the following figure:

Options available in the View drop-down list:
• Apply hierarchically: Shows all data within the hierarchy.
• Shifts: The shift in which the resource is working.
• On-call: Filters out resources available for on-call activities, if used.
• Points: Displays the points available during that shift, if used.
• Routes: Displays two numbers underneath each day of the resource’s calendar. The first number indicates the
number of pending activities for the day and the second number indicates the total number of activities for the day.
• Zones: This shows the Work Zone that a resource is able to work in for the given day.
• Inactive Resource: This is used if you are viewing a group or bucket. When checked, it displays resources that
have the week off for vacation, leave of absence, etc.
• Work Skills: Displays the work skills of technicians.
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Add the Find Nearby Inventory Action to Part Details Screen
Field Resources can find out the availability of an item with any of the nearby technicians. You must first configure the context
layout of the Part details screen to display the Find Nearby Inventory action on the Parts details screen.
The Find Nearby Inventory option is available based on these rules:
1. The Find Nearby link is active ONLY if these conditions are true:
◦ Your company has a subscription to Smart Collaboration and Smart Location or Oracle Field Service Cloud
Enterprise edition or Oracle Field Service Cloud Professional edition.
◦ Collaboration is enabled and configured for the user type and user.

◦
◦
◦
◦

User location information is available and the location permission given in the browser.

◦

You have enabled the Enable Real Time Traffic check box on the User Types page.

Nearby resources are available for the current user and at least one nearby user is online.
Find Nearby action link is added to the Part Details context for the user.
User activated the route.

2. The Find Nearby Inventory tab shows the number of users who hold this inventory within 50 miles distance from
the resource. The distance is based on the Nearby Radius field configured on the Business Rules screen.
3. The Find Nearby Inventory tab displays the travel duration only if these conditions are true:
◦ Your company has a subscription to Oracle Field Service Cloud Enterprise edition with Google Maps.

To add the Find Nearby Inventory action to the Parts details screen:
1.
2.
3.
4.

Click Configuration.
Click User Types.
Open the Screen configuration tab.
In the Application screens section, click Parts details.

5.
6.
7.
8.

The Parts details context layout screen appears.
Under Action, click theClick to Add link.
Select the Standard action screen option.
Select the Nearby Resources with Parts check box and then click OK.
Click Add new visibility.

Read-only is selected by default.
9. Click Save.
The Find Nearby Inventory button is now available on the Parts details screen.

Add a Plug-in to the Parts Details Screen
You may have created a plug-in that lets Field Resources order a part from the warehouse or from a vendor. To display a link
to the plug-in on the Parts Details screen, you must configure the context layout of the Parts details screen.
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Prerequisite: You have added the plug-in on the Forms & Plugins screen and configured it.
To add a plug-in to the Part details screen:
1.
2.
3.
4.

Click Configuration.
Click User Types.
Open the Screen configuration tab.
In the Application screens section, click Parts details.

5.
6.
7.
8.

The Parts details context layout screen appears.
Under Action, click theClick to Add link.
Select the Plugins option.
Select the check box for the plug-in to be displayed and then click OK.
Click Add new visibility for the newly selected plug-in.

Read-only is selected by default.
9. Click Save.
The plug-in is now available on the Parts details screen.

Resource Work Skills
To ensure that a resource has the ability to perform the assigned activities, you must correlate the incoming activity skill
requirements with the skills specified for each resource.
The Work Skill functionality is what that correlation is based on. Work Skills are set up first, and then are assigned to resource
records, with the appropriate levels of qualification set for each. Incoming activities are also assigned Work Skills based on
certain conditions being met, and are then matched up with resources with corresponding skills during routing. The setup
and management of work skills and work skill conditions are covered within the Company Settings portion of this guide.
In this section, we’ll cover a common administrative task – assigning work skills to resources to help ensure that the right
resource is being assigned the right work by routing.

Work Skill Group Considerations
Work skill groups are bundles of work skills that can be assigned to resources, similar to individual work skills. The difference,
however, is that work skill groups may already contain predetermined qualification levels of certain skills, whereas when
assigning works skills one at a time, you can define unique qualification levels for the resource.
If there is an overlap in qualification levels between what is defined within work skill groups and individual work skills, then the
resource is considered to have whichever is the highest. Work skill groups are assigned in the same manner that work skills
are (less selecting qualification levels), so this section only describes the process of assigning work skills. Editing existing work
skills for resources is another common task, and it is also accomplished in the same manner as initially assigning skills.

Assign Work Skills to a Resource
Work skills are the competencies that each resource is qualified to perform. A resource without work skills is not considered
for activity assignments. You can assign work skills to resources through the Resource Info screen.
1. In the resource tree, click on the group or bucket that you want to add the new resource to.
2. Click Settings > Resource Info from the drop-down menu.
The Resource Info screen displays.
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3. Click the plus icon in the Work skills field.
The Add work skills window opens.
4. Assign a preference level for each work skill using a scale of 1 to 100.
A higher number means that the resource has a higher chance of being allocated the task. If a resource performs
this task only occasionally, enter a lower number.
5. Click Save.
The resource is now assigned the skills and will be considered for work only if their qualification level meets or
exceeds the level in the activity record. these guidelines are applicable:
◦ If no individual skills are defined for a resource, then the application interprets that the resource is qualified to
perform all of the skills at the highest qualification level. This is the default setting.
◦ When qualification levels are set for at least one work skill, then the resource is considered to have only that
specific skill. The resource is not considered for work requiring any of the other skills.
◦ A higher ratio number increases the likelihood that this resource will be assigned activities with this work skill.
If the ratios are conflicting, the application uses the higher ratio. If the work skill group ratio conflicts with the
individual work skill ratio, the application uses the individual work skill ratio.

Resource Work Zones
Work zones provide two major capabilities—the first is to define the areas within which a resource is allowed to work (or is
restricted from working outside of), and the second is to support the ability to cap or stop activities from being booked at
certain times on a zone-by-zone basis (capacity management).
Work zones can be assigned to resources through any level within the Resource Tree (group, bucket or resource). An
exception is temporary work zones – they can only be set at an individual resource level. If work zones are set at a group
or bucket level, then their child entities (resources) inherit the same settings. If work zones are set at the resource level,
then those settings override any higher-level settings. Given those rules, ensure that before assigning work zones, you have
selected the correct entity from the Resource Tree. The process of assigning work zones is the same for all levels. This
document includes the steps for assigning work zones to individual resources.

Add Work Zones to a Resource
Work zones define the regional areas in which technicians are permitted to work. When you add a work zone to a resource,
any work zone shape or custom map layer that is added to the work zone is displayed on the map. Work zone shapes and
custom map layers help you visualize your work area better.
1. Select the resource from the Resource Tree.
2. Click Resource Settings and then select Resource Work Zones from the drop-down menu.
The Resource Work Zones screen displays for the selected resource.
3. Click Add new.
The Add Resource Work Zone for <resource name> window appears.
4. Complete these fields:
Field

Description

Work zone

Select the work zone from the drop-down menu.
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Field

Description

Display additional zones in the dropdown list

Select the box to view all the active work zones. For the group or bucket that this resource is
in.

Ratio

Type a value between 1 and 100. A higher number increases the likelihood that this resource
will be assigned activities in this work zone. If this is a work zone the resource works in daily,
or if it is a preferred zone for the resource, enter a higher number. If this resource only works
in this work zone occasionally or only by exception, enter a lower number. You can assign
multiple work zones with different ratios to one resource.

Schedule Section
Temporary

Select this check box to create a temporary work zone for a specified period of time.

Date Start

Enter the date that this work zone assignment starts.

Date End

[Optional] If this is a temporary assignment, enter the date that this work zone assignment
ends.

Recurrence

Set the schedule for the work zone if the resource is alternating between work zone
assignments. Resources can cover different work zones on different days of the week.
Use this feature to change a resource’s work area on certain days of the week. Select the
frequency of recurrence and the days on which to recur.

5. Click Add.
The work zone is added to the resource. If any work zone shapes are added to this work zone, they are displayed on
the map.

Remove Work Zones from a Resource
If a resource doesn’t want to work in a specific region, you can delete the work zone from a resource’s record. Deleting a
work zone has a major impact on the activity assignments.
1.
2.
3.
4.
5.

Select the resource from which you want to delete a work zone.
Click Settings > Resource Work Zones .
Select the work zones you want to delete from this resource.
Click Delete.
Click OK.
Any activities associated with these work zones will no longer get routed to this resource. Deleting a work zone
from a resource does not delete it from the application. It will still be available to be assigned to other resources as
needed.

Assign a Temporary Work Zone
You can assign a temporary work zone to a resource, for the resource to perform a work outside the usual work zone.
Temporary work zones override all regular work zones of the resource for the defined period of time.
1. Select the appropriate resource from the Resource Tree.
2. Click Settings > Resource Work Zones .
3. Click Add new.
The Add resource work zone for [resource name] window appears.
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4. Select the Work Zone that you want to assign temporarily to the resource.
5. Select the Temporary check box.
6. Adjust the Date Start and Date End dates.
Date End is mandatory for temporary work zones.
7. Click Add.
The work zone is added.
There is no need to remove temporary work zones once the date has passed. They expire on the end date and the normal
work zones take precedence. These rules apply to temporary work zones:
• The End Date is mandatory.
• You can assign temporary work zones only to resources. You can’t assign them to buckets or groups.
• Only the Everyday recurrence is available for temporary work zones.
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View Internal Activity Types
Internal activities are non-customer facing activities that a resource performs as part of their daily duties. External activities are
activities where resources are required to travel to perform some type of service.
For many resources, their first activity might be a warehouse visit. Around mid-way through the shift, there will be a lunch
activity. The last activity might also be a warehouse activity, completing their end-of-day tasks. This is an example of how an
internal activity is part of a resource’s daily duties.
1. Click Configuration.
2. In the Resources, Activities, Inventories section, click Activity Types.
The Activity Types screen appears. The internal activities are listed under the heading Internal. The colors indicate
the colors used on the Time, List and Map view.
3. Scroll down to see the activities types of various groups.

Add a Mass Activity
When you create an activity for one resource that you would like to use for other resources, you can create a mass activity.
For example, if all the technicians are required to attend a training, you add a mass activity.
1. Add an activity to a resource as you normally would.
2. Complete the Activity Notes, Position in Route, Duration, SLA Start, SLA End, and Time Slot fields.
3. Click Mass activity.
The Mass activity check box is displayed only for the activity types for which it is configured.
4. Click Add new.
The resource tree displays.
5. Select the resources that you want to be part of this activity.
6. Click OK.
The activity is assigned to all the selected resources.

Add Repeating Activities to a Resource’s Route
You can add activities to a resource’s route that repeats for a specified period. Examples of repeating activities include
meetings and lunch breaks.
1. From the Resource Tree, select the resource to which you want to assign the activity.
2. Click the gear icon and select Add activity.
The Add activity [resource name] screen appears.
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3. Complete these fields:
Field

Description

Activity Type

Select the internal activity type. Some common options include: Lunch Break, Assisting,
Office Activity, Warehouse Activity, Weather and Vehicle Maintenance. This list is populated
with activities designated specifically as allowed for repeating.

Activity Notes

Any notes or comments about the activity.

Position in Route

If Not Ordered is chosen, then the activity is displayed as a scheduled/not ordered activity
in the lower portion of the Time view interface. This is true whether a subsequent time slot is
indicated or not.
If Ordered is chosen and a time slot is indicated, then the activity is displayed on the
resource’s route within the time slot specified.
If Ordered is chosen and no time slot is indicated, then the activity is displayed as pending
at the beginning of the resource’s route.

Duration

The amount of time that the activity lasts.

SLA Start

The date and time at which the SLA starts for this activity.

SLA End

The date and time at which the SLA ends for this activity.

Time Slot

Select the period of time within which this activity can be started. Time slots for internal
activities are defined within the Activity Type settings. Time slots can also be created to
support internal activities, similar to how they work for scheduling external activities.

Repeating Activity

Select the frequency at which the activity occurs and complete the corresponding fields.

4. Click OK.
The activity is added to the resource’s route.

Activity Alerts
You see alert messages when you move activities. These messages guide you through the process. these alerts are available:
Overtime Alert: This alert notifies you that the estimated completion time of the activity extends beyond the end of a
resource’s working day.
Soft Skill Mismatch Alert: This alert displays when you move an activity to a resource that does not have the preferable
qualification level of an activity skill.
Work skill Mismatch Alert: This alert displays when you move an activity to a resource that does not have the required and
preferred qualification level of an activity skill. Depending on your settings, the Work Skill Mismatch Alert either prevents
you from moving the activity, or gives you the option to move it or to cancel the move.
don't Move Alert: This alert displays when you try to move an activity type that is not allowed to move between resources.
Activity types are configured in the Add activity type page.
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View Scheduled Reports
The Schedule Report option enables you to view a list of reports that have been set up to run on a specified schedule.
Initial report scheduling is handled by your system administrator.
To view scheduled reports:
1. Select the Navigation button.
2. Select Schedule Report from the navigation pane.
A list of the reports that have been scheduled to run on a recurring basis by the system administrator appears.
This figure displays the Schedule Reports page showing the list of all scheduled reports.

This table provides the elements in the Scheduled Report and their description:

Column

Description

ID

The unique identifier for this report.

Report name

The name of the report.

Start Date

The start date of the reporting period.

End Date

The end date of the reporting period.

Report Type

The format of report to be sent or saved (CSV, HTML, XML, PDF).

Time

The time that the report was run.

Recurrence

How often this report is run. You cannot run or modify any recurring reports.

Action

To view the details of the settings for an individual report (View).
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Create a Scheduled Report
The Schedule Reports option allows you to view a list of recurring reports. The initial set-up to schedule a recurring report is
handled by the system administrator.
1. Click Reports > Schedule Reports .
The list of reports that are scheduled by the system administrator to run on a recurring basis appears.
2. Click Add new.
The Add schedule window appears.
3. Complete these fields:
Field

Description

Report Name

Select the name of the report from the drop-down menu of choices.

Report Type

Select the report output type from the drop-down menu. Choices are: .csv, .html, .pdf, .xml

Save to File

Select to indicate if you want to you save the report to a file.

Email Address

Email address of the person receiving the file.

Name or ID

External ID of the resource or bucket used for this report.

Start Date

The date on which the report run begins.

End Date

The date on which the report run ends.

Time From

The time at which the report generates.

Recurrence

How often the report generates. Specify whether the report runs everyday, daily, or weekly:
Weekly allows you to select specific days of the week.

◦
◦

Report Parameters

Monthly allows you to select the day of the month.

Based on the report you selected from the drop-down menu, this section resets with the
parameters for that report. Enter the value in the Value field.

4. Click Add.
The new scheduled report appears in the Schedule Report list.

View the Messages Report
The Messages report details the results of messages sent out through the Notification Engine. This report shows only those
messages that use set property delivery channel (method) if they were generated in less than one hour. The only exception
from this rule: Messages with failed status. Such messages are important for troubleshooting therefore they do not have the
one-hour expiration time.
To view the Messages report:
1. Select the subject of your report from the resource tree.
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This could be a bucket or organization, such as XYZ contractors, or one or more resources.
Click the Navigation button.
Select Messages Report from the navigation pane.
Click View to display the filtering options for this report.
Select your options.
a. From/To Date: Use the calendar icons to select the desired dates.
b. Trigger: Select a trigger from the drop-down menu. The trigger is the action taken within Oracle Field Service
Cloud that triggers the message. For example, if you would like to run a report showing all messages triggered
when an order is canceled, select Cancel.
c. Find: Use this field to search for a certain term, word, or character (such as the name of a resource) within the
results.
d. Rows: Enter the number of rows you want to see at one time. The default value is 20.
The Messages report details the results of messages sent out through the Notification Engine.
Field

Description

Method

How the message was sent. For example, internal process or external system.

Status

The status of the message at the time the report was run.

Description

Additional information about the message status.

Miscellaneous

Other information

Scenario (Step)

The scenario or step referenced in the message.

Trigger

The event or reason why the message was sent.

Call Day

The day the call was placed.

Day Created

The date and time that the message could be seen in the system.
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